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Thank you for purchasing the IS8000 Integrated Software (hereinafter referred to as the IS8000 
Software). This user’s manual explains the features, operating procedures, and handling 
precautions of the software. To ensure correct use, please read this manual thoroughly before 
operation.
After reading this manual, keep it in a safe place. The manuals for this software are listed on the 
“Manuals” on page iii. Please read all manuals.

Contact information of Yokogawa offices worldwide is provided on the following sheet.
Document No. Description
PIM 113-01Z2 List of worldwide contacts

Notes
•	 The contents of this manual are subject to change without prior notice as a result of 

improvements  to the product’s performance and functionality. Refer to our website to view our 
latest manuals. 

•	 The figures given in this manual may differ from those that actually appear on your screen.
•	 Every effort has been made in the preparation of this manual to ensure the accuracy of its 

contents. However, should you have any questions or find any errors, please contact your 
nearest YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents of this manual without the permission of 
YOKOGAWA is strictly prohibited.

•	 The license management section of this licensee application is based on one or more of the 
following copyrights:
Sentinel® RMS © 2005 SafeNet, Inc. All rights reserved.
Sentinel® EMS © 2009 SafeNet, Inc. All rights reserved.

•	 The Math/FFT calculation section of this licensee application uses the following technology.
MATLAB®. © 1984 - 2021 The MathWorks, Inc.

Trademarks
•	 Microsoft, Windows, Windows 10, and Windows 11 are registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Sentinel is a registered trademark of SafeNet, Inc.
•	 MATLAB is a registered trademark of The MathWorks, Inc. in the United States.
•	 RAMScope is a registered trademark of DTS INSIGHT Corporation.
•	 FASTCAM and FASTCAM NOVA are registered trademarks of PHOTRON LIMITED.
•	 Modbus is a registered trademark of AEG Schneider.
•	 In this manual, the TM and ® symbols do not accompany their respective registered trademark 

or trademark names.
•	 Other company and product names are trademarks or registered trademarks of their respective 

holders.

 

17th Edition: March 2024 (YMI)
All Rights Reserved, Copyright © 2021 Yokogawa Test & Measurement Corporation
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Manuals	

The following manuals, including this one, are provided as manuals for this software.

PDF Data of Manuals
The downloaded software contains the following English and Japanese manuals. For details on 
downloading, see page iv and section 1.2 in the Installation Manual (IM IS8000-04EN).

Manual Title Manual No. Description
IS8000 Integrated Software  
User’s Manual

IM IS8000-01EN This document. Explains the features of the 
IS8000 Software and how to configure and 
operate it.

IS8000 Integrated Software  
Installation Manual

IM IS8000-04EN Explains how to install and activate the IS8000 
Software, which includes this software.

IS8000 Integrated Software
High-speed Camera Synchronization 
Feature (FS1 option)
User’s Manual

IM IS8000-61EN Explains the features of the IS8000 Software’s 
High-speed Camera Synchronization Option and 
how to use it.

IS8000 Integrated Software
ECU Monitor Synchronization Feature 
(EM1 option)
User’s Manual

IM IS8000-62EN Explains the features of the IS8000 Software’s 
ECU Monitor Synchronization Option and how to 
use it.

Harmonic/Flicker Software 
User’s Manual

IM IS8000-63EN Explains the features of the Harmonic/Flicker 
Software (a dedicated application that you can 
start from the IS8000 Software) and how to use it.

IS8000 Integrated Software  
Modbus/TCP Communication Feature  
(MB1 option) 
User’s Manual

IM IS8000-64EN Explains the features of the IS8000 Software’s 
Modbus/TCP Communication Option and how to 
use it.

The “-EN” in the manual number is the language code.

You can open the above manuals from the launcher and Help menu of this software. For details on 
the procedures, see section 9.3.
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Conventions Used in This Manual

Prefixes k and K
This manual distinguishes prefixes k and K used before units as follows:

k:	 Denotes 1000.	 Example: 100 kS/s (sample rate)
K:	 Denotes 1024.	 Example: 720 KB (file size)

Displayed Characters
Bold alphanumeric characters in procedural explanations indicate characters that appear in the 
menus on the screen.

Notes
This manual uses the following symbol to indicate notes.

Note	 Calls attention to information that is important for the proper operation of the 
software.
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Chapter 1	

Product Overview

The IS8000 software can be used to connect multiple measuring instruments, such as ScopeCorders, 
oscilloscopes, and power meters, and display, acquire, analyze, integrate, and create reports of data.

1.1	 System Configuration

IS8000 Integrated Software (standard features) 

• Instrument connection

• Online monitoring and analysis
• Instrument configuration and control

• Offline analysis
• Data acquisition

• File management

DL950

Sync.

DLM5000

WT5000

Optional features (add-on packages)

High-speed camera

ECU monitorModbus/TCP-
compatible 

device

• ECU monitor synchronization (EM1 option)

• Waveform math (MH1 option)

• High-speed camera synchronization (FS1 option)

• Multi-Unit connection (SY1 option)

• Report generator (RP1 option)
• Serial bus analysis (SB1 option)

• Modbus/TCP communication (MB1 option)

Harmonic/Flicker Software (dedicated application)

IS8000



1-2 IM IS8000-01EN

1.1  System Configuration

Target Instruments
Model* Product Name/Model Name
DL Series ScopeCorder

DL950 DL950
DL850 Series DL850/DL850V, DL850E/DL850EV
DL350 DL350

SL1000 High-Speed Data Acquisition Unit
SL1000 SL1000

DLM Series High Definition  
Oscilloscope

Mixed Signal 
Oscilloscope

Digital Oscilloscope

DLM5000 Series DLM5034HD, DLM5038HD, 
DLM5054HD, DLM5058HD

DLM5034, DLM5038, 
DLM5054, DLM5058

─

DLM4000 Series ─ DLM4038, DLM4058 ─
DLM3000 Series ─ DLM3024, DLM3034, 

DLM3054
DLM3022, DLM3032, 
DLM3052

DLM2000 Series ─ DLM2024, DLM2034, 
DLM2054

DLM2022, DLM2032, 
DLM2052

WT Series Precision Power Analyzer
WT5000 WT5000
WT3000 Series 760301, 760302, 760303, 760304, WT3001E, WT3002E, WT3003E, WT3004E
WT1800 Series WT1801, WT1802, WT1803, WT1804, WT1805, WT1806,  

WT1801E, WT1802E, WT1803E, WT1804E, WT1805E, WT1806E

* �Hereafter in this manual, the names in the Model column in the above table are used to refer to the types 
of models appearing in the explanations.

•	 For details on the models that support high-speed cameras and ECU monitors, see the Installation 
Manual and the manuals for the options.

Compatible Measuring Instruments and Interfaces

Model
USB Ethernet

USB-TMC VISA VXI11 HiSLIP 
DL950 Y Y Y Y
DL850 Series Y ─ Y ─
DL350 Y ─ Y ─
SL1000 Y ─ Y ─
DLM5000 Series Y ─ Y ─
DLM4000 Series Y ─ Y ─
DLM3000 Series Y ─ Y ─
DLM2000 Series Y ─ Y ─
WT5000 Y Y Y ─

Note
Connection with the software may not be possible depending on the firmware version of the instrument.
Versions 24.1.1.0 and later of this software are compatible with the following firmware versions.
•	 WT5000: 3.31 and later
•	 DL950: 1.50 and later
	 When connecting a DL950 with the /MT1 option, update this software to version 23.4.1.0 or later. With 

older versions, this software will not be able to acquire math waveform data of DL950’s real time math 
and power analysis (equivalent to the /G03, /G05 option).

You can view the version information of the software from the Help menu. ► section 9.4
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1.1  System Configuration

IS8000 API (Application Programming Interface)
The following functions can be added to this software by using the IS8000 API. They enable you to 
program your own functions for your own purposes.
•	 Connect this software to any measuring instrument and acquire data (DAQ).
•	 Load arbitrary data as waveforms 
For details on the interface functions and how to use them, see the IS8000 Software API User’s 
Manual, IM D037-01EN.

To use the IS8000 API, you need to purchase IS8001 (IS8000 subscription license) or IS8002 (IS8000 
perpetual license).
You cannot use the API on the IS8000 Simple Edition.
For details on the IS8000 Simple Edition, see “Feature Restrictions” under “Notes on Usage” in the 
Installation Manual (IM IS8000-04EN).
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1.1  System Configuration

Signal and Data Flow
The signal and data flow between this software and the instruments are described below.

PC (IS8000 Software)

Signal to be 
measuredDisplay data

Measured raw data
Current value data
Error and alarm information

Communication 
processing

Display

Display data
Current value data

Measured raw data

Ethernet/USB

Waveform display/analysis

Connection
Control commands

Measured raw data

Instrument

Storage

•	 Display Data
Data that instruments create for displaying waveforms.

•	 Measured Raw Data
All the measured data that instruments acquired. The data is sent to a PC to be stored in its 
storage device.
Waveforms can be displayed, and data can be analyzed.

•	 Current Value Data
Current value data is instantaneous data that instruments calculate. The data is sent immediately 
in response to a request from a PC.

•	 Error and Alarm Information
Errors and alarms that occur while instruments make measurements can be displayed.

Monitoring (Measurement) and Recording (Data Acquisition)
This software refers to the task of acquiring measured data into the internal memory of an 
instrument and displaying waveforms on this software as monitoring (measurement) and the 
task of saving the measured data that has been acquired to the internal memory of an instrument 
as files on a PC’s storage device or the internal storage device of an instrument while making 
measurements as recording (data acquisition).

PC Instrument

Signal to be measured

Display Measure

Record

Record
Monitor

Storage

Storage

Memory

Saving Measured Data
When a measurement is complete, the measured data acquired in the internal memory of a 
instrument can be saved as a single file on your PC. This task is referred to as saving, not 
recording.
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1.2	 Main Features

Features and Compatible Instruments

Model

Available Feature
Offline Analysis Online Measurement

Report 
Generator4

File 
ManagementWaveform File 

Loading1
Real-time 

Waveform Monitor
Data 

Acquisition
Remote Control 
and ACQ Save2

DL950 Y Y Y Y Y Y
DL850 Series Y — — Y Y Y
DL350 Y — — Y Y Y
SL1000 Y — — — Y —
DLM5000 Series Y — — Y Y Y
DLM4000 Series Y — — — Y —
DLM3000 Series Y — — Y Y Y
DLM2000 Series Y — — — Y —
WT5000 Y Y Y 3 Y —
WT3000 Series Y — — — Y —
WT1800 Series Y — — — Y —

1	 For the instrument file formats that this software can load, see page 1-7.
2	 ACQ Save is a feature used to obtain measured data accumulated in the acquisition memory of an 

instrument through remote control. ► section 6.2
3	 ACQ Save is not available on the WT5000. Only remote control is possible.
4	 Report Generator (RP1 option)
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1.2  Main Features

Launcher and Simple Wizard
When you start the software, the launcher appears. If you select an online measurement feature 
with the launcher, a wizard setup window appears for you to enter the necessary settings.

Launcher
On the launcher, select the feature you want to use. 
► section 3.2
Feature Description
File Open Loads measurement data files and project files

→ Opens a file open window
DAQ Online monitor (measurement), data acquisition (recording) features
Remote Control Remote control
File Manager File transfer feature
IEC 61000 Starts the Harmonic/Flicker Software (dedicated application)

→ Displays the IEC launcher of the Harmonic/Flicker Software
	 For details, see the Harmonic/Flicker Software User’s Manual, IM IS8000-63EN.

DAQ (WT) Easy online DAQ measurement for WT
When only the WT5000 is connected, a numeric screen appears when the device 
is selected and data acquisition (DAQ) becomes possible.
Online monitor (measurement), data acquisition (recording) features

DAQ (IEC 2k-9kHz) Harmonic measurements complying with IEC 61000-4-7 Annex B (2k-9kHz)
When you connect the WT5000* and select the device, a harmonics bar graph 
window appears for data acquisition (DAQ).
*	 IEC harmonics/flicker measurement feature (/G7 option) is required for WT5000
Online monitor (measurement), data acquisition (recording) features

Simple Wizard (Smart Setup)
From the launcher, select DAQ, Remote Control, File Manager,  DAQ (WT), and DAQ (IEC 
2k-9kHz) to open the Device Search window. 

Device Search Window
On this window, you can search for connectable measuring instruments on the communication 
line and view them in a list. Then, you can select the devices you want to connect to.
 ► section 3.4

If you select DAQ on the launcher, you can then display the following setting window.

Channel Setting Window
From the measurement channels of connected instruments, select and configure the channels 
to display on this software.
 ► section 3.5

DAQ Setting Window
On this window, you can set the monitor and display conditions and specify the record 
condition settings for acquiring data.
 ► section 3.6

You can also display the setup window separately using the ribbon commands (icons).
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1.2  Main Features

Loading and Saving Files
You can load into this software waveform data that has been saved on DL series, DLM series, and 
SL1000 instruments and waveform/power data that has been saved on WT series and save it to files.
In addition, you can load CSV data that has been saved with this software or Xviewer and other 
general, simple CSV waveform data.*

*	 Xviewer is a YOKOGAWA waveform viewer.

Project Files
Preferences such as the settings of measuring instruments connected to the software, display 
windows, and panel layout can be saved in a project file. You can save frequently used 
settings and displays and load them when necessary. The following two types are available.

IS8000 analysis project (.anpjt extension)
Links to offline analysis setup files and waveform files can be saved.
Data source file information and offline analysis information are saved. Waveform files 
themselves remain unchanged.
You can specify an anpjt file saved in the past and display a different waveform file using the 
same settings.

IS8000 measurement project (.mepjt extension)
Data source device information, data acquisition information, remote control information, 
and file manager information for online measurement are saved. Setup files of measuring 
instruments (DL950) can also be copied from the measuring instrument to the PC.

Loading Waveform Data
Supported file formats: CSV, CSZ, MF4 (MDF4.1), WDF, WVF, project files (anpjt, mepjt), file 
division link files (wlk).*

*	 CSZ files (.csz extension ) can be loaded directly. For details, see the next page and page 3-41.

File Formats Saved by Waveform Measuring Instruments
Model CSV1 WDF2

DL950 Y Y
DL850 Series Y Y
DL350 Y Y
SL1000 — Y
DLM5000 Series Y Y
DLM4000 Series Y Y
DLM3000 Series Y Y
DLM2000 Series Y Y

1	 Waveform data saved in ASCII format.
2	 Waveform data saved in binary format.

Note
You can also load arbitrary data as waveforms by creating your own library using the IS8000 API.
For details, see the API User’s Manual, IM D037-01EN.
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1.2  Main Features

Loading Power Values and Waveform Display Data (PP waveforms)
The compatible file format is CSV. Waveform display data can be loaded if the data has been 
saved by a WT5000, WT3000 series, or WT1800 series.

File Format Saved by Power Measurement Instrument

Model
CSV

Not compatible with 
IEEE1588

Compatible with 
IEEE1588

WT5000 Y3, 4 Y3, 4

WT3000 Series Y5 —
WT1800 Series Y5 —

3	 For numeric data, only data saved in ASCII format with the update mode set to Constant can be 
loaded.

4	 Waveform display data saved by a WT5000 (hereinafter referred to as PP waveforms) refers 
to waveform sampling data that has been P-P compressed to 2002 points for the purpose of 
displaying waveforms. It is not the data acquired at the WT5000 sample rate (sampled waveform 
data).

	 For details on P-P compression, see the WT5000 User’s Manual.
5	 • �Limited to CSV data whose Model in the first line starts with “WT1800” “WT3000” (includes 

WT1800E/WT3000E). 
	 • �Only up to the first 128 channels can be loaded.
	 • �Data that has been saved with Measurement Mode to Normal Mode (Trg) cannot be loaded 

because such data is discontinuous. Data that includes harmonic data cannot be loaded either.

Loading CSV Waveform Data
This software can load CSV waveform data that has been saved with this software or Xviewer 
(see page 3-6). It can also load other general, simple CSV data as waveforms.

Loading General, Simple CSV Data
Data is loaded without a header, and the time axis is indicated by the number of points. Note 
that the first column is skipped (not loaded).

	

The first column is blank.

CH1 CH2 CH3

Note
If information such as waveform times or sampling rate is required when loading CSV or CSZ files, 
header information is needed.

Saving Files
The compatible file formats are MF4 (MDF4.1), CSV, CSZ, and project files (anpjt, mepjt).

CSZ Files (.csz extension)
This software can save waveform files as zipped CSV files (see page 3-41).

Note
If you want to load a CSV file into Excel, use the From Text/CSV button in the Get & Transform Data 
group on the Data tab in Excel.
If you double-click the file icon or use Open on the File tab in Excel, the default data format settings 
will be applied to the opened sheet, and the data may not be displayed properly.
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1.2  Main Features

Offline Data Analysis
Data measured and saved on measuring instruments can be displayed on the PC screen and 
analyzed. You can display multiple files simultaneously.

Measurement Data Display
•	 Overview waveform display
•	 View waveform
•	 History display
•	 Dual capture display
•	 XY waveform display
•	 Power numeric display
•	 Harmonic bar graph display (WT5000)*

*	 When the IEC harmonics/flicker measurement feature (/G7 option) is installed in the WT5000, 
measurement data display complying with IEC 61000-4-7 Annex B (2k-9kHz) is supported.

•	 Vector display (WT5000)
•	 Cursor measurement
•	 Display conditions
•	 Annotation settings

Measured Data Analysis
You can analyze waveform data that has been saved on DL series, DLM series, and SL1000 
instruments and power data that has been saved on WT5000s.

Waveform Math (MH1 option)
The following computation can be performed on loaded waveform data.
•	 FFT analysis
•	 Waveform math feature

Serial Bus Analysis (SB1 option)
•	 Analyzing and searching CAN bus signals

CAN bus signal analysis/search can be performed on the loaded waveform data.
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1.2  Main Features

Online Measurement
You can connect to measuring instruments through USB and Ethernet interfaces and monitor data, 
acquire data, display integrated power, and remotely control the measuring instruments.

Real-Time Monitoring
Data that the measuring instrument is measuring can be displayed.
•	 Waveform display
•	 Numeric Monitor display
•	 Power trend display
•	 Power numeric and integral display
•	 Harmonic bar graph display (WT5000)*

*	 When the IEC harmonics/flicker measurement feature (/G7 option) is installed in the WT5000, 
measurement data display complying with IEC 61000-4-7 Annex B (2k-9kHz) is supported.

•	 Vector display (WT5000)

Data Acquisition
Acquisition data of measuring instruments can be downloaded to the PC.

*	 For details on the available communication interfaces and available instruments, see section 1.1.

•	 High-speed data acquisition capability
•	 Real-time recording (waveform data, power values)
•	 Simultaneous recording of multiple measuring instruments
•	 File division
•	 Auto naming
•	 Comment entry
•	 Recording status monitoring

Remote Measuring Instrument Control
The measuring instruments in the following table can be controlled from a PC.
The display screen of the connected measuring instrument appears on the PC screen (Remote 
Control window). You can control instruments from the PC using a mouse in the same manner 
as using the front panels of instruments.
It is also possible to save waveform data on the remote control window to the PC.

Applicable Instruments and Available Communication Interfaces

Model USB
Ethernet 10G Ethernet

Control via VXI11 Control via HiSLIP
DL950 Y Y Y2

DL850 Series1 Y Y —
DL350 Y Y —
DLM5000 Series Y Y —
DLM3000 Series Y Y —
WT5000 Y Y —

1	 The DL850 series instruments do not support touch control. The remote control from this software 
is limited to the registered control buttons. You can perform panel control by starting XWirepuller by 
selecting the APPs tab and then XWirepuller.

2	 Available when a 10 Gbps Ethernet Interface (/C60 option) is installed in the DL950. For details, 
see the DL950 manuals.
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1.2  Main Features

File Management
You can connect to measuring instruments and perform the following file operations.
•	 Download files (instrument → PC)
•	 Upload files (PC → instrument)
•	 Create folders
•	 Rename files and folders
•	 Display a list of files
•	 Display overviews of files
•	 Download data recorded using DL950 flash acquisition* to a PC

* �A dedicated flash memory (/ST2 option) is required in the DL950. For details, see the DL950 manuals.

Note
The DL950’s 10G Ethernet (/C60 option) is supported. Files and recorded data can be transferred quickly to 
the PC for management purposes.

CSV Batch Converter
Multiple files can be converted into CSV or CSZ files collectively.* Files can be processed without 
having to open them.

*	 CSZ files (.csz extension) are zipped CSV files. See pages 1-8 and 3-48.

Note
If you want to load a CSV file into Excel, use the From Text/CSV button in the Get & Transform Data group 
on the Data tab in Excel.
If you double-click the file icon or use Open on the File tab in Excel, the default data format settings will be 
applied to the opened sheet, and the data may not be displayed properly.
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1.3	 Optional Features and Dedicated Applications

You can add the following optional features (add-on analysis features) and dedicated applications.

Multi-Unit Connection (SY1 option)
Up to five measuring instruments can be connected simultaneously. It is also possible to record 
data by synchronizing the simultaneously connected measuring instruments.

Waveform Math (MH1 option)
You can set up to 32 math waveforms (Math1 to 16, FFT1 to 16).

Serial Bus Analysis (SB1 option)
CAN bus signals can be analyzed/searched.
The instrument can decode frames, fields, and other information from the loaded waveform data. 
Then, it can display the decoded results along with the waveform on the screen or display a list of 
detailed decoded results.
If you set search conditions and perform searches, the waveform can be displayed expanded, with 
the detected frame’s or field’s first data byte at the center of the window. Up to 100000 items can be 
searched.

Report Generator (RP1 option)
You can create your own layouts by combining the necessary display items. You can make 
frequently used layouts into templates and use them to generate reports in standard formats.
Reports can be printed on a printer or exported to files (Word, Excel, PDF).
You can also process multiple sets of data collectively under the same conditions.
► chapter 8

High-speed Camera Synchronization Measurement (FS1 option)
By acquiring and synchronously displaying the video taken by a high-speed camera and the 
waveform data measured by a measuring instrument, you can analyze and visualize the causal 
relationship between the waveform and the video.
For details, see the User’s Manual, IM IS8000-61EN.

ECU Monitor Synchronization Measurement (EM1 option)
By connecting a RAM monitor, you can analyze the correlation between the waveform data 
acquired by a measuring instrument and the RAM data acquired from the RAM monitor.
For details, see the User’s Manual, IM IS8000-62EN.
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1.3  Optional Features and Dedicated Applications

Modbus/TCP Communication (MB1 option)
Measurement data can be collected by connecting to a Modbus/TCP-compatible device. Correlation 
can be analyzed by synchronously displaying waveform data measured with other measuring 
instruments.
For details, see the User’s Manual, IM IS8000-64EN.

Harmonic/Flicker Software
This is a dedicated application (IS8011, IS8012) that you can use to connect to a WT5000 power 
analyzer, measure and analyze harmonics and flicker according to the IEC standards, and generate 
reports.
You can start the IEC launcher from the launcher of this software and choose the following 
measurement software applications.
•	 IEC 61000-3-2	 Harmonic Measurement Software
•	 IEC 61000-3-3	 Voltage Fluctuation/Flicker Measurement Software
•	 IEC 61000-3-11	Voltage Fluctuation/Flicker Measurement Software
•	 IEC 61000-3-12	Harmonic Measurement Software

For details, see the User’s Manual, IM IS8000-63EN.
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Chapter 2	

Workflows for Various Objectives

2.1	 Measuring and Recording Waveforms or Power 
Values Online

This is an example of connecting a DL950 or WT5000 and performing real-time monitoring 
(measurement) and recording.

Connect the instruments.� Connect the measuring instrument and PC via Ethernet or USB.  
� See the user’s manual of the measuring instrument.

Start the software. See section 3.1.

Configure the connection.
•	 From the launcher
Select the 
function.

Select DAQ. See section 3.2.

Smart setup •	 In the Device Search window, search for the measuring 
instrument and connect.

See section 3.4.

•	 In the Channel Setting window, check the display 
conditions.

See section 3.5.

•	 In the DAQ Setting window, set the display conditions and 
recording conditions.

See section 3.6.

•	 From the start window
Open the 
launcher.

On the File tab, select New to open the launcher.
From here, refer to the procedure in “From the launcher” 
described earlier.

See section 3.2.

Set the display and measurement conditions.� Monitor > Monitor tab

Set the display 
conditions.

On the Channel Control panel,* set the monitor (measurement) 
display conditions.
* �The operation here directly changes the parameters of the 

connected measuring instrument itself.

See section 5.3

Set the 
measurement 
conditions.

In the Device Control panel, set the measurement conditions. See section 5.6.

Configure the 
measured data 
display.

•	 Under Display Setting, set the waveform color, grid, and 
other items.

•	 Under Numeric Setting, set the numeric display of power 
values.

See section 5.7.

Continue to the next page.
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2.1  Measuring and Recording Waveforms or Power Values Online

Execute measurement and recording.� Monitor > Control tab

Start and stop 
measuring.

Click Monitor Start/Monitor Stop. See section 5.8.

Set the record 
conditions.

DAQ Setting (Specify the recording start, stop, division, and 
save destination settings.)

See sections 3.6 
and 5.9.

Start and stop 
recording.

Click Record Start/Record Stop. See section 5.9.

•	 When Using a Project File
Tab window and panel positions and various waveform display information can be saved in a 
project file. The next time you open this file, the display conditions will be restored to what they 
were when the software was last closed.
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2.2	 Controlling an Instrument from a PC

This is an example of connecting to a DL950 or WT5000 and controlling it remotely from a PC.

Connect the instruments.� Connect the measuring instrument and PC via Ethernet or USB. 
See the user’s manual of the measuring instrument.

Start the software. See section 3.1.

Configure the connection.
•	 From the launcher
Select the 
function.

Select Remote Control. See section 3.2.

Smart setup In the Device Search window, search for the measuring 
instrument and connect.

See section 3.4.

•	 From the start window
Open the 
launcher.

On the File tab, select New to open the launcher.
From here, refer to the procedure in “From the launcher” 
described above.

See section 3.2.

When the instrument is already connected
When the instrument is connected through the DAQ or File Manager feature
From [...] in the device list
Select the 
function.

Select Remote Control. See section 3.7.

Open the remote control window.� File tab

Transfers and 
displays the screen 
of the instrument 
on the PC

•	 A control window is displayed in the Remote Control panel.
•	 Control buttons appear on the keypad panel.

See section 6.1.

Operation and 
control

Operate the Remote Control window using the PC mouse, the 
touch panel (if the PC has a touch panel), or keypad.

See section 6.1.

Save waveform data to the PC.*� Remote Control > Tool tab

Save measured 
data.

You can download (save) waveform data to the PC by using 
Save group > Waveform.

See section 6.2.

*	 When a DL950, DL350, DL850 series, DLM3000 series, or DLM5000 series is connected, you can 
download (ACQ save) the measured data accumulated in the acquisition memory of the measuring 
instrument as a single file to the PC.
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2.3	 Analyzing Measured Data Offline

This is an example of loading and analyzing DL950 measurement waveform data saved in the PC 
using this software.

Start the software. See section 3.1.

Load waveform data.
•	 From the launcher
Select the 
function.

Select File Open. See sections 3.2 
and 3.3.

•	 From the start window
Select the 
function.

Select Open on the File tab See section 3.8.

Open a file. Select and open a file. See section 4.1.

Display measured data.� Waveform Analysis > View tab
Set the display 
conditions.

Waveforms are displayed on the Overview panel.
•	 Under Overview  - Properties at the right side of the 

window, select the split style and display channels.
•	 Set display groups.
•	 Set the scale.
•	 History waveform display
•	 Dual capture display
•	 XY Display
•	 Cursor measurement

See sections 4.2 
to 4.4.

Configure the 
measured data 
display.

Under Display Setting, set the grid and other items. See section 4.5.

Analyze measured data.� Waveform Analysis > Analysis tab
Display the 
measured results.

•	 The results of waveform parameter measurement are 
displayed in the Measure Result panel.

•	 Math Setting (option)

See sections 4.7 
to 4.8.

Set annotations. •	 Insert annotations in the waveform view. See section 
4.10.

Perform FFT analysis of measured data (option).� Waveform Analysis > FFT View tab
Display the 
measured results.

•	 Waveforms are displayed on the FFT View panel.
•	 FFT view and FFT history waveform display
•	 Cursor measurement

See section 
4.11.

Set the 
measurement 
conditions.

FFT Setting (FFT math, window function, etc.) See section 
4.11.

Export to file� File tab
Export to a file. Use Export to File to save data to an MDF file. See section 3.8.
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2.3  Analyzing Measured Data Offline

Tab window and panel positions and various waveform display information can be saved in a 
project file. The next time you open this file, the display conditions will be restored to what they 
were when the software was last closed.
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2.4	 Generating Reports (RP1 option)

Creating a Report on Data Measured or Analyzed Online
This is an example of creating a new template and generating report while acquiring the images 
displayed in the software window and measurement results.

Measure and record waveforms of power values online. See section 2.1.

Analyze waveforms or power values offline. See section 2.3.

Select the function.� APPs tab
Select Report.

Create a new template.� Report Editor > layout window

Create a new 
layout.

Click New Template.
•	 Report size and orientation (portrait, landscape)
•	 Enter the report title.
•	 Set the template name.

See sections 8.1 
and 8.2.

Set the layout. •	 Arrange, move, and delete parts.
•	 Add layouts when necessary.
•	 Click Go to Preview.

See section 8.3.

Edit the measurement or analysis data to display in the report.� Monitor > View tab

Edit the display 
window.

•	 Execute a measurement.
•	 Move the cursor position and so on.

See section 8.3.

Edit the report contents.� Report Editor > preview window

Display the 
preview window.

•	 Update and view the display on the preview panel.
•	 Select the part you want to edit.

See section 8.4.

Set the part items. •	 Set the displayed content of each item on the preview setup 
panel.

See section 8.4.

Generate a report.� Report Editor > preview window

Select the output 
format.

•	 Click Print, or click Export to File to select the output format 
(Excel, Word, PDF).

•	 Execute the output.

See section 8.5.
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2.4  Generating Reports (RP1 option)

Creating a Report Using an Existing Layout

Measure and record waveforms of power values online. See section 2.1.

Select the function.� APPs tab
Select Report.

Create a layout.� Report Editor > preview window
Select a template.

Edit the report contents.� Report Editor > preview window

Show the report 
preview window.

•	 Check the display on the preview panel.
•	 Select the part you want to edit.

See section 8.3.

Set report part 
items.

•	 Set the displayed content of each item on the preview setup 
panel.

See section 8.4.

Generate a report.� Report Editor > preview window

Select the output 
format.

•	 Click Print, or click Export to File  to select the output 
format (Excel, Word, PDF).

•	 Execute the output.

See section 8.5.
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2.4  Generating Reports (RP1 option)

Generating Multiple Reports Collectively
This is an example of selecting a new or existing layout and collectively generating (batch 
processing) reports with the same layout from several waveform files with the same configuration.

Display the waveform file or monitor. See sections 2.1, 
2.3.

Select the function.� APPs tab
Select Report.

Select a layout.� Report Editor > preview window
Open a new or existing template.

Display and edit the measurement or analysis data to display in the report.� Analysis > View tab
•	 Execute measurement, move the cursor position, and so on.

Edit the report contents.� Report Editor > preview window

Show the report 
preview window.

•	 Check the display on the preview panel.
•	 Select the part you want to edit.

See section 8.3.

Set report part 
items.

Set the displayed content of each item on the preview setup 
panel.

See section 8.3.

Batch processing Select Batch. See section 8.6.

Generate reports through batch processing.� Report Editor > preview window

Add files to list. Add files that you want to output to the output file list. See section 8.6.

Update the display 
in the report 
preview window.

Select each file to update the preview, and check the display in 
the preview setting panel.

See section 8.6.

Select the output 
format.

Click Export to File to select the output format (Excel, Word, 
PDF).

See section 8.6.

Specify the export 
destination.

Click Select Folder, and export. See section 8.6.
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Chapter 3	

Common Operations

This chapter explains operations common to all the features of this software.

3.1	 Starting and Exiting the Software

Procedure

Starting the Software
There are four methods that you can use to start the software.

•	 Double-click the shortcut icon IS8000 on the desktop.
•	 Click Windows  (Start) > Yokogawa > IS8000.
•	 Double-click the file with the associated extension.
•	 Drop the file with associated extension on the IS8000 shortcut icon.

	

Shortcut icon

Start-up Operation
•	 When you start the software for the first time, a start window appears. Refer to chapter 2 in the 

Installation Manual (IM IS8000-04EN), and complete the activation.
•	 When the activation is complete, the launcher or start window will appear the next time you start 

the software.
Details of the launcher ► section 3.2
Details of the start window ► section 3.7

Note
The specifications of the IS8000 application do not apply to connection of instruments and data collection 
when multiple instances of the application are running on the same PC.
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3.1  Starting and Exiting the Software

Closing the Software
There are two methods that you can use to close the software.

•	 Right-click the title bar, and from the drop-down menu, select Close.
•	 Click [x] at the right edge of the title bar.

	
Closes the window 
(software)

Title bar

Operation at Closing
The software closes. 

Note
You can specify whether to display a confirmation for saving the window settings to a project file when the 
software is closed.
Procedure ► section 3.11

When “Confirm saving to Project file when finished” is selected, a Save As dialog box will appear when an 
offline analysis is finished or when the online monitor is closed. The settings of the window that you are 
closing can be saved to an IS8000 analysis project file (.anpjt) or IS8000 measurement project file (.mepjt).
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3.2	 Selecting a Feature on the Launcher

On the launcher, select the feature you want to use or a file you want to load.

Procedure

Launcher
By default, when you start the software, the launcher appears.

Closes the launcher

File history list

Select this check box to not display the launcher at the next 
startup and display the start window (see section 3.7) instead.

Select the function.

Opens the manual folder

Feature Name Description
File Open Loads measurement data files and project files

→ Opens a window for opening the file window ► section 3.3, chapter 7
DAQ Online monitor (measurement), data acquisition (recording) features

→ Opens the wizard’s Device Search window ► section 3.4
Remote Control A feature used to remotely control measuring instruments on the communication line

→ Opens the wizard’s Device Search window ► section 3.4
File Manager File transfer feature between devices on the communication line and the PC

→ Opens the wizard’s Device Search window ► section 3.4
IEC 61000 Starts the Harmonic/Flicker Software

→ Displays the IEC launcher of the Harmonic/Flicker Software 
  ► User’s Manual (IM IS8000-63EN)

DAQ (WT) Easy online DAQ measurement for WT
When only the WT5000 is connected, a numeric screen appears when the device is 
selected and data acquisition (DAQ) becomes possible.
Online monitor (measurement), data acquisition (recording) features
→ Opens the wizard’s Device Search window ► section 3.4

DAQ (IEC 2k-9kHz) IEC 61000-4-7 Annex B (2k-9kHz) harmonic measurement
When you connect the WT5000* and select the device, a harmonics bar graph 
window appears for data acquisition (DAQ).
*	 IEC harmonics/flicker measurement feature (/G7 option) is required for WT5000.
Online monitor (measurement), data acquisition (recording) features
→ Opens the wizard’s Device Search window ► section 3.4
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3.2  Selecting a Feature on the Launcher

File History List
Recently used files are listed in reverse chronological order. Files (.wlk extension) that were divided 
during data acquisition are also listed.
When you click a file in the list, the file is loaded, and a measured data window appears.



3-5IM IS8000-01EN

3.3	 Opening Files

When you want to analyze data offline, specify a file (measured data, project file) on the PC.

Procedure

Window for Opening the File Window
1.	 On the launcher, select File Open.
	 The following window appears.

*	 You can also display this window by accessing the File tab > Open or Add File.  
► sections 3.7, 3.8

	

Lists the files at the entered location

Opens the files

Select files.

Enter the file location.
Moves to the higher level

Shows information about the selected file

Location

File list display

2.	 Specify the folder, and select the file from the file list.

Displaying Multiple Waveforms on the Same Axis
If you want to display multiple waveforms on the same axis, hold down Shift and click multiple 
files.

3.	 Click Open to load the files.
	 If you selected multiple files in step 2, multiple waveforms are displayed on the same axis.
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3.3  Opening Files

Explanation

Loadable File Formats
•	 MF4 (MDF4.1)

MF4 Loading Conditions
MDF Version: 4.1
fixed length data channel(cn_type=0)/master channel(cn_type=2)/virtual master channel(cn_type=3)
Data Type: UIntLE(cn_data_type=0)/UIntBE(cn_data_type=1)/IntLE(cn_data_type=2)/IntBE(cn_data_type=3)/
FloatLE(cn_data_type=4)/FloatBE(cn_data_type=5)
Data Size Int: 8/16/32/64bit, Float: 32/64bit
Conversion type: 1:1 conversion(cc_type=0)/linear conversion(cc_type=1)/rational conversion(cc_type=2)

•	 WDF
•	 WVF (YOKOGAWA’s old file format)
•	 CSV

	- CSV files that have been saved with this software
Only CSV files saved with IS8000 software version 22.6.1.0 or later can be loaded (file 
version 0.2).

	- CSV files that have been saved with YOKOGAWA’s Waveform Viewer Xviewer
	- CSV files that have been saved with DL950, DL850 series, DL350, DLM5000 series, 

DLM4000 series, DLM3000 series, DLM2000 series, WT5000, WT3000 series, and WT1800 
series*
*	 Data saved on a WT5000, WT3000 series, and WT1800 series are only available with the update 

mode set to Constant.
	- General, simple CSV data

•	 CSZ
CSV files that have been zipped and saved with this software. These files can be loaded directly, 
without unzipping.

•	 IEEE1588-compatible CSV (saved using the WT5000’s IEEE1588 synchronization feature)
•	 Project files created with this software

	- anpjt (IS8000 analysis project file)
	- mepjt (IS8000 measurement project file)

•	 wlk (link file created when recording is divided with this software) ► page 5-36

Creating and saving project files ► section 3.8
Details of various file formats ► page 1-7

Note
Loading files divided and saved by a measuring instrument
When a file is divided and saved with a measuring instrument such as the DL950, an underscore “_” and a 
3-digit serial number (000 to 999) are added to the end of the file name.
To load files that have been divided and saved by a measuring instrument with this software, place all the 
files in the same folder and open “filename_000.extension.” All divided files are loaded as one continuous 
data.

Displaying Multiple Waveforms on the Same Axis
If you select and load multiple files, multiple waveforms can be displayed on the same axis.
For a display example, see page 3-34.
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3.4	 Connecting to Instruments

The software searches for connectable devices (measuring instruments, high-speed cameras/ECU 
monitors (option)) on the communication line.

Procedure

Device Search Window
This is the first wizard window that appears when you select an online feature (DAQ, Remote 
Control, File Manager, DAQ (WT), and DAQ (IEC 2k-9kHz)) from the launcher.

*	 You can also use ribbon commands to specify the various settings in the simple wizard (smart setup).

Executes the 
search

Applies the settings and opens the 
(feature name) - (host name) tab window.

Moves to the Channel Setting window

List of detected 
devices (instruments)

When Remote Control, File Manager, DAQ (WT), or DAQ (IEC 2k-9kHz) is selected

When DAQ is selected
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3.4  Connecting to Instruments

1.	 Check the communication interface type, address (IP address or USB serial number), and the 
device (host) name of the connection destination.

2.	 Use Auto or WIRE under Manual to select the communication interface type.
•	 Auto

Items Description
WIRE The types of communication interfaces that can be selected are as follows. You can 

also select both. You can also select both.
•	 Ethernet
•	 USB

•	 Manual
Items Description
WIRE The types of communication interfaces that can be selected are as follows. Select from 

the drop-down list.
•	 Ethernet
•	 VXI11
•	 HiSLIP
•	 USBTMC
•	 VISAUSB
•	 ModbusTCP*

Address You can specify the IP address of the device to be connected in the combo box.
•	 Click  to view or select the history of addresses that were entered when you 

manually searched for devices.
•	 You can also press the down arrow key in the input box to display the input history.
	 You can select from multiple input histories with the up and down arrow keys.
When WIRE is set to ModbusTCP, you need to specify the IP address.

Read file When WIRE is set to ModbusTCP, select a Modbus/TCP setup file of the device to be 
connected from the drop-down list. *

*	 Modbus/TCP communication (MB1 option) is required. The Modbus/TCP setup file can be selected 
from files that you have created in advance with a dedicated tool and stored in the designated 
folder. For details, see the User’s Manual, IM IS8000-64EN.

3.	 Click Search.
	� Connectable devices on the communication line are listed. If you specify an address, the 

corresponding device is displayed.
4.	 View the information displayed in the WIRE, ADDRESS, MODEL, and NOTE columns to verify 

the devices to be connected.

Items Description
WIRE Communication interface type
ADDRESS IP address or USB serial number
MODEL Host name (product model name)
NOTE In the case of the WT5000, the enabled or disabled state of the DS option is indicated. 

For details on the disabled indication, see page 5-24.

5.	 Select the check boxes on the left of the devices you want to connect to, and then click Open 
or Next.

•	 When you click Open, communication will start with the instrument, and the screen of the feature you 
selected on the launcher will appear.

•	 If you click Next, the Channel Setting window (next page) opens.
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Note
When DAQ Is Selected
If the Multi-Unit Connection Feature (SY1 option), High-speed Camera Synchronization Feature (FS1 
option), ECU Monitor Synchronization Feature (EM1 option), or Modbus/TCP Communication Feature (MB1 
option) is installed, multiple devices can be connected as shown in the following figure.
The specifications of the IS8000 application do not apply to connection of instruments and data collection 
when multiple instances of the application are running on the same PC.

Y: with option, blank: without option
Option Maximum number of 

connected devices Selection of connected devicesSY1 FS1 EM1 MB1
Y 5 In the Device Search window, you can select multiple devices.

Y 2 •	 One measuring instrument and high-speed camera
Y 2 •	 One measuring instrument and ECU monitor

Y 2 •	 One measuring instrument and Modbus/TCP-compatible 
device can be selected.

Y Y Y Y 5 •	 High-speed camera, ECU monitor, and Modbus/TCP-
compatible device cannot be selected simultaneously.

Option Number of additional 
connections Addition of connectionsSY1 FS1 EM1 MB1

Y 4

After connecting the first device, clicking Add Device on the 
File tab opens the Device Search window. Here you can add 
connections for the second and subsequent devices.
► page 3-29

Y 1 •	 High-speed camera
Y 1 •	 ECU monitor

Y 1 •	 Modbus/TCP-compatible device

Y Y Y Y 4 •	 High-speed camera, ECU monitor, and Modbus/TCP-
compatible device cannot be connected simultaneously.

	 Examples of Instrument Connections
	 When the SY1 option is installed (maximum number of connectable instruments: 5)

• DL950 × 5 • DL950 × 3 + WT5000 × 2
• WT5000 × 5 • DL950 × 1 + WT5000 × 4

When the SY1 and EM1 options are installed (maximum number of connectable instruments: 5)
•	 DL950 × 2 + WT5000 × 2 + ECU monitor × 1

	 DL950 Operation Mode and Motion Mode
•	 Connect the DL950 with the operation mode set to Scope.
	 If you connect the DL950 through DAQ with the operation mode set to Recorder, it is automatically 

changed to Scope.
	 For details on the operation mode, see the DL950 manuals.
•	 When you connect the DL950 through DAQ, the DL950 Motion Mode (page 5-21) is automatically set 

to FreeRun.

When Remote Control or File Manager Is Selected
You can connect only a single device in the Device Search window.

When DAQ (WT) Is Selected (WT5000 only)
When the SY1 option is installed, the maximum number of connectable instruments is five.
On the Device Search window, if you select WT5000 and click Open, default values will be applied to the 
channel selection/setting, display conditions, and recording conditions, and the data acquisition screen will 
appear (see page 5-2).
To change the settings, use the ribbon commands.
► �channel settings (sections 5.2 and 3.5), measurement conditions (section 5.6), DAQ settings (sections 5.9 

and 3.6)
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3.4  Connecting to Instruments

When DAQ (IEC 2k-9kHz) Is Selected (WT5000 only*)
*	 This feature is available when the IEC harmonics/flicker measurement feature (/G7 option) is installed 

in the WT5000.
The maximum number of connected units is one.
On the Device Search window, if you select WT5000 and click Open, default values will be applied to the 
channel selection/setting, display conditions, and recording conditions, and the data acquisition screen will 
appear. Harmonic measurements is possible complying with IEC 61000-4-7 Annex B (2k-9kHz) (see page 
5-3).
To change the settings, use the ribbon commands.
► �channel settings (sections 5.2 and 3.5), measurement conditions (section 5.6), DAQ settings (sections 5.9 

and 3.6)
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3.5	 Setting Measurement Conditions in the IS8000 
Software

You can set display groups and measurement conditions for each channel to acquire channel 
information from the connected measuring instrument and display it on this software.

*	 Measurement conditions edited on this software are not reflected on instrument. 
	 To change the measurement conditions on the instrument, use the channel control panel (Section 5.6) 

or remote control (Section 6.1). If settings are changed on the instrument, they can be reflected in this 
software by following the procedure in “Adding Channels (page 3-12)”.

Procedure

Channel Setting Window
This is the second wizard window that appears when you select DAQ from the launcher. When you 
add channels to a display group, waveforms of measured data are displayed in the Overview panel 
(page 5-5).

*	 You can also use ribbon commands to specify the various settings in the simple wizard (smart setup).

Example when a DL950 is connected

Moves the selected 
line up

List of measurement 
conditions of each 
channel

Moves the selected 
line down

Add channels. Select filter conditions.

Deletes the selected line

Aligns the selected range of settings 
to the contents of the first row

Resets the selected range of 
settings to default

Inverts the selected range of settings
Automatically sets the 
selected range of settings

Moves to the DAQ Setting window

Returns to the Device 
Search window

Applies the settings and closes the 
DAQ-(host name) tab window.
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Adding Channels
You can add channels to display groups.

1.	 Click Add Channel to open the following dialog box. The names of connected instruments 
and channels that can be added are displayed in a tree-style list.

		

Set the waveform 
display.

Adds the selected channel

DL950 WT5000

Updates the channel list

Analysis items
Displayed on models with 
the power math option 
(/G05, /MT1 option)

Set the numeric 
display.

When a DL950 Is Connected
2.	 Click the arrow to the left of a device (instrument) name or analysis item. The list is 

expanded, and the channels that can be added appear.
	� When any of the following options is installed in the DL950, channels for analysis items of 

each option can be added.
•	 /G03 option: Real time math
•	 /G05 option: Power math function (including real time math function)
•	 /MT1 option: Motor dq analysis function (including power math function)
	 When connecting a DL950 with the /MT1 option, update this software to version 23.4.1.0 or later

	 Analysis items vary depending on the settings. For details, see the DL950 user’s manual.

Note
Updating the channel list
If you change the motor dq analysis mode, power analysis mode, or harmonic analysis mode or 
change the analysis item settings after connecting the DL950, click Update. The contents of the 
changed analysis items are reflected in the channel list. The changes are applied to the measurement 
conditions by adding the channels in steps 3 and 4.
*	 This updating does not affect the information of channels already added or entered in this software. 

Labels and other information edited with this software will not be updated to match the instrument.

Adding the Selected Channels
3.	 Select the check boxes of the channels you want to add.
	� You can select all the check boxes for the channels under a higher-level check box, 

located to the left of a device (instrument) name or an analysis item, by selecting the 
higher-level check box.

4.	 Click Add to add the channels to the list of each channel’s measurement conditions.
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When a WT5000 is connected
Setting the Waveform Display
2.	 Click the arrow to the left of WT5000 (Wave). PP waveform data source channels that 

can be added appear.

	 You can add the following channels.
•	 WU1, WI1, WU2, WI2, WU3, WI3, WU4, WI4, WU5, WI5, WU6, WI6, WU7, WI7

	� If the MTR1/MTR2 option is installed on the WT, eight more channels can be added. The 
channels switch depending on the motor configuration setting as follows:
•	 WSpeed1, WTorque1, WSpeed2, WTorque2, WSpeed3, WTorque3, WSpeed4, 

WTorque4
•	 WSpeed1, WTorque1, WSpeed2, WTorque2, WAUX5, WAUX6, WAUX7, WAUX8
•	 WAUX1, WAUX2, WAUX3, WAUX4, WSpeed3, WTorque3, WSpeed4, WTorque4
•	 WAUX1, WAUX2, WAUX3, WAUX4, WAUX5, WAUX6, WAUX7, WAUX8
For details, see the WT5000 user’s manual.

	 Proceed to step 6 under “Adding the Selected Channels” on page 3-14. 

Setting the Numeric Display
2.	 When you click Edit next to WT5000 (Numeric), the following window appears.

		
Select the function.

Select a preset.Import settings.Export settings.

Load a preset.

Select the element.

Select the order.

Button Name Description
Export Clicking this button opens a Save As dialog box. The numeric display 

settings can be saved to an xml file.
Import Clicking this button opens a file open dialog box. You can load a numeric 

display setting file (xml file) into the PC.
Preset From a drop-down list, you can select from Preset 1 to Preset 25. 

For details on each preset, see section page 3-20.
Import Preset Clicking this button imports the contents of the preset you selected with the 

drop-down list.
Element You can change the element settings.
Order You can change the target harmonic order. Click the order display you want 

to change, and select the order from the drop-down list.
The is blank for functions that cannot display harmonics
*	 For details on harmonics, see the WT User’s Manual.
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•	 Selecting and Loading a Preset
3.	 From the pull-down list, select a preset from Preset1 to Preset25.

	 For details on each preset, see section pages 3-20 to 3-23.

4.	 Click Import Preset. 

5.	 Click OK. The numeric display setting window closes, and channels that can be added 
are displayed.

Adding the Selected Channels
6.	 Select the check boxes of the channels you want to add.
	� You can select all the check boxes for the channels under a higher-level check box, 

located to the left of a waveform display or numeric display or the like, by selecting the 
higher-level check box.

7.	 Click Add to add the channels to the list of each channel’s measurement conditions.

Selecting Filter Conditions
You can select conditions to filter the list of measurement conditions of each channel.
From the drop-down list in the setup box at the upper right of the window, you can select All, Only 
Recording, or Group1 to Group4.
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List of Measurement Conditions of Each Channel
When a channel is added, the channel information acquired from the connected instrument is listed.

Note
•	 Here you can set or edit the measurement conditions on the software. Measurement conditions edited 

here are not reflected in the connected measuring instrument.
•	 Measurement conditions on the instrument can be changed on the channel control panel (Section 5.6).

You can use the check boxes in the title line to collectively turn on or off the measurement 
conditions of the corresponding columns.

Channel number

Below, the items in the table are explained in order from left-most column.

Channel number
•	 Click a number to select the line.
•	 Click  in the title line of the number column to select all lines.

Recording Channel (Record)
You can select the channels to record. Select or clear the check box for each channel (trace).
Check Box Description
ON The channel is recorded.
OFF The channel is not recorded.

Trace (Trace)
Label names are displayed. When you click a cell, you can edit the label name.*

*	 Label names edited with this software are not reflected in the connected measuring instrument.

Model (Model)
The measuring instrument name (host name, model name) of each channel is displayed.
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Group1 (Group1)
You can set the channel (trace) display and mapping for each group.

Adding and Deleting Groups
You can add or delete display groups by clicking + or – in the title row.
Items Description
+ Click this to add a display group column. Up to 4 groups can be displayed.
- Click this to delete the group column with the largest group number.

Display (Display)
You can show or hide channels.
•	 You can set up to 32 channels collectively using the check box in the title row.

Check Box Description
ON The top 32 channels of the display group are shown.
OFF Hides all the channels of the group

•	 You can select or clear the check box for each channel to show or hide it.

Mapping (Mapping)
Use the toggle switch in the title row to turn the channel mapping feature on and off.
Toggle switch Description
ON The display group’s channel mapping is enabled.

You can change the display channel assignments. You can select the channel to be 
assigned from each channel’s drop-down list.
This is available when the split style (page 4-10)) is set to Split or Tile.

OFF The display group’s channel mapping is disabled.

Numeric Monitor (Numeric Monitor)
Set whether to show or hide values on the numeric monitor.
You can select or clear the check box for each channel to show or hide it.

Waveform Color (Color)
Double-click to set the waveform color of each channel using a color palette.

Minimum (Min) and Maximum (Max)
Set the minimum and maximum values of the Y-axis of the main display. You can set them 
separately for each waveform.
When the Link (Link) check box (see next item) is selected, the values acquired from the 
connected measuring instrument are displayed. When you click a cell, you can change its 
value.*

*	 Values changed with this software are not reflected in the connected measuring instrument. When 
you change a value, the Link (Link) check box is automatically unselected.
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Link (Link)
You can select or clear the check box for each channel to link the minimum and maximum 
values of the Y-axis to those of the measuring instrument range.
If the target channel is a DL950, selecting the check box allows the DL950 target channel 
value to be set automatically to V/Div*10 (except logic channels).

Display Format (Format Type)
You can select the display format of the vertical-axis grid’s scale values from the following 
options.
Display Format Display format
Floating point 0.0, 2.5, 5.0, 7.5, 10.0
Exponent 0.0E00, 2.5E00, 5.0E00, 7.5E00, 1.0E01
Hexadecimal 0, 2, 5, 7, A

Significant digits (Significant digits)
You can set the significant digits of the following scale values from 1 to 7. 

• Vertical cursor values • History statistics
• Horizontal cursor values • DAQ monitor vertical cursor values
• Waveform tooltip display (see page page 4-11). • FFT vertical cursor values
• Computed waveform parameter values • FFT horizontal cursor values
• Cycle statistics

Default value: 5

The scale value display changes depending on the display format setting as follows:
Display Format Scale Value Display
Floating point Number of fractional digits
Exponent Counting the integer part as one digit, the number of significant digits is set to the 

digits specified by decimal place.
Hexadecimal Displayed using the specified number of digits
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Display Conditions of Logic Waveforms (Logic)
You can set the logic waveform display.

1.	 For logic waveform data, the bits to be displayed are shown in hexadecimal in the Logic 
column. When you click a value, the following window appears.

2.	 Set the display conditions of the logic waveform.

		

Bit Name (Bit Name)
When a bit name is assigned to the loaded logic waveform, the bit name is displayed.

On
Select the check boxes of the bit numbers you want shown. If there is no bit data in the loaded 
logic waveform, you will not be able to select the bit number check boxes.

Mapping
When there are bits that are hidden, select the display positions of the shown bit waveforms 
using the check boxes.
Check Box Description
ON The shown bit waveforms are displayed at regular intervals (the display positions change).
OFF The shown bit waveforms are displayed at the positions they would be displayed when all 

bit waveforms are shown (the display positions do not change).

•	 Bit Order (Bit Display Order)
You can select the bit order of logic probes.
*	 The order and displayed numbers vary depending on the model. For details, see the measuring 

instrument’s user’s manual.

Bit Order Description
MSB The most significant bit is displayed first (bit 7-> bit 0).
LSB The least significant bit is displayed first (bit 0-> bit 7).

•	 Cursor Data Display Format (Measure Result)
Select whether to display measured values in binary or hexadecimal.
Display Format Description
Binary Binary format
Hex Hexadecimal format
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Bundle
You can set Bundle to ON or OFF.
Check Box Description
ON If there are bits that are not shown, they are shown as “−” in binary. In hexadecimal, 

the measured values are displayed as though they are not present.
Binary: Binary format
Hex: Hexadecimal format

OFF Logic waveforms are not displayed in bundles.

Vertical Scale Unit (Unit)
You can set the vertical scale unit. Click the Unit box of the measuring channel you want to set 
to display the text cursor or to highlight the existing unit. Then, type the unit. Set the unit using 
up to four characters.

Explanation

Setting Measurement Conditions Collectively
You can set several measurement conditions of a channel collectively by dragging over the list to 
specify a range.

*	 The following buttons do not change the Trace, Model, and Link settings.

Automatically Setting the Selected Range of Settings
Affected settings: Waveform color, minimum, maximum
Click Auto to automatically set the selected minimum, maximum, and waveform color settings.

Inverting the Selected Range of Settings
Affected settings: Record, display, waveform color
Click Invert to invert the selected ON/OFF and waveform color settings.

Aligning the Selected Range of Settings to the Contents of the First Row
Affected settings: Display, minimum, maximum, display format, decimal place, unit
Click Copy to copy the contents of the selected range in the first row to the other rows.

Resetting the Selected Range of Settings to Default
Affected settings: Waveform color, display format
Click Default to reset the settings to default.
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Setting the Numeric Display (when a WT5000 is connected)
Contents of Each Preset
•	 For details on the measurement items, see the WT5000 User’s Manual.
•	 The element numbers (1, 2, 3, 4, 5, 6, 7, ΣA, ΣB, ΣC) indicated in the measurement items 

can be changed on the setting menu.

Preset 1 to Preset 8

Preset 1 Preset 2 Preset 3 Preset 4 Preset 5 Preset 6 Preset 7 Preset 8
Udc1 Udc4 Udc1 Udc4 Udc1 Udc4 Urms1 Urms2
Idc1 Idc4 Idc1 Idc4 Idc1 Idc4 Umn1 Umn2
P1 P4 P1 P4 P1 P4 Udc1 Udc2
UrmsΣA UrmsΣA UrmsΣA UrmsΣA S1 S4 Urmn1 Urmn2
IrmsΣA IrmsΣA UmnΣA UmnΣA UrmsΣA UrmsΣA Uac1 Uac2
PΣA PΣA UfndΣA UfndΣA UmnΣA UmnΣA Ufnd1 Ufnd2
Urms2 Urms1 IrmsΣA IrmsΣA UfndΣA UfndΣA Uthd1 Uthd2
Irms2 Irms1 ImnΣA ImnΣA IrmsΣA IrmsΣA Irms1 Irms2
P2 P1 IfndΣA IfndΣA PΣA PΣA Imn1 Imn2
Urms3 Urms2 PΣA PΣA SΣA SΣA Idc1 Idc2
Irms3 Irms2 λΣA λΣA Urms2 Urms1 Irmn1 Irmn2
P3 P2 λfndΣA λfndΣA Umn2 Umn1 Iac1 Iac2
Urms4 Urms3 Urms2 Urms1 Ufnd2 Ufnd1 Ithd1 Ithd2
Irms4 Irms3 Umn2 Umn1 Irms2 Irms1 P1 P2
P4 P3 Ufnd2 Ufnd1 Urms3 Urms2 S1 S2
η1 η1 Irms2 Irms1 Umn3 Umn2 Q1 Q2
FreqU2 FreqU1 Imn2 Imn1 Ufnd3 Ufnd2 λ1 λ2

Ifnd2 Ifnd1 Irms3 Irms2 φ1 φ2
Urms3 Urms2 Urms4 Urms3 FreqU1 FreqU2
Umn3 Umn2 Umn4 Umn3 FreqI1 FreqI2
Ufnd3 Ufnd2 Ufnd4 Ufnd3 U+peak1 U+peak2
Irms3 Irms2 Irms4 Irms3 U-peak1 U-peak2
Imn3 Imn2 η1 η1 I+peak1 I+peak2
Ifnd3 Ifnd2 η2 η2 I-peak1 I-peak2
Urms4 Urms3 η3 η3 CfU1 CfU2
Umn4 Umn3 FreqU2 FreqU1 CfI1 CfI2
Ufnd4 Ufnd3 Speed Speed
Irms4 Irms3 Torque Torque
Imn4 Imn3 Pm Pm
Ifnd4 Ifnd3 Slip Slip
η1 η1 SyncSp SyncSp
η2 η2
FreqU2 FreqU1
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Preset 9 to Preset 16

Preset 9 Preset 10 Preset 11 Preset 12 Preset 13 Preset 14 Preset 15 Preset 16
Urms3 Urms4 Urms5 Urms6 Urms7 UrmsΣA UrmsΣB UrmsΣC
Umn3 Umn4 Umn5 Umn6 Umn7 UmnΣA UmnΣB UmnΣC
Udc3 Udc4 Udc5 Udc6 Udc7 UdcΣA UdcΣB UdcΣC
Urmn3 Urmn4 Urmn5 Urmn6 Urmn7 UrmnΣA UrmnΣB UrmnΣC
Uac3 Uac4 Uac5 Uac6 Uac7 UacΣA UacΣB UacΣC
Ufnd3 Ufnd4 Ufnd5 Ufnd6 Ufnd7 UfndΣA UfndΣB UfndΣC
Uthd3 Uthd4 Uthd5 Uthd6 Uthd7 UthdΣA UthdΣB UthdΣC
Irms3 Irms4 Irms5 Irms6 Irms7 IrmsΣA IrmsΣB IrmsΣC
Imn3 Imn4 Imn5 Imn6 Imn7 ImnΣA ImnΣB ImnΣC
Idc3 Idc4 Idc5 Idc6 Idc7 IdcΣA IdcΣB IdcΣC
Irmn3 Irmn4 Irmn5 Irmn6 Irmn7 IrmnΣA IrmnΣB IrmnΣC
Iac3 Iac4 Iac5 Iac6 Iac7 IacΣA IacΣB IacΣC
Ithd3 Ithd4 Ithd5 Ithd6 Ithd7 IthdΣA IthdΣB IthdΣC
P3 P4 P5 P6 P7 PΣA PΣB PΣC
S3 S4 S5 S6 S7 SΣA SΣB SΣC
Q3 Q4 Q5 Q6 Q7 QΣA QΣB QΣC
λ3 λ4 λ5 λ6 λ7 λΣA λΣB λΣC
φ3 φ4 φ5 φ6 φ7 φΣA φΣB φΣC
FreqU3 FreqU4 FreqU5 FreqU6 FreqU7
FreqI3 FreqI4 FreqI5 FreqI6 FreqI7
U+peak3 U+peak4 U+peak5 U+peak6 U+peak7
U-peak3 U-peak4 U-peak5 U-peak6 U-peak7
I+peak3 I+peak4 I+peak5 I+peak6 I+peak7
I-peak3 I-peak4 I-peak5 I-peak6 I-peak7
CfU3 CfU4 CfU5 CfU6 CfU7
CfI3 CfI4 CfI5 CfI6 CfI7
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Preset 17 to Preset 23

Preset 17 Preset 18 Preset 19 Preset 20 Preset 21 Preset 22 Preset 23
P1 P5 P1 F1 Uthd1 Uthd2 Uthd3
WP1 WP5 P2 F2 U1(dc) U2(dc) U3(dc)
Irms1 Irms5 P3 F3 U1(1) U2(1) U3(1)
q1 q5 P4 F4 U1(2) U2(2) U3(2)
P2 p6 P5 F5 U1(3) U2(3) U3(3)
WP2 WP6 P6 F6 U1(4) U2(4) U3(4)
Irms2 Irms6 P7 F7 U1(5) U2(5) U3(5)
q2 q6 PΣA F8 U1(6) U2(6) U3(6)
P3 P7 η1 F9 U1(7) U2(7) U3(7)
WP3 WP7 η2 F10 U1(8) U2(8) U3(8)
Irms3 Irms7 η3 F11 U1(9) U2(9) U3(9)
q3 q7 η4 F12 U1(10) U2(10) U3(10)
P4 PΣA F13 U1(11) U2(11) U3(11)
WP4 WPΣA F14 U1(12) U2(12) U3(12)
Irms4 IrmsΣA F15 U1(13) U2(13) U3(13)
q4 qΣA F16 U1(14) U2(14) U3(14)

Ithd1 Ithd2 Ithd3
I1(dc) I2(dc) I3(dc)
I1(1) I2(1) I3(1)
I1(2) I2(2) I3(2)
I1(3) I2(3) I3(3)
I1(4) I2(4) I3(4)
I1(5) I2(5) I3(5)
I1(6) I2(6) I3(6)
I1(7) I2(7) I3(7)
I1(8) I2(8) I3(8)
I1(9) I2(9) I3(9)
I1(10) I2(10) I3(10)
I1(11) I2(11) I3(11)
I1(12) I2(12) I3(12)
I1(13) I2(13) I3(13)
I1(14) I2(14) I3(14)
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Preset 24, Preset 25
These are presets for harmonic measurements complying with IEC 61000-4-7 Annex B 
(2k-9kHz).
Preset 24 Preset 25*
U1(Total) U1(2100) U1(6100)
I1(Total) I1(2100) I1(6100)
P1(Total) U1(2300) U1(6300)
S1(Total) I1(2300) I1(6300)
Q1(Total) U1(2500) U1(6500)
λ1(Total) I1(2500) I1(6500)
φ1(Total) U1(2700) U1(6700)
Uthd1 I1(2700) I1(6700)
Ithd1 U1(2900) U1(6900)
Pthd1 I1(2900) I1(6900)
THC1 U1(3100) U1(7100)
FreqPLL1(fPLL1) I1(3100) I1(7100)

U1(3300) U1(7300)
I1(3300) I1(7300)
U1(3500) U1(7500)
I1(3500) I1(7500)
U1(3700) U1(7700)
I1(3700) I1(7700)
U1(3900) U1(7900)
I1(3900) I1(7900)
U1(4100) U1(8100)
I1(4100) I1(8100)
U1(4300) U1(8300)
I1(4300) I1(8300)
U1(4500) U1(8500)
I1(4500) I1(8500)
U1(4700) U1(8700)
I1(4700) I1(8700)
U1(4900) U1(8900)
I1(4900) I1(8900)
U1(5100) FreqPLL1(fPLL1)
I1(5100)
U1(5300)
I1(5300)
U1(5500)
I1(5500)
U1(5700)
I1(5700)
U1(5900)
I1(5900)

*	 U(f): 2100 to 9900 Hz (the input range is 2000 to 10000 Hz)
	 I(f): 2100 to 9900 Hz (the input range is 2000 to 10000 Hz)
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When you select the data acquisition feature, set the display and recording conditions of acquisition 
data.

Procedure

DAQ Setting Window
This is the third wizard window that appears when you select DAQ (data acquisition feature) from 
the launcher.

*	 You can also use ribbon commands to specify the various settings in the simple wizard (smart setup).

Record settings

Monitor settings

Applies the settings and 
opens the window

Returns to the Channel 
Setting window

Time Synchronization Settings

Monitor Setting 
Set the display conditions.

Display Time
You can specify the display time with time.
Time: Enter the time in the d.hh:mm:ss format. The maximum time setting is 1 day.

Time Base (Time Base) 
Item Description
Relative time 
(Relative time)

Relative time from the start of measurement. Displays all waveforms by aligning the start 
position. (Select this value when multiple units are connected and the times of each measuring 
instrument do not match.)

Absolute time 
(Absolute time)

Measured time (absolute time). Waveforms are displayed using the times of each measuring 
instrument. Select this value when the times of measuring instruments are synchronized.

Clock Adjustment (Clock Adjustment)
Base Clock (Base Clock)
When the time base is set to Absolute time, select which device’s clock will be used as the 
reference. Select the PC or any of the connected devices.
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Set Time (Set time)
Specify the time of the device (check mark) that is to become the time reference on devices 
whose time synchronization is disabled. An error of about ±1 s will occur.

Time Synchronization Settings
The following information is displayed in the list of connected devices on the right side.
•	 A check mark next to the reference device
•	 Measuring instrument time
•	 Time synchronization state

Display State
OFF No time synchronization
Unlock Time not synchronized
Lock Time synchronization being established
Stable Time synchronized
Master Master time synchronization device

Record Setting
Set the recording conditions.

Recording Start (Recording Start)
You can set the recording start conditions manually or by date.
•	 Manual

Recording starts when, on the feature ribbon, you select Monitor, the Control tab, and click 
Record Start in the DAQ group.

•	 Date and time
Enter the recording start time in the yyyy/MM/dd HH:mm format.

Recording Stop
Select the recording stop condition from the following four options.
•	 Manual

Recording starts when, on the feature ribbon, you select Monitor, the Control tab, and click 
Record Stop in the DAQ group or Monitor Stop.

•	 Size
You can enter the size in the following ranges.
1 MB to 600 GB (1 G Ethernet/USB connection or 10 G Ethernet (HiSLIP) connection)

*	 Because measurement conditions and other supplementary information are estimated in the calculation, 
the actual size will be smaller than the specified size.

•	 Date and time
Enter the recording stop time in the yyyy/MM/dd HH:mm format.

*	 This is available only when Recording Start is set to Date and Time.

•	 Recording time
Enter the recording time in the d.hh:mm:ss format. The maximum record length is 7 days.
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File Division (File Divide)
Select the file division condition from the following three options.
•	 Manual

The recording file is divided when, on the feature ribbon, you select Monitor, the Control 
tab, and click File Divide in the DAQ group.

•	 Size
You can enter the size in the following ranges.
1 MB to 10 GB
This is available when Recording Stop is set to Manual or Size.
Specify the size so that the record file time is at least 10 s. If the record file time is less than 10 s, the 
file will not be divided even when the size is specified.

•	 Times
Enter the time when the file is to be divided in the d.hh:mm:ss format.
This is available when Recording Stop is set to Manual or when both Recording Start and Recording 
Stop are set to Date and time. The minimum division time is 10 s.

Save Folder
Click [...] to specify the folder to which data is to be recorded.

Create Date and Time Folder Check Box
Check Box Description
ON Date folders are created in the save folder, and recorded data is saved in those folders. 

The folder name is the date followed by a sequence number. 
Example: yyyymmdd_nnn, nnn: serial number between 000 and 999

OFF Recorded data is saved in the save folder.

File name (File Name)
Set the file name. A serial number specified by auto naming (next section) or a timestamp is 
appended to the file name specified here.
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Auto Naming
You can select Number or Date and time.

When Number Is Selected
A sequence number is appended to the file name that you specify.

		

Test_0000-00.mf4

Character string
Sequence number (0000 to 9999)

Sequence number when files are divided (00 to 99)

When Date and Time Is Selected
A timestamp (in ms) at the time of recording is added to the file name that you specify.

		

Year
Month

Day

Hour
Minute

Second
ms

Test20210118_121530_100-00.mf4 (2021/01/18 12:15:30.100)

Character string

Sequence number when files are divided (00 to 99)

File Comment (File Comment)
Enter any necessary comments using up to 250 characters.
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Start Window
If you configured the software to not show the launcher at startup, the following window appears 
when you start the software.

Window display area Property 
display area

Data source 
display area

Maximizes the window

Help menuSetting menu

Closes the window (software)

Collapses the ribbon

Minimizes the window

Tab
Capture setting menu

Command group
Group name

Command (icon)

Ribbon

Screen 
capture
button

Data Source Display Area
•	 The names of the loaded files are displayed under Waveform Files.
•	 The names of the connected devices (hosts) are displayed under Devices.

Window Display Area
Tab windows and panels are displayed according to the selected feature or the contents of the 
loaded file.
*	 Feature ribbons are added in sync with tab windows. The tabs of tab windows and tabs of feature 

ribbons show the feature names.

Property Display Area
Information such as the settings of the selected panel is displayed.

•	 Example of a Window Shown When a File Is Loaded (Waveform Analysis)

Feature name Tab Window

Properties 
(Overview)

Panel
(Overview)

Panel
(Vertical 
cursor)

Waveform 
file list

Device list

Waveform 
analysis ribbon
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Ribbons
A ribbon consists of tabs, command groups, and commands (icons).
•	 Click a tab to switch the ribbon.
•	 A command group contains commands of a related feature.
•	 Commands are shown in the divided groups. Group names are shown at the bottom of the 

ribbon.
*	 Commands that cannot be selected appear dimmed.

File and APPs are ribbon tabs that are shown at all times. When you open a file or select a feature, 
the feature ribbon (page 3-30) is added.

File Tab

Group/Command Description
Open A window opens for opening the file window. ► section 3.3
Project

New A launcher appears. ► section 3.2
Configures a new project using a simple wizard format.

Save Project Saves the project to a file.
Save Project As Saves the project to a file with a different name.

Waveform
Add File Opens a file open dialog box. Select an additional waveform file to be displayed 

with an already displayed waveform file on the same axis.
Export to File Exports the displayed waveform data to a file.

Device
Add Device A Device Search window opens. ► section 3.4

Select another measuring instrument to be displayed with the data of a 
measuring instrument already connected through DAQ on the same axis.

For instructions on how to use each command, see section 3.8.

APPs Tab

Command Description
CSV batch converter Starts the CSV batch converter application. ► section 3.9
Report Displays a report generation window. ► chapter 8
IEC 61000 Displays the IEC launcher of the Harmonic/Flicker Software.

► User’s Manual (IM IS8000-63EN)
XWirepuller Starts the XWirepuller application. XWirepuller is a YOKOGAWA free software 

application that can be used to remotely control measuring instruments from a 
PC via Ethernet, USB, or GP-IB.
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Feature Ribbons
A feature ribbon is displayed along with a tab window according to the loaded file or selected 
feature. The following feature ribbons are available. The feature name is displayed at the top of the 
ribbon tab. A blue band is displayed above the feature name when the ribbon can be used.

Waveform Analysis (Waveform Analysis)

This is a ribbon for offline measurement. Click a tab to switch the ribbon.
For details on ribbon commands and how to use them, see chapter 4.
Tab Description
View Loads and displays measurement data files.
Analysis Analyzes measurement data files.
FFT View Performs FFT computation and analysis.
Video Measured data and video data are played in sync. (High-speed Camera 

Synchronization Feature, option)

Monitor

This is a ribbon for online measurement. Click a tab to switch the ribbon.
For details on ribbon commands and how to use them, see chapter 5.
Tab Description
Monitor Displays measured data of connected measuring instruments.
Control Configures connected measuring instruments and executes monitoring (measurement) 

and recording (data acquisition).
Video This feature synchronizes a high-speed camera and a DL950 and records waveforms. 

(High-speed Camera Synchronization Feature, option)

Remote Control (Remote Control)

This is a ribbon for remotely controlling measuring instruments. The following tabs are 
available.
For details on ribbon commands and how to use them, see chapter 6.
Tab Description
Tool Displays a tool for retrieving measured data as files through remote control and a tool 

for setting the update rate.

File Manager

This is a ribbon for file management. Files can be transferred between the PC and connected 
instruments. The following tabs are available.
For details on ribbon commands and how to use them, see chapter 7.
Tab Description
File Manager Displays tables of files for both the connected instruments and the PC. You can 

transfer files, create folders, rename files and folders, and so on.
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Screen Capture
An image of the active panel shown in a tab window can be saved to the Clipboard or an image file.

Screen Capture
This button executes a screen capture.

Capture Setting Menu
You can select the following items from the drop-down list.
Item Description
Capture Settings Set the screen capture data output destination and file type.
For details, see section 3.10

Setting Menu
You can select the following items from the drop-down list.
Item Description
Language You can set the language. Select English, Japanese, or Chinese.
Theme You can set the window tone. Select dark or light.
Layout You can set the panel layout in the tab window.

•	 Initialization You can initialize the panel layout in the tab window.
•	 Initial setting You can apply the settings of another analysis project file (.anpjt) to display another 

file in the same layout.
Show the launcher at 
startup

You can set whether to show the launcher at start up. To not show the launcher 
the next time you start the software, clear the check box shown to the left of the 
command.

Generate cache files Cache files can be generated and MDF files can be loaded quickly.
Confirm saving to Project 
file when finished

You can set whether to confirm saving to a project file when the software is closed.

For details, see section 3.11

Help Menu
You can select the following items from the drop-down list.
Item Description
About Displays the version of the software. ► section 9.4
License Displays license information such as options and expiration date. ► section 9.5
Manual You can view the PDF data of the manual for this software. ► section 9.3
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Data Source Display Area
Displays a table of waveform files in the top row and a table of devices (connected devices) in the 
bottom row.
•	 When you drop a waveform file in the data source display area, the file is added to the list of 

waveform files, and you will be able to display the waveform.
•	 You can click the pin-on-top icon  or  to minimize (automatically hide) or maximize the 

display area.
•	 If you select a file or connected device and click [...] shown on the right, the following drop-down 

list appears.

Waveform Files
A list of loaded files is displayed. Multiple sets of waveform data can be displayed on the same 
axis in a single tab window.

Coaxial display mark
Minimizes the display area

Select the function.
A tab window opens for the selected function.

Stops the coaxial display
Starts the coaxial display

Removes the file
• The selected file is removed from the file list.
• The tab window of the corresponding file is deleted.

Displays file information
Information about the selected file are displayed.

File Information
You can view the information about the file displayed in the tab window.
•	 Display example

Closes the window
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Devices
A list of connected devices (measuring instruments) is displayed. Data from multiple 
connected devices can be displayed synchronized in a single tab window.

Sync mark

Disconnects from the device

Minimizes the display area

Select the function.
A tab window opens for the selected function.

Stops the synchronized display
Starts the synchronized display
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Window Display Area
When you open a file or select a feature, a tab window is displayed. A tab window consists of 
multiple panels.

	

Feature name

Panel
(Overview)

Panel
(Vertical 
cursor)

Closes the tab windowDisplayed file names

Example displaying three files on the same axis in a single tab window

Tab Window
The following feature tab windows are displayed.
Feature Name Description
DAQ A tab window that appears when you select the data acquisition (DAQ) feature.
Analysis A tab window that appears when you select the offline analysis feature.
File Manager A tab window that appears when you select the file management feature.
Remote Control A tab window that appears when you select the remote control feature.
DAQ (WT) A tab window that appears when you select the easy online DAQ measurement 

feature for WT.
DAQ (IEC 2k-9kHz) A tab window that appears when you select harmonic measurements 

complying with IEC 61000-4-7 Annex B (2k-9kHz).

Tab Window Names
Display format: (feature name) - (file name or host name)

Adding a Tab Window
Select a file or measuring instrument in the data source display area, and select a feature from 
the drop-down list.

Deleting a Tab Window
Click [×] next to the tab window name, or select the file or device from the waveform file or 
device list and select Remove.

Selecting (Activating) a Tab Window You Want to Use
When a tab window is activated, the background color of the tab turns blue.
When multiple tab windows are displayed overlapped in the window display area, you can 
click the tab of a tab window to activate the window (bring the window to the front).
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Displaying a Tab Window in a New Window
If multiple tab windows are open in the window display area, you can select and display a tab 
window in a new window.

1.	 Select a tab in the tab window, and drag it to the desktop.

		

Drag the tab.

2.	 When a new window is displayed in light blue, and drop it. The selected tab window is 
displayed in a new window.
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Panels
When you select a command (icon) of a ribbon, a panel for the selected item appears in the 
tab window.

Showing or Hiding a Panel
Click the command (icon) you want to show or hide.

Selecting (Activating) a Panel You Want to Use
When you click a panel, the panel was activated, and a blue frame is displayed.

Hiding a Panel
Click [×] next to the panel name.

Changing the Display Position of a Panel
You can change the display position of a panel within the tab window.

1.	 Dragging a panel name causes arrows to appear in the movable areas (top, bottom, left, 
right, center).

		

Drag the panel name display area.

2.	 When you drag on top of one of these arrows, the placeable area is displayed in light 
blue.
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3.	 When you drop the panel name in such an area, the panel position changes. This causes 
the layout of other panels in the tab window to be adjusted.

		

Displaying Multiple Panels on Top of Each Other
You can display multiple panels on top of each other in a tab window. You can select the panel 
that is displayed in front by clicking the panel name tab.

1.	 Drag the panel name of the panel you want to display on top of another panel to the 
panel name display area of the other panel. The area where the panel can be moved to 
is displayed in light blue.

		

Drag the panel name display area.

2.	 When you drop the panel name in such an area, the panel is displayed on top of the 
other panel. The panel names of the panels that are displayed on top of each other are 
shown in tabs. This causes the layout of other panels in the tab window to be adjusted.
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Property Display Area
•	 When you select a displayed panel, information (such as settings ) related to the panel part 

displayed. The displayed information varies depending on the selected panel. For details, see 
chapters 4 to 7.

•	 You can click the pin-on-top icon  or  to minimize (automatically hide) or maximize the 
display area.

Window Display Size
You can change the size of a window as you like by dragging the window frame. The tab window 
and panel display area change according to the size of the entire window.

Note
Various waveform display information and panel positions can be saved as a project file. After you save a 
project file, the next time you open this file, the display conditions will be restored to what they were when 
the software was last closed.
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This section explains the following file operations by command groups of the File tab.
•	 File Open (Open) 
•	 Project File (Project)
•	 Waveform File (Waveform)
•	 Add Device (Device)

Procedure

File Open (Open)
Select a file you want to analyze offline.

1.	 Click Open. A window opens for opening the file window.

2.	 Select a file you want to display or a project file. ► section 3.3

	 An Analysis-(file name) tab window opens in the displayed window display area.

Project File (Project)
•	 Configures a new project using a simple wizard format.
•	 Saves the project to a file with a different name.
•	 Saves an existing project.

Creating a New Project File
1.	 Select New. A launcher appears.

2.	 Select the project content (feature). You can select the following features.

Feature Description
File Open Opens a file or project file in a new window.
DAQ Select this to connect to an instrument and acquire data with the IS8000.
Remote Control Select this to remotely control an instrument.
File Manager Select this to transfer data between an instrument and the PC.
DAQ (WT) Select this to connect to only the WT5000 and acquire data with the IS8000.
DAQ (IEC 2k-9kHz) Select this to connect only to the WT5000 and acquire harmonic 

measurements complying with IEC 61000-4-7 Annex B (2k-9kHz) with the 
IS8000.

Opening the File in a New Window
3.	 Select File Open. A window opens for opening the file window.

4.	 Select a file you want to display or a project file. ► section 3.3

	 An Analysis-(file name) tab window opens in a new separate window.
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Creating a New Project File
3.	 Refer to section 3.4, and select and connect to the target device of the project.

4.	 If you selected DAQ in step 2, click Next, set the measurement conditions (see section 3.5) 
and recording conditions (see section 3.6), and click Open.

	 If you selected Remote Control in step 2, FileManager, DAQ (WT),or DAQ (IEC 2k-9kHz), 
click Open.

	 A tab window opens for the selected project.

Saving a Project File with a Separate Name
You can assign a file name to the new project you created and save it.

5.	 Click Save Project As. A Save As dialog box appears.

6.	 Enter the file name and the save destination, and click Save. The file type and extension 
are as follows:

File Type Extension
IS8000 measurement project .mepjt
IS8000 analysis project .anpjt

Saving a Project File
1.	 If you open an existing project file and want to change the conditions and save it, click 

Save Project.
*	 Save Project is valid only when an existing project file is open.

Note
Opening a File Using the Settings of Another Analysis Project File
You can open a waveform file using the settings of another analysis project file (.anpjt) saved in the past. 
This is useful when you want to open several files using the same settings.
For the procedure, see section 3.11.
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Waveform File (Waveform)
•	 Loading and adding a file (coaxial display)
•	 Exporting a file

Loading and Adding a File (coaxial display)
1.	 Click Add File. A window opens for opening the file window. ► section 3.3

2.	 Select the waveform file you want to additionally display, and click Open. ► section 3.3
	� The waveform of the selected file is displayed on the same axis as the displayed 

waveform. The file name is also added to the tab window name.

Exporting a File
1.	 Click Export to File. The following window appears.

	 Example: Saving WT5000 harmonic data in waveform file (*.csv) format

	

Set the range 
to save and 
compression

Numeric, harmonic bar, and 
vector export settings

Select the file type 
Select the channels to save

Configure 
the ASCII file.

Enter a comment.

Select the channels to save collectively.

2.	 Specify the save file type, and enter the necessary settings. You can select decimation 
and the saved channels when saving data.

File Type Description
•	 Waveform file (*.mf4) The open waveform file is saved in MF4 format.
•	 Waveform file (*.csv)
•	 Waveform file (*.csv) with BOM The open waveform file is saved in CSV format.

•	 Waveform file (*.csz)
•	 Waveform file (*.csz) with BOM The open waveform file is saved in zipped CSV format.

•	 Measure result (*.csv)
•	 Measure result (*.csv) with BOM

Available only when saving automated measurement values 
of waveform parameters (measurements shown in the 
measured result panel). ► section 4.7

•	 FFT file (*.csv)
•	 FFT file (*.csv) with BOM

Available only when saving the analysis results of FFT 
waveforms. (MH1 option) ► section 4.11

•	 Serial bus analysis result (*.csv)
•	 Serial bus analysis result (*.csv) 

with BOM

Available only when saving the results of serial bus analysis. 
(SB1 option) ► section 4.9

If you select the CSV or CSZ format without a BOM, data is saved without a BOM.
BOM: Byte Order Mark ► page 3-44
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	 Storage File Formats and Settings

Setting

File Type
MF4 CSV/CSZ CSV

Waveform 
file

Waveform 
file

Measure  
result FFT file

Select the channels to save
► next page Y Y ─ Y

Numeric, harmonic bar, 
and vector export settings 
(WT5000 data only)

N/A Y ─ ─

Range to save and 
compression settings Y Y ─ Y

Comment Y Y ─ Y

ASCII file setting ─ Y Decimal point 
setting only

Only the header, 
frequency, and 
decimal point settings

Details of each setting ► “Exporting to a File” on page 3-44.

	 •	 When the Storage File Format Is Measurement Results (*.csv)

			 

	 •	 When the Storage File Format Is FFT File (*.csv) (MH1 option)

			 

	 •	 When the Storage File Format Is Serial Bus Analysis Results (*.csv) (SB1 option)
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	 Selecting the Channels to Save
•	 Select individual channels to be saved

You can select or clear the check box of each channel on the left side of the No. 
column to specify whether to save the channel.

•	 Collectively saving multiple channels of a waveform file
Click the check box in the title row.

When a dual capture waveform is to be saved
Click the check box in the title row to show the selection menu in the following figure. 
You can collectively select only the main waveforms or only the sub waveforms.

			 

Selects all dual capture waveform channels
Collectively selects only the main waveform 
Collectively selects only the sub waveform channels

3.	 Click Save. A Save As dialog box appears. 

4.	 Specify the save destination, and click Save.

	 The file is exported to the specified destination.

Note
The file format and other settings will be stored when the file is saved. The next time a file is exported, 
it will be exported with the same settings as the previous time.

Adding a Connected Device (on the same axis)
1.	 Click Add Device. A Device Search window opens. You can add measuring instruments to the 

DAQ - (host name) tab window of a measuring instrument already connected through DAQ 
and display them on the same axis. 

	 ► section 3.4
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Explanation

Loadable File Formats
► page 3-6
Details of various file formats ► page 1-7

Displaying Multiple Waveforms on the Same Axis
Multiple waveforms can be displayed on the same axis. For a display example, see page 3-34.

Saving a Project File with a Separate Name
The settings of the displayed file can be saved as a project file.

Exporting to a File
•	 You can save waveform data in waveform file (*.mf4), waveform file (*.csv), waveform file (*.csz), 

measurement result (*.csv), FFT file (*.csv), and serial bus analysis result (*.csv) formats.
•	 The above CSV and CSZ formats can also be selected with BOMs.

BOM stands for Byte Order Mark, a short piece of data added to the beginning of Unicode-encoded 
text. The BOM is used as a means to determine if the text is written in Unicode, the type of encoding, 
endianness, and so on.

Note
Saving DL950 power math (/G05, /MT1 option) data or motor dq analysis (/MT1 option) data
When data is exported to CSV format, multiple files are created for each power or motor dq analysis and 
harmonic analysis result. For details, see “When DL950 Power Math or Motor dq Analysis Results Are 
Exported in CSV Format” on page 3-47.

Numeric, Harmonic Bar, and Vector Export Settings
These settings are available only when saving data to a waveform file (.csv or .csz) and a 
WT5000’s numeric, harmonic bar, or vector display data is present. Saving in MF4 format is not 
applicable.
Item Description
Harmonics •	 Export target: Set the start order and end order.

	 The Harmonic Order settings under ASCII file setting become available.  
► page 3-46

•	 Export target: Set the start frequency and end frequency.
	 For harmonic measurement data complying with IEC 61000-4-7 Annex B (2k-9kHz), the 

Harmonic Frequency setting in the ASCII file settings becomes valid.  
► page 3-46

•	 The measured results of the Bar1 and Bar2 panels are exported to a file.
Numeric Export target: All saved data

The measured results of the Numeric1 and Numeric2 panels are exported to a file.
Matrix The measured results of the Matrix display are exported to a file.
Vector The measured results of the Vector display are exported to a file.
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Range to Save and Compression (Data Setting)
You can set these items when the file type is set to waveform file (.mf4) or waveform file (.csv).
Item Description
Range •	 Set the range to Overview, Cursor, or select from View1 to 4.

•	 When the storage file format is FFT file (*.csv), select from All Range, Cursor, Zoom1, 
and Zoom2.

Compression Set the compression to Non, PP Comp, or Decim.
Compressibility •	 This is valid when the compression is set to PP Comp.

	 Select from 5, 10, 20, 50, 100, 200, 500, 1000, 2000, 5000, and 10000.
•	 This is valid when the compression is set to Decim.
	 Select from 2, 5, 10, 20, 50, 100, 200, 500, 1000, 2000, 5000, and 10000.

Comment
You can enter up to 250 characters.

Configuring the ASCII File
You can set these items when the file type is set to waveform file (.csv or .csz).
•	 Header

Item Description
ON A header is included.
OFF A header is not included.

•	 Time Axis Information
Select the time axis information type from the following.
If you are saving an external clock waveform, only Point and OFF are available.

Item Description
Absolute time Measurement time

	 Example: 2021/11/16 08:30:11.848770580000 
Relative time Relative time from the start of measurement. Relative time in reference to the 

reference time axis (Reference time axis) in the channel settings. ► section 4.2
	 Example: 00:10:10.000000000000

Seconds Relative times are added with the display unit set to seconds.
	 Example: 610.000000000000

Point Assuming the output start point to be zero, points incremented per line are added.
OFF Time axis information is not included.

•	 Frequency
When the storage file format is FFT file (*.csv), you can select whether to save frequency 
information.
Item Description
ON Frequency information is saved.
OFF Frequency information is not saved.

•	 Decimal Point
You can select the decimal point and separator (data separation).
Item Description
Point The decimal point is a period, and the separator is a comma.
Comma The decimal point is a comma, and the separator is a period.
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•	 Separate and save each history
This is available only when a history waveform file is open.

Toggle switch Description
ON Files are divided and saved for each history. A history number is appended to each 

file name.
OFF Files are not divided for each history. Data is saved in a single CSV file.

•	 Save different sample rate waveforms in one file
This setting is unnecessary (invalid) when DL950 power or harmonic analysis (/G05, /MT1 option) data or 
motor dq analysis (/MT1 option) data is saved in CSV format.

Toggle switch/Item Description
ON Waveforms with different sampling rates are saved collectively to a single CSV file.

Interpolation method Select the interpolation method to apply between sampling data points.
•	 Interpolation
•	 Space: This is available only when data compression is set to Non.

OFF Channels with the same sampling rate are saved in separate files.

•	 Harmonic Order
You can set the following items when Harmonics is selected in the numeric, harmonic bar, and 
vector export settings (pages 3-41, 3-44).
Item Description
Start Order From the drop-down list, select the harmonic order to start exporting.

	 Total, DC, 1 to 500
End Order From the drop-down list, select the harmonic order to stop exporting.

	 Total, DC, 1 to 500

•	 Harmonic Frequency
For measurement data complying with IEC 61000-4-7 Annex B (2k-9kHz), you can set the 
following items when you select Harmonics in the numeric, harmonic bar, and vector export 
settings (pages 3-41 , 3-44).
Item Description
Start Frequency From the drop-down list, select the harmonic frequency to start exporting.

	 2100 to 9900
End Frequency From the drop-down list, select the harmonic frequency to stop exporting.

	 2100 to 9900

Note
If you want to load a CSV file into Excel, use the From Text/CSV button in the Get & Transform Data group 
on the Data tab in Excel.
If you double-click the file icon or use Open on the File tab in Excel, the default data format settings will be 
applied to the opened sheet, and the data may not be displayed properly.
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When DL950 Power Math or Motor dq Analysis Results Are 
Exported in CSV Format

When the power analysis function is in use, the motor dq analysis function cannot be used.

The computed results of DL950 power or harmonic analysis (/G05 option, /MT1 option) or motor 
dq Analysis (/MT1 option) are saved in timestamp format. Different time information is available by 
wiring system.
•	 Regardless of whether Save different sample rate waveforms in one file (previous page) is 

enabled or disabled, power analysis or motor dq analysis results (RTmath13 and RTmath14) and 
harmonic analysis results (RTmath15 and RTmath16) are exported to separate files.

•	 Further, power or motor dq analysis results and harmonic analysis results are exported to 
separate files by wiring system (time information).

•	 In the vertical direction, measured values are output line by line for each timestamp.

File Names of Output Data
(Output file name)_TS000.csv. 	 The 000 part is the index number.

Note
When MDF files containing timestamp data is saved through data acquisition (DAQ) with a version earlier 
than 22.2.1.0 of this software, if the data is exported in CSV format, a separate file is created for each 
RTmath channel. With a version 22.2.1.0 or later, MDF files are exported for each wiring system.
When MDF files are saved through data acquisition (DAQ) with a version earlier than 22.2.1.0, timestamps 
are saved for each DL950 RTmath channel. Since data may span over several RTmath channels depending 
on the wiring system, the software has been changed to save timestamps for each wiring system, not for 
each RTmath channel, on versions 22.2.1.0 and later.

Adding Device
Select Add Device to add another measuring instrument to the DAQ-host name) tab window when 
a measuring instrument is connected through the DAQ feature and display the waveforms on the 
same axis.
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Multiple waveform files can be converted into CSV or CSZ files (see pages 1-8 and 3-41). Files 
can be processed collectively without having to open them.

This section explains the following operations:
•	 Starting the application
•	 Selecting the target files and converting them to CSV or CSZ files

Procedure

Starting the Application
1.	 On the APPs tab, click CSV batch converter.

	 The CSV Batch Converter dialog box appears.

Selecting the Target Files and Converting Them to CSV or CSZ Files
2.	 Click Add file, and select the files you want to convert (MDF, WDF, WVF files).
	 The selected files appear in the file list.

•	 You can also select the files you want to convert and drop them on the file list.
•	 To select multiple files, click the files while holding down the Ctrl key.

CSV Batch Converter Dialog Box

	

Select the file type.

Numeric, harmonic 
bar, and vector 
export settings

Compression 
setting

Add file

File list

Configure the 
ASCII file.

Enter an output file name. Execute
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3.	 Select the file type.
File Type Description
•	 Waveform file (*.csv)
•	 Waveform file (*.csv) with BOM Converts all open waveform files to CSV format at once.

•	 Waveform file (*.csz)
•	 Waveform file (*.csz) with BOM

Converts all open waveform files into a compressed CSV file in 
Zip format.

If you select the CSV or CSZ format without a BOM, data is saved without a BOM.
BOM: Byte Order Mark ► page 3-44

4.	 Set the items.
	� The items you need to set are the same as those for “Waveform File (*.csv)” for Export to File 

(page 3-41).
	� However, the range to save and range of compression (Data Setting) are fixed to the entire range, and 

the channels to save is fixed to all channels.
•	 Numeric, harmonic bar, and vector export settings and compression settings ► page 3-44
•	 ASCII file settings ► page 3-45

5.	 Enter the output file name, and click Execute.
	 A progress bar is displayed while the conversion is in progress.

	� If you cancel the operation during the conversion process, the conversion is aborted after completing the 
conversion of the file being converted.

	 The converted CSV files are saved in the same folder as the files you selected to be 
converted.

	 If DL950 power math (/G05, /MT1 option) data or motor dq analysis (/MT1 option) data is 
converted collectively to CSV files, power analysis results, motor dq analysis results, and 
harmonic analysis results are saved to separate files for each specified file. For details, see 
“When DL950 Power Math or Motor dq Analysis Results Are Exported in CSV Format” on 
page 3-47.

Explanation

File Formats That Can Be Batch Converted to CSV or CSZ Files
You can select multiple file formats.
•	 MDF
•	 WDF
•	 WVF

File Names of Output Data
The names of the files after the conversion are the same as those of the files being converted. The 
extension becomes .csv or .csz.

When Waveforms with Different Sample Rates Are Saved to a Single File
(User-assigned file name)(name of the file to be converted).csv

When Waveforms Are Saved Separately by Sample Rates
(User-assigned file name)(name of the file to be converted)_(sample rate).csv

Note
If you want to load a CSV file into Excel, use the From Text/CSV button in the Get & Transform Data group 
on the Data tab in Excel.
If you double-click the file icon or use Open on the File tab in Excel, the default data format settings will be 
applied to the opened sheet, and the data may not be displayed properly.
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An image of panel shown in a tab window can be saved to the Clipboard or as screen capture data 
in the folder you specify.

The screen capture feature becomes available in the following cases:

Offline analysis
When a Overview, View, XY, History, or Dual Capture panel is displayed ► section 4.3
When a FFT View, Zoom, or [FFT] History panel is displayed ► section 4.11
When a Video panel is displayed
	 ►  �For details, see chapters 3 and 4 of the IS8000 Integrated Software High-speed Camera 

Synchronization Feature (FS1 option) User’s Manual, IM IS8000-61EN.
Remote control

When a remote control window is displayed ► section 6.1

	 Execute a screen capture

Capture Settings menu

This section explains the following operations:
•	 Selecting the panel to save
•	 Selecting the output destination and output format
•	 Executing a screen capture

Procedure

Selecting the Panel to Save
1.	 Click the panel you want to save.

	 The selected panel is activated, and the panel frame is displayed in light blue.

Selecting the Output Destination and Output Format
2.	 Click  next to Screen Capture, and select Capture Settings from the drop-down list.

	 A screen capture setting window appears.

		  Select the file type.

Select the output destination.

The output destination folder
Select the output destination folder.

Appears only when the output 
destination is Folder.

3.	 Select the output destination (Folder or Clipboard).

	 If you set the output destination to Clipboard, proceed to step 5.
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4.	 If you set the output destination to Folder, select the file type and output destination folder.

5.	 Click OK.

	 The settings are applied, and the screen capture setting window closes.

Executing a Screen Capture
6.	 Click Screen Capture.

	 The panel selected in step 1 is saved as screen capture data in the specified output 
destination.

Example of Saved Screen Capture Data
(When the Overview panel is saved)

Explanation

File Settings
Output Destination (Output)
Output Description
Clipboard The screen capture data is saved to the Clipboard.
Folder The image file is saved to the specified folder.

File Type
You can select from the following file types. This setting is valid when the output destination is 
set to Folder.
•	 PNG
•	 JPEG
•	 GIF

File Names of Screen Capture Data
When the output destination is set to Folder, the name of the file will be in the following format.

Saved panel (name of the panel to be saved)_date (yyyymmdd)_time (hhmmss)

Example: Overview_20220131_110745

Panels to Be Saved
• Overview • FFT View
• View1 to 4 • Zoom1 or Zoom2
• XY1 or XY2 • [FFT] History
• History • Video1 or Video2
• Dual Capture • Remote Control
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This section explains the following setting operations.
•	 Language
•	 Window Theme
•	 Layout
•	 Showing or Hiding the Launcher
•	 Generate Cache Files
•	 Confirm saving to Project file when finished

Procedure

Language
On the Setting menu, click Language to select the language of the software.
You can select from the following languages.

•	 Japanese
•	 English
•	 Chinese

Window Theme
On the Setting menu, click Theme to change the window theme of the software.
You can select from the following tones.

•	 Light
•	 Dark

Layout
On the Setting menu, click Layout to initialize the panel layout in the tab window or change the 
default layout settings that are applied at startup.
You can select the following items.

•	 Initialization
•	 Initial setting

Initialization
1.	 Click the tab of the tab window you want to control.
	 The selected tab window is activated, and the background color of the tab turns blue.
2.	 On the Setting menu, click Layout and then Initialization.
	 The panel layout will be initialized.
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Initial setting
You can use the settings of another analysis project file (.anpjt) to display another waveform 
file in the same panel layout.

However, analysis project files containing the following settings cannot be used.
•	 Save multiple files
•	 Display multiple tab windows

1.	 On the Setting menu, click Layout and then Initial setting.
	 The following window appears.

		

Specify an anpjt file.

Turns default layout settings on and off

Browse anpjt files.

Saves and applies the current 
layout as default

Item Description
Toggle switch ON: The default layout settings are enabled.

OFF: The default layout settings are disabled.
Default window layout 
settings (*.anpjt)

You can specify an analysis project file (.anpjt) saved in the past to use 
its layout settings.
If the specified analysis project file is not applicable, an error is 
displayed, and the file cannot be applied.

File conditions that can be specified
You can specify only project files that contain a single tab, displayed 
from a single file. You cannot specify multiple files, a file containing 
devices, or a file containing multiple tabs.

Save & apply current 
layout as default

The current layout is saved in an analysis project file.
The saved file is automatically applied to the Default window layout 
settings file.
If the current layout is inapplicable, an error is displayed, and the file 
cannot be applied.

Layout conditions that can be saved and applied
Layout conditions can be specified only when the following conditions 
are met.
•	 Layout of the current (active) tab only
•	 This active tab is displaying the information of a single file.
An error will occur if multiple files (coaxial) are displayed or when the 
online tab is activated. Also, the layout (project file) saved here will only 
contain information for the current tab.

2.	 Turn on the default layout settings toggle switch.
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Using the settings of an analysis project file saved in the past
3.	 Click [...]. An Open dialog box appears.

4.	 Specify a default window layout settings file (*.anpjt).

Saving the settings of the opened waveform file to an anpjt file and applying the settings
3.	 Click Save & apply current layout as default.
	 A Save As dialog box appears.
4.	 Enter a file name, and click OK.
	� The current layout is saved in an analysis project file. The saved file is automatically 

applied to the default layout settings file.

5.	 Click OK.
	� The layout settings are applied to the currently opened waveform file. They will also be 

applied to files that will be opened in the future.
	 If the currently opened tab window is inapplicable, the following error will appear.
	 “Settings cannot be applied when a view includes multiple files or when multiple windows are 

displayed.”

	 Clicking Cancel cancels the changes to the settings and closes the setting window.

Note
•	 Once set, the settings are automatically applied the next time you start the software. To stop using 

them, turn off the toggle switch.
•	 Settings are skipped (ignored) when their conditions do not match.

Example: When the target channel is a voltage channel but the channel in the anpjt file you want to 
apply is a logic channel.
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Showing or Hiding the Launcher
On the Setting menu, click Show the launcher at startup to select whether to show the launcher 
at startup.

Click the menu item to place or remove the check mark.
Check mark Description
Yes The launcher is shown at startup.
No The launcher is not shown as start, and the start window is shown instead.

Generate Cache Files
MDF files can be loaded quickly when you generate cache files.
From the Setting menu, click Generate cache files to enable or disable this feature.

Click the menu item to place or remove the check mark.
Check mark Description
Yes •	 When the menu item has a check mark and you open an MDF (.mf4 extension) file, a 

cache folder is created in the same path as the waveform file for the first time, and the 
cache file is saved.

	 The next time the same file is opened, it will load quickly.
•	 cache folder
	 The generated cache folder can be deleted. If it is not available the next time it is opened, 

it will be generated automatically.
No Cache files are not generated.

Confirm saving to Project file when finished
From the Setting menu, click Confirm saving to Project file when finished to enable or disable 
this feature.
Operation at closing ► section 3.1

Click the menu item to place or remove the check mark.
Check mark Description
Yes A confirmation is made to save a project file when finished. A Save As dialog box appears, 

and you can save the settings of the window being closed to a project file.
No A confirmation is not made to save a project file when finished. The window simply closes.
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Chapter 4	

Analyzing Measured Data (Offline Analysis)

This chapter explains how to analyze measured data on an offline PC.

4.1	 Opening Files

Procedure
1.	 Use any of the following methods to open a file or project file.

•	 On the launcher, click File Open and select a file.
•	� On the start window, click the File tab and then Open, or click Add File, and select a file.

	 A window opens for opening the file window. ► section 3.3

2.	 Select a file or specify the file name in the text box, and click Open.

	� An Analysis-(file name) tab window opens, and the waveforms of measured data are displayed 
in the Overview panel. The Waveform Analysis ribbon will appear.

		

Overview panel
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Waveform Analysis (Waveform Analysis) Ribbon

This is a ribbon for offline measurement. Click a tab to switch the ribbon.
Tab Description Refer To
View Loads and displays measurement data files. Section 4.2 to section 4.6
Analysis Analyzes measurement data files. Section 4.7 to section 4.10
FFT View Performs FFT computation and analysis. Section 4.11
Video This is the high-speed camera synchronization feature (option). Section 4.12

Explanation

Opening a Project File
To open an IS8000 project file (.anpjt), on the File tab, click Open. You cannot load a project file if 
you click Add File.

Opening by Dropping Files
Files with the following extensions can be loaded by dragging the files from the load source window 
to the data source display area, which is on the left side of the window.
Extension Description
.mf4 Measurement data saved in MF4 (MDF4.1) format

MDF files can be loaded quickly by enabling Generate cache files in the Setting menu.
See page 3-55.

.wdf YOKOGAWA’s standard format waveform data files

.wlk Shortcut to consecutive files created when a file is split and saved

.csv Data saved with this software, Xviewer, DL950, DL850 series, DL350, DLM5000 series, DLM4000 
series, DLM3000 series, DLM2000 series, WT5000, WT3000 series, or WT1800 series

.csz CSV files zipped and saved with this software

.wvf YOKOGAWA’s old file format

Opening by Double-Clicking
The files with the following extensions can be opened by double-clicking.
Extension Description
.mepjt IS8000 measurement project file
.anpjt IS8000 analysis project file
.mf4 Measurement data saved in MF4 (MDF4.1) format
.wdf YOKOGAWA’s standard format waveform data files
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Opening Multiple Files
You can use any of the following methods to open multiple files at once.
•	 In the Open dialog box, select multiple files.
•	 Drag multiple files to the data source display area.
•	 On the File tab, click Add File to select files.
•	 Under Waveform Files in the data source display area, select a file. Click [...] and select Start 

Coaxial.

Note
Loading files divided and saved by a measuring instrument
When a file is divided and saved with a measuring instrument such as the DL950, an underscore “_” and a 
3-digit serial number (000 to 999) are added to the end of the file name.
To load files that have been divided and saved by a measuring instrument with this software, place all the 
files in the same folder and open “filename_000.extension.” All divided files are loaded as one continuous 
data.
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This section explains how to configure the display channels for loaded measurement data (waveforms, 
power values).
•	 The settings are mostly the same as those in the Channel Setting window of Smart Setup. ► section 3.5
•	 This section explains only the settings that are different from those in the Channel Setting window of Smart Setup.

Procedure

Channel Setting Window
1.	 On the View tab, click Channel Setting. A Channel Setting window opens.

2.	 For each channel, set the waveform display conditions, groups, and so on.
•	 Set display groups.
•	 Channel number
•	 Enter the group name.
•	 Channels (trace names) registered in the group

		

Add channels. Select filter conditions.Reference time axis

Deletes the selected line

Aligns the selected range of settings 
to the contents of the first row

Resets the selected range of 
settings to default

Inverts the selected range of settings

Automatically sets the 
selected range of settings

Moves the selected line up

Moves the selected line down

Applies the settings and closes the window

Cancels the settings and closes the window

Applies the settings

List of measurement 
conditions of each channel

Adding Channels (Add Channel)
When you click Add Channel, the channels that can be added are displayed in a tree-style 
list. You can add the selected channels. ► page 3-14
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Reference Time Axis
Set the synchronized display method. You can select the following items from the drop-down 
list.
Item Description
Trigger Position Displays waveforms by aligning their trigger positions. The trigger position is set to 0 s.
Absolute Time Displays waveforms using absolute times.
First Displays waveforms by aligning the beginning of each waveform. The beginning is 

set to 0 s.
Last Displays waveforms by aligning the end of each waveform. The trigger position is 

set to 0 s.

Selecting Filter Conditions
► page 3-14

List of Measurement Conditions of Each Channel
For each channel number, you can set (1) the display format and the number of displayed 
digits of the values on the Analysis window, (2) logic waveform display conditions, and (3) the 
distal line, mesial line, proximal line, and high and low values used in waveform parameter 
computation.

•	 You can use the check boxes in the title line to collectively turn on or off the display 
conditions of the corresponding columns.

•	 You can set multiple items collectively. Select a range, and then click Auto, Invert, Copy, 
or Default below the list. ► page 3-19

Channel number

The items in the table are explained in order from left-most column.

Channel number
► page 3-15

Trace
► page 3-15

Model
► page 3-15
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Group1 (Group1)
•	 Adding and Deleting Groups
•	 Display (Display)

► page 3-16
•	 Mapping (Mapping)

► page 3-16

Measure Target (Measure Target)
You can select or clear the check box for each channel to select the channels to be measured.

*	 Logic waveforms, high-speed sampling waveforms (sub waveforms) of dual capture, WT5000 PP 
waveforms, external clock data, timestamp data (DL950 power math data or motor dq analysis 
data and Modbus/TCP (MB1 option) data) are excluded. Check boxes are not displayed for these.

Waveform Color (Color)
► page 3-16

Minimum (Min) and Maximum (Max)
► page 3-16

First Source
The beginning of the waveform of each channel can be displayed according to the position of 
the beginning of the channel selected here.

Example When data is acquired by connecting a DL950, WT5000, and ECU monitor, 
synchronizing the DL950 and WT5000, and aligning the beginning of the waveform 
on the DL950 and ECU monitor
The positions of the waveforms can be aligned and displayed by setting the reference 
time axis to absolute time and aligning the first source of the waveform on the ECU 
monitor with the DL950 channel.

Offset Time
You can offset the waveform display positions by the specified time.

Display Format (Format Type)
► page 3-17

Significant digits (Significant digits)
► page 3-17

Display Conditions of Logic Waveforms (Logic)
► page 3-18

Vertical Scale Unit (Unit)
► page 3-19
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Mode
Set the unit for distal, mesial, and proximal values. Select either of the following:
Item Description
% You can set the distal, mesial, and proximal values as percentages of the specified trace. 

The high value of the specified trace is equal to 100.0%, and the low value is equal to 0.0%.
Unit You can set the distal, mesial, and proximal values of the specified trace by specifying 

physical values, such as voltages or temperatures.

For details, see the measuring instrument’s user’s manual.

Distal Line, Mesial Line, and Proximal Line Values
You can set the distal, mesial, and proximal levels.
•	 Range when the mode is set to %

�0.0 to 100.0% (in steps of 0.1%)
•	 Range when the mode is set to Unit

Range defined by Min and Max specified in the channel settings
For details, see the measuring instrument’s user’s manual.

Setting the High and Low Levels
The high and low levels are the 100 % and 0 % levels used to measure various parameter 
values, such as the rise and fall times.
You can choose one of the following methods for setting the high and low levels.
•	 AUTO
•	 MAX-MIN
For details, see the measuring instrument’s user’s manual.

Selecting Display Groups
1.	 On the View tab, click Group Selection. You can select the channel groups to show in the 

Overview panel from the drop-down list.
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Explanation

Groups and Channels (Traces) That Can Be Registered
Channels (trace names) can be divided into up to 4 groups. Up to 32 channels can be registered in 
a group.

Displaying External Clock Waveforms
•	 The sample rate for an external clock waveform is displayed at 1 S/s. For an external clock 

waveform saved on the DL series, the pulse/rotate value is used as the sample rate.
•	 The horizontal scale is points. However, for the DL series, the horizontal scale is the value that 

results by dividing the number of points by the pulse/rotate value.
•	 Coaxial display is not possible for an external clock waveform loaded from a file.
•	 External clock waveforms are cannot be used with Measure, Math, or FFT.

Displaying Timestamps
•	 Data containing timestamps and measured results under irregular sample interval conditions are 

displayed.
•	 Timestamped waveforms are cannot be used with Measure, Math, or FFT.

Viewing the DL950 Power Math Results
Power Analysis and Harmonic Analysis (/G05 option, /MT1 option)
In power analysis and harmonic analysis, the analysis period* is from a zero crossing point to the 
next zero crossing point.* Calculations are performed on the data in this section, and the zero 
crossing time at the calculation start point and the calculation result are recorded (timestamp 
format). Since the calculation result is displayed based on the time of the calculation start point, it 
is possible to display the analysis result, the waveform data that is the basis of the calculation, and 
the calculation result without phase shift.

*	 In power analysis, the analysis period differs depending on the type of calculation period (calc period).
	 If the type is edge (Edge), the analysis period is from the zero crossing point of the edge source to the 

zero crossing point (for power analysis, the analysis period can be specified even for the encoder’s 
rotation angle (with a threshold setting)). If the type is Timer, the analysis period is the specified update 
time (Auto Timer). If the type is transient (Transient), the analysis period switches when the edge and 
Timer switch.

•	 The timestamp data value at the cursor position (the previous value if it is not available) is 
displayed.

•	 The sample rate is indicated as “---.”
•	 DL950 power math data saved in MDF format on the IS8000 Software cannot be used with 

Measure, Math, or FFT. (Files saved in WDF format on the DL950 are resampled and displayed 
as fixed-period data and can be used with Measure, Math, and FFT.)
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This section explains the following operations:
• Displaying Overview Waveforms • Numeric Display (WT5000)
• Displaying View Waveforms • Displaying Harmonic Bar Graphs (WT5000)
• Displaying History Waveforms • Displaying Vector (WT5000)
• Displaying Dual Capture Waveforms • Moving and Zooming Waveforms
• Displaying XY Waveforms • Splitting and Displaying Windows

Procedure

Displaying Overview Waveforms
1.	 When you open a waveform data file, overview waveforms and vertical cursor measurement 

results are displayed. On the View tab, click Overview to show or hide the Overview panel.
Cursor measurement ► section 4.4

Overview panel
The entire waveform data is displayed in the Overview panel.

Example Displaying Overview Waveforms (Overlap Display) and Properties

Overview panel Vertical cursor 
panel

Overview  
properties

Trace name

Sampling rate

T/div

0 Level

Scale values Time from a trigger

Trigger position (    )

When waveforms are overlapped, clicking the top waveform causes the waveform under it to 
become active.
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Overview Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
Overview waveforms can be displayed separately by trace names.
•	 Share property setting in Overview/View

Check Box Description
ON The split style setting is shared among overview waveforms and view 1 to 4 waveforms.

•	 Cursor measurement values use the settings of the Overview panel.
•	 When the display style is Split, detailed settings such as Auto, Count, and Tile 

Column and Row are not shared.
Set these separately for the overview and view waveforms.

OFF The split style setting is not shared among overview waveforms and view 1 to 4 
waveforms.
Set these separately for the overview and view waveforms.

•	 Overlap, Split, and Tile
You can select the waveform display style.
Display Style Description
Overlap Waveforms are displayed overlapped in a single window.

The trace you select in the list of channels in the properties is shown in front.
Split The window is split horizontally. The waveforms are mapped to the split areas in 

ascending order by channel number.
Auto ON: The waveforms are displayed at regular intervals based on the specified 

number of divisions.
Count: You can set the number of splits (Count) to All or a value between 1 and 10.

OFF: You can change the height of each trace display by dragging the boundaries of 
the split trace displays.
Right-click the area to the left of each trace to display the menu shown in the 
following figure.

Align to this height
Aligns the height of all traces with the height 
of the clicked trace.

Cancel
Closes the menu

Align height in number of row
Divides the window by the specified number 
of rows. From the drop-down list, select the 
number of rows.
(Auto, 1 to 32)

Tile The waveforms are tiled at the trace name level. Set the number of columns and the 
number of rows.

For display examples of split styles ► page 4-30

Channel (Channel)
The trace names, sample rates, source file names of the channels displayed on the Overview 
panel are shown in a table.

The active waveform channel is highlighted in light gray.
If the display style is Overlap, when you click a trace on the list of channels, that channel is shown in front.
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Position
•	 Offset

When you click the following item, the vertical movement mode can be turned on or off for 
the displayed waveform.
Item Description

Y You can turn on or off the waveform vertical movement mode.
ON: The button’s background color changes to light blue. On the Overview panel, 

the pointer icon changes to the shape shown in the following figure. Click the 
waveform you want to control to select it, and then drag it vertically.

The maximum and minimum values of the range that results by moving the 
waveform vertically are applied to the maximum and minimum values of the 
channel setting.

OFF:  The waveform cannot be moved vertically.

Explanation

Tooltip Display
If you select a waveform with the pointer and keep the mouse button held down, the information 
about that point is displayed. Information is displayed for overview and view waveforms.
Example of a time vs. voltage waveform

The time and voltage are displayed.
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Displaying View Waveforms
1.	 On the View tab, click View 1 to View 4 to show or hide View 1 to 4 panels.

View 1 to 4 Panels
The display areas of the View 1 to 4 panels are indicated with frames on the overview 
waveform.

Example Displaying View Waveforms (Overlap Display) and Properties

View 2 panel

View 1 panel

Select the scrolling direction or stop scrolling
Select the scrolling speed

Drag to move the section to zoom

Zoom frame (View 1) 

Zoom frame (View 2) 

View 1 
properties

View 1 to 4 Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
View waveforms can be displayed separately by trace names.
•	 Share Property Setting in Overview/View

The split style setting can be shared among overview waveforms and view 1 to 4 
waveforms. ► page 4-10

•	 Overlap, Split, and Tile
► page 4-10

Channel (Channel)
The trace names, sample rates, source file names of the channels displayed in the View 1 to 4 
panels are shown in a table.
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Position
•	 Offset

When you click the  Y button, the vertical movement mode can be turned on or off for the 
view waveform.
► page 4-11

•	 View range
When you click the following items, you can set the zoom area to any position and zoom in 
or out of the target view waveform.
Item Description
Drag to set the range When you click this button and drag the overview waveform to any 

position, the zoom area is set to the area that results from dragging.
Horizontal ‒/+ Each time you click [-] or [+], the waveform is expanded or reduced 

horizontally.
Vertical ‒/+ Each time you click [-] or [+], the waveform is expanded or reduced 

vertically.

Horizontal auto scroll
The target view waveform can be scrolled horizontally automatically.
Item Description

Scrolling starts to the left.
Scrolling stops.
Scrolling starts to the right.

Scroll Speed You can select the auto scroll speed. From the drop-down list, you can select x1 
(normal speed) or x2 (double speed).

Shortcut key description
Shortcut Key Description
Mouse wheel Vertical movement of the scroll box
Shift + mouse wheel •	 Horizontal movement of the scroll box

•	 Horizontal movement of the zoom position when a zoom 
waveform is selected

Ctrl + mouse wheel Horizontal zoom
Ctrl + Alt + mouse wheel Changing the range (the channel settings’ maximum and minimum 

values)
Space + dragging Move the zoom position in any direction
Space + Shift + dragging Move the zoom position horizontally

Moving the Zoom Position
You can move the zoom position using any of the following methods.
•	 Dragging
•	 Scroll Bar
•	 Auto Scroll
•	 Using shortcut keys ► See the previous section

Dragging
The following two methods are available.
•	 Moving the Zoom Frames on the Overview Panel
•	 Moving the Zoom Area on the View Panel
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Moving the Zoom Frames on the Overview Panel
1.	 When you click the white frame (zoom frame: view1 to 4) indicating the zoom area of the 

overview waveform, the frame color changes to light blue, and white squares (anchor 
points) are displayed on the frame.

2.	 If you drag a point within the zoom frame when the anchor points are shown, you can 
move the entire zoom area.

Moving the Zoom Area on the View Panel
1.	 Click the view panel to select it. The view panel frame color changes to light blue.

2.	 Place the mouse pointer on the view panel, and press the space key. The mouse pointer 
changes to  (a palm shape).

3.	 Then click. The mouse pointer changes to  (a grabbing hand shape). Then drag to 
move the zoom area.

	 The direction in which it can be moved depends on the split style of the view waveform.
Split Style Description
Overlap and Tile Can be moved in any direction.
Split Can be moved horizontally.

	 Example of overlapped view waveform display

		

View panel

Zoom frame

4.	 If you drag while holding down the Shift key, you can limit the movement of the zoom 
range to the horizontal direction.

Scroll Bar
•	 You can drag the scroll box at the bottom of a View panel (View 1 to 4) to move the zoom 

position horizontally.
•	 Click  or  at the ends of the scroll bar to move the zoom position left or right.
•	 Click left or right of the scroll box to move the zoom position by one zoom window.

Note
You can also move the zoom position with a shortcut key. After selecting the target View panel, use 
the following shortcut key.

	 Shift+mouse wheel: The scroll box is moved horizontally.
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Auto Scroll
You can perform the following operations in the bottom area of a View panel (View 1 to 4) or 
the property display area.

1.	 To start scrolling, click  or  to specify the direction you want to scroll in.

2.	 Click ■ to stop scrolling.

3.	 Click  or  to resume scrolling.

Auto Scroll Speed
From the drop-down list, you can select x1 (normal speed) or x2 (double speed).

Note
Scrolling is not possible while waveform parameters are being measured or while computation is 
progress.

Changing the Zoom Area
You can change the zoom area in the following ways.
•	 Dragging the zoom frame
•	 Using shortcut keys ►page 4-13

Dragging the Zoom Frame
1.	 When you click the zoom frame (view 1 to 4) of the overview waveform, the frame color 

changes to light blue, and anchor points are displayed on the frame.

2.	 Dragging these anchor points changes the zoom area. 
	 The anchor point display changes depending on the split style of the overview waveform.

Split Style Description
Overlap and Tile Anchor points are shown in the four corners of the zoom frame.
Split Anchor points are shown at the left and right of the zoom frame.

	 When the waveform display area is narrow, some of the anchor points may not be shown.

Note
You can also change the zoom area with a shortcut key. After selecting the target View panel, use the 
following shortcut key.

	 Ctrl+mouse wheel: The zoom area is expanded or reduced horizontally.

Explanation

Tooltip Display
If you select a waveform with the pointer and keep the mouse button held down, the information 
about that point is displayed. Information is displayed for overview and view waveforms.
► page 4-11

Zoom Factor
The maximum zoom factor varies depending on the displayed data.
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Procedure

Displaying History Waveforms
1.	 On the View tab, click History to show or hide the History panel.

History Panel
•	 When a history waveform file is open, you can display the History panel.
•	 The display group settings (waveform color, channel registration, show/hide, and Y-axis 

minimum and maximum) are applied to waveforms displayed in the history panel.
Thumbnail Display
The top area of the History panel displays history waveforms.
•	 Selecting the Active Waveform

When you click a thumbnail display to activate it, that waveform is displayed in the history 
waveform chart in the bottom area of the History panel.

•	 Selecting an Inactive Waveform
When you select the check box below a thumbnail display, the selected waveform is 
displayed overlapped on the history waveform chart. An inactive waveform appears darker 
than the active waveform.

Example Displaying History Waveforms and Properties

Thumbnail display

History panel

History waveform chart

View 1 panel

Overview panel
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History Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
The waveforms displayed on the history waveform chart can be split by trace name and 
displayed. 
•	 Overlap, Split, and Tile
► page 4-10

Channel (Channel)
The history waveform chart’s trace names, sample rates, source file names of the displayed 
channels are shown in a table.

Other Settings (Other)
•	 ALL Display

Item Description
All ON Click this to display all history waveforms on the history waveform chart.
All OFF Click this to display only the active waveform on the history waveform chart.

•	 Displaying the Thumbnail Range in the View1 Panel
You can specify the following setting using the Display the thumbnail to View1 check box.
Check Box Description
ON When the View1 panel is displayed, clicking a history waveform thumbnail causes 

the thumbnail range to be displayed in the View1 panel.
You can analyze the history waveform range displayed in the View1 panel.

OFF Clicking a history waveform thumbnail does not cause the thumbnail range to be 
displayed in the View1 panel.

Explanation

Data That Can Be Displayed in the History Panel
The waveforms of multiple records saved using the YOKOGAWA DL series’ sequential store, single 
(N) trigger mode, and history features can displayed in a table.
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Procedure

Displaying Dual Capture Waveforms
1.	 On the View tab, click Dual Capture to show or hide the dual capture panel.

Dual Capture Panel
•	 When a dual capture waveform file is open, you can display the Dual Capture panel.
•	 The display group settings (waveform color, channel registration, show/hide, and Y-axis 

minimum and maximum) are applied to waveforms displayed in the Dual Capture panel.

Thumbnail Display
The top area of the Dual Capture panel displays captured waveforms.
•	 Selecting the Active Waveform

When you click a thumbnail display to activate it, that waveform is displayed in the dual 
capture waveform chart in the bottom area of the Dual Capture panel.

•	 Selecting an Inactive Waveform
When you select the check box below a thumbnail display, the selected waveform is 
displayed on the dual capture waveform chart.
An inactive waveform appears darker than the active waveform.

Example Displaying Dual Capture Waveforms and Properties

Thumbnail display

Dual Capture panel

Dual capture waveform chart

View 1 panel

Overview panel
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Overview and Dual Capture Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
The waveforms displayed on the overview waveform or dual capture waveform chart can be 
split by trace name and displayed. 
•	 Overlap, Split, and Tile
► page 4-10

Channel (Channel)
The overview waveform or dual capture waveform chart’s trace names, sample rates, source 
file names of the displayed channels are shown in a table.
The mark m  in the trace name represents the low-speed sampling waveform (main waveform) 
of dual capture and mark s  the high-speed sampling waveform (sub waveform).

	

Display example
Dual Capture propertiesOverview properties

Low-speed sampling 
waveform 
(main waveform)

High-speed sampling 
waveform 
(sub waveform)

Dual Capture Properties
Other Settings (Other)
•	 ALL Display

Item Description
All ON Click this to display all captured waveforms on the dual capture waveform chart.
All OFF Click this to display only the active waveform on the dual capture waveform chart.

•	 Displaying the Thumbnail Range in the View1 Panel
You can specify the following setting using the Display the thumbnail to View1 check box.
Check Box Setting
ON When the View1 panel is displayed, clicking a captured waveform thumbnail causes 

the thumbnail range to be displayed in the View1 panel.
You can analyze the captured waveform range displayed in the View1 panel.

OFF Clicking a captured waveform thumbnail does not cause the thumbnail range to be 
displayed in the View1 panel.

Explanation

Data That Can Be Displayed in the Dual Capture Panel
Overview waveforms and captured waveforms acquired using the DL850 or DL950 series’ dual 
capture feature can be displayed.



4-20 IM IS8000-01EN

4.3  Using the Window

Procedure

Displaying XY Waveforms
1.	 On the View tab, click XY1, XY2 to show or hide the XY panel.

XY1 and 2 Panels
•	 The channel name selected with Y Trace in the property display area (XY Setting) in the 

unit are displayed.
•	 The minimum and maximum values in the channel settings are applied to the Y-axis and 

X-axis scales. The waveform color in the channel settings is applied to the text color.
•	 The trace name of the channel assigned to X Trace of the active waveform (forming a pair 

with Y Trace) and the unit are displayed. The waveform color in the channel settings is 
applied to the trace name and unit.

Example Displaying XY Waveforms and Properties

XY2 panel

XY1 panel

XY2 
properties

Overview panel

XY1 and 2 Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

XY Setting
•	 Selecting the Source Waveforms (Range)

Select the source waveform type from the Range drop-down list in the property display 
area.
Source Waveform Description
Overview XY waveforms are displayed for all waveforms displayed in the Overview panel.
View1 to 4 XY waveforms are displayed for the waveforms displayed in the View 1 to 4 

panels (the data in the areas enclosed by the zoom frames).
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X Trace and Y Trace
From the X-Trace list, select the waveform to assign to the X-axis (trace name). The Y-axis is 
assigned with a waveform other than that assigned to the X-axis.
Specify waveforms with the same sample rate for X and Y. The same sample waveform list 
selected with the X trace is displayed in the Y trace list.

Channel (Channel)
The trace names, sample rates, source file names of the displayed channels on the XY1 and 
2 panels are shown in a table.

Overlaying on the X-Y waveform
The active waveform in the history panel can be displayed overlapped on the XY panel.
•	 If Range is set to Overview, the waveform in the Overview panel is overlapped.
•	 If Range is set to View1 to 4, the waveform in the View1 to 4 panels is overlapped.

Note
XY display is not possible on logic waveforms or WT5000’s PP waveforms.
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Procedure

Numeric Display (WT5000)
1.	 On the View tab, click Numeric1 or Numeric2 to show or hide the Numeric 1 or 2 panel.

Numeric 1 and 2 Panels
The measurement data values at the vertical cursor 1 position are displayed numerically.

Cursor operation ► section 4.4

Example Displaying the Numeric 1 Panel (4-value display) and Properties

Cursor 1 

Numeric 1 panel

Numeric 1 
properties

Numeric 1 and 2 Properties
You can set the numeric display format in the property display area of each panel.

Numeric Data Display

Display Format Description
4 items 4-value display. Four numeric data values are displayed in two columns.
8 items 8-value display. Eight numeric data values are displayed in two columns.
16 items 16-value display. 16 numeric data values are displayed in four columns.
32 items 32-value display. 32 numeric data values are displayed in four columns.
Matrix Matrix display. A table of numeric data is displayed with measurement functions 

listed vertically and symbols indicating elements and wiring units listed horizontally.
Data can be displayed for all connected units and for all measurement modes (850 
channels max.).*
*	 For 17 functions × (7 elements + 3 wiring units) × 5 units max.

Measure Mode Select the measurement mode of the function you want to display from the following:
	 RMS, MEAN, DC, RMEAN, AC

Select element 
to display

Show or hide the following elements and wiring units by selecting or unselecting the 
check boxes.
	 Element 1 to 7, ΣA , ΣB , ΣC
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•	 Display Example
4 items (4-value display) 8 items (8-value display)

16 items (16-value display) 32 items (32-value display)

Matrix (Matrix display)
When Element1 to 5 are displayed
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Procedure

Displaying Harmonic Bar Graphs (WT5000)
1.	 On the View tab, click Bar1, Bar2 to show or hide the bar panel.

Bar 1 and 2 Panels
Harmonic measurement data values at the vertical cursor 1 position are displayed in a bar 
graph and numeric list for each harmonic or frequency.*

Cursor operation ► section 4.4

Example Displaying Harmonic Bar Graphs and Properties

Bar1 panel

Bar1
properties

Harmonic bar graphs Numeric list

Cursor 1 

When you select a value in the numeric 
list, the boundary of the corresponding 
harmonic bar is highlighted.

* �For measurement data recorded with the launcher’s DAQ (IEC 2k-9kHz) feature, the 
numeric list is displayed by frequency.

		

Bar1 panel

Harmonic bar graphs Numeric list

Displayed by frequency
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On the Bar 1 and 2 panels, you can display harmonic bar graphs and numeric lists. Up to 
three of these elements can be displayed.

		

Bar 1 and 2 Properties
Bar2 propertiesBar1 properties

Shows or hides numeric lists
Synchronizes or 
unsynchronizes numeric lists

The following items are displayed in the property display area.

Bar Setting
•	 Function

Bar graph functions are displayed.

•	 Color
Bar graph colors are displayed. Double-click to select the bar graph color to display.

•	 Start Order and End Order
Double-click to select from a drop-down list the harmonic orders or frequencies* of the 
numeric data to display.
If the start order is greater than the end order, only the start order is displayed.
*	 For IEC 61000-4-7 Annex B (2k-9kHz) harmonic measurement data, frequencies are 

displayed. You can select the start and end frequencies.
•	 Minimum (Min) and Maximum (Max)

Set the maximum and minimum values for displaying harmonic bar graphs.
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•	 Numeric Display (Numeric List)
Show or hide the harmonic numeric list with the check box. The default setting is ON.
Check Box Setting
ON A numeric list is displayed to the right of the bar graph.
OFF A numeric list is not displayed.

•	 Synchronization (Synchronization)
Set whether to synchronize the scrolling of multiple numeric lists with the check box.
Check Box Setting
ON The vertical scrolling of the numeric lists is synchronized. When you control any of 

the scroll bars or turn the mouse wheel on any of the numeric lists, all the numeric 
lists on the same panel scrolls in sync.

OFF The vertical scrolling of the numeric lists is not synchronized. You can scroll each 
numeric list separately.
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Procedure

Displaying Vector (WT5000)
1.	 On the View tab, click Vector1, Vector2 to show or hide the vector panel.

Vector 1 and 2 Panels
The measurement data values at the vertical cursor 1 position are displayed in a vector graph 
and numerically.

Cursor operation ► section 4.4

The relationship of the phase difference and magnitude (rms value) between the fundamental 
waves U(1) and I(1) of each element assigned to the selected wiring unit is displayed using 
vectors. The positive vertical axis is set to zero (angle zero), and the vector of each input 
signal is displayed.

Example showing the Vector1 panel and properties (vector display of wiring unit C)

Vector1 panel

Vector1
properties

Numeric display 
(magnitude) of input 
element 5

Numeric display 
(magnitude) of input 
element 6

Numeric display (magnitude) of input element 7
Numeric display (phase difference) of wiring unit C
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Vector 1 and 2 Properties

Turns the numeric display on and off

Set the display colors.

Set the zoom factor.

Vector source

The following items are displayed in the property display area.

Vector Setting
•	 Vector Source (Object)

The vector display source, an element or wiring unit, is displayed.

•	 Voltage Zoom Factor (U Mag), Current Zoom Factor (I Mag)
Set the zoom factors (0.100 to 100.000) of the fundamental waves U(1) and I(1).
The value that indicates the size of the vector display’s peripheral circle changes according 
to the zoom factor, and the size of the vectors that indicate U (1) and I (1) change 
accordingly as well.

•	 Display Colors (L1 to L6)
Line colors of the vector graph are shown. Double-click to select the color of each line.

•	 Numeric Display (Numeric)
The numeric display can be shown or hidden with the check box.
Check Box Description
ON The phase difference and magnitude (rms value) between the fundamental waves 

U(1) and I(1) of each element assigned to the selected wiring unit are displayed 
numerically.
Example of numeric display ► page 4-27

OFF Numeric values are not displayed.



4-29IM IS8000-01EN

4.3  Using the Window

Procedure

Moving and Zooming Waveforms
You can perform these operations in the Overview and View panels.
•	 Displaying the overview waveform ► page 4-9
•	 Displaying view waveforms ► page 4-12

1.	 Select the overview or view waveform panel you want to control.

Moving a Waveform Vertically
2.	 Under Position > Offset in properties, click  Y. 

	 The waveform vertical movement mode is turned on. ► page 4-11

3.	 Drag the overview or view waveform you want to move.

	 The waveform is moved vertically.

Zooming In or Out of a Specified Point
You can use shortcut keys to change a range (the maximum and minimum values of a 
channel) without opening the channel setting window.

2.	 On the waveform, point to the center position you want to zoom in or out of.

3.	 While holding down the Ctrl and Alt keys, turn the mouse wheel.

	 The pointer icon in the waveform window changes in shape as shown in the following 
figure, and the waveform is expanded or reduced around the pointer.

		

Zooming In on or Out of a Waveform
Zooming Vertically
2.	 Under Position > View range in the view properties, click [-] or [+] next to Vertical.

Vertical Description
‒ The zoom target waveform is reduced vertically each time you click the button.
+ The zoom target waveform is expanded vertically each time you click the button.

Zooming Horizontally
2.	 Under Position > View range in the view properties, click [-] or [+] next to Horizontal.

Horizontal Description
‒ The zoom target waveform is reduced horizontally each time you click the button.
+ The zoom target waveform is expanded horizontally each time you click the 

button.

Explanation

Shortcut Keys for Moving and Zooming Waveforms
► “Shortcut key description” on page 4-13
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Procedure

Splitting and Displaying Windows
Split Waveform Display
If the waveforms are difficult to view because they are overlapped, you can select a split style 
in the properties to split the waveforms displayed in the Overview and View panels at the trace 
name level.
► “Split Style” on page 4-10

Setting the Split Display
The default number of splits is automatically detected and set to the number of displayed 
source waveforms. This number is shared between the Overview and View panels. The 
default value can be changed in the properties of the overview and view. You can set separate 
number of splits for the Overview and View panels or set it to any value like.
► “Share property setting in Overview/View” on page 4-10

Example of Split Display Style Set to Split

Select Split, and set Auto 
and Count.

Example of Split Display Style Set to Tile

		

Select Tile, and set 
Column and Row.
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This section explains the following operations:
•	 Measuring with vertical cursors
•	 Measuring with horizontal cursors

Procedure

Measuring with Vertical Cursors
1.	 On the View tab, click Vertical Cursor to display two vertical cursors in the Overview and 

View panels.

Vertical Cursor Panel
The Vertical Cursor panel displays the measured value at each cursor position (time), the 
differences in times and measured values between the two cursors, and so on.

Example Displaying Vertical Cursors and Properties (When Point Display is ON)

Vertical cursor panel

Cursor 1 
(can be moved by dragging)

Cursor positions
Time difference between 
cursors 1 and 2

Turns point display 
on and off

Measured value of cursor 1
(intersection of cursor 1 
and waveforms)

Cursor 2 
(can be moved by dragging)

Vertical cursor  
properties

Measured value difference 
of cursors 1 and 2

Measured value of cursor 2
(intersection of cursor 2 
and waveforms)View 1 panel

Overview panel

*	 When the horizontal scale display format is Absolute time, the panel is displayed as follows. Values 
can be entered in time format. Setting the horizontal scale display format ► section 4.5
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Moving the Vertical Cursors
•	 You can drag each cursor.
•	 You can click the cursor value in the Vertical Cursor panel and enter the value of the 

position you want to move the cursor to. The cursor will move to the specified position.
•	 If you select Vertical Cursor > Move Cursor (1)/(2) Here from the shortcut menu that 

appears by selecting the vertical cursor command (icon) and right-clicking in the Overview 
and View panel, you can move the cursor to the position you click.

	

Cursor positions

Time difference between cursors 1 and 2

*	 For logic waveforms, the values will be blank.

Note
If measured data is present at the cursor position, the intersections between the waveforms and cursor are 
indicated with circles.
If waveforms measured at different sample rates are displayed in the same window, measured data may 
not be present at the cursor position. For such a waveform, the circle is not displayed at the intersection 
between the waveform and cursor. However, measured value is displayed by interpolating from the previous 
measured value.
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Measuring with Horizontal Cursors
1.	 On the View menu, click Horizontal Cursor to display two horizontal cursors in the Overview 

and View panels.

Note
When the waveforms shown in the Overview and View panels are different (when “Share property setting in 
Overview/View” is set to off), horizontal cursors are not displayed in the View panel.

Horizontal Cursor Panel
The Horizontal Cursor panel displays the measured value at each cursor.

Cursor 1 (can be moved by dragging)
Cursor 2 (can be moved by dragging)

Cursor 1 Cursor 2

Horizontal Cursor Panel

Measured value difference of 
cursors 1 and 2
Measured value of cursor 2
(intersection of cursor 2 and 
waveforms)
Measured value of cursor 1
(intersection of cursor 1 and 
waveforms)

*	 For logic waveforms, “***” is displayed.

Moving the Horizontal Cursors
•	 You can drag each cursor.
•	 You can click the cursor value in the Horizontal Cursor panel and enter the value of the 

position you want to move the cursor to. The cursor will move to the specified position.
•	 If you select Horizontal Cursor > Move Cursor (1)/(2) Here from the shortcut menu 

that appears by selecting the horizontal cursor command (icon) and right-clicking in the 
Overview and View panel, you can move the cursor to the position you click.
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Explanation

Cursor Position Display
Time Display
The time is displayed in absolute or relative time. You can select the display type with the 
horizontal axis display format.
•	 Absolute time: The cursor positions are displayed using absolute times.
•	 Relative time: The cursor positions are displayed using relative times from the trigger position.
Setting the horizontal scale display format ► section 4.5

Point Display
Measurements at the vertical cursors can be displayed in terms of the number of points. Set 
whether to show or hide the number of points using Display Settings > Point Display in the 
vertical cursor properties.
Check Box Description
ON The number of points is displayed above the cursor measurement value (time display) 

in the vertical cursor panel.
The number of points is counted with the beginning of each trace assumed to be zero. 
Even when two traces have the same sample rate, if the start positions are different, 
the number of points at each cursor position will be different.

OFF Only the cursor measurement value (time display) is shown. The number of points is 
not shown.

Note
When DL950 power math waveform data (timestamp format) is displayed
The timestamp data value at the cursor position is displayed. If the data is not available, the previous data 
value is displayed.
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This section explains the following display settings.
•	 Grid
•	 Horizontal axis
•	 Color
•	 Waveform and grid line weight
•	 Waveform display panel’s scale information

Procedure

Display Setting
1.	 On the View tab, click Display Setting to open the display setting dialog box. Click the 

Graticule, Horizontal Axis, Color, Size, and Other information tabs, and configure the display 
settings.

Grid
When you click the Graticule tab, the following item appears. You can set the number of 
vertical divisions.

Select the number of vertical scale divisions.
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Horizontal Axis Display Format
When you click the Horizontal Axis tab, the following items appear. You can set the horizontal 
axis display format.

Select the time display format.

Turns the detailed time display on or off

Select the type of time to display on the 
horizontal scale.

Time
You can set the type of time to display on the horizontal scale.
Type Description
Relative Time Relative time from the trigger time. Relative time in reference to the reference time 

axis (Reference time axis) in the channel settings. ► section 4.2
Absolute Time Measured time (absolute time)

Include Year
Setting Description
On The Gregorian year is displayed when absolute time is displayed.
Off The Gregorian year is omitted when absolute time is displayed.

Color
When you click the Color tab, the following items appear. Using the color palette, you can set 
the window background, grid, and text colors.

Inverts the color tones.

Sets the background color for the waveforms
Sets the background color of the windows

Sets the color of the text
Sets the colors of the graticule and the divisions

Inverts the color tones of all items
Resets settings to their defaults
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Waveform and Grid Line Weight
When you click the Size tab, the following items appear. You can set the waveform and grid 
line weight.

Select the waveform thickness
(1 to 6 px)

Select the grid line thickness
(1 to 6 px)

Other
When you click the Other Information tab, the following items appear. You can set the 
waveform interpolation and the bit label display on/off state. 

Waveform interpolation

Turns bit label display on or off

Waveform Interpolation
You can change the setting to display the waveforms as follows:
Setting Description
Off Waveforms are displayed without connecting between measurement points with lines.
Line Waveforms are displayed by connecting between measurement points with lines.

Bit Label Display
The bit names of logic waveforms can be displayed in the Overview panel.
Setting Description
Off Bit names are not displayed.
On Bit names are displayed.

Bit names
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Note
Bit labels are not displayed if the display area of the Overview panel is narrow. To display bit labels, 
do the following:
•	 Drag the Overview panel vertically to expand it.
•	 Reduce the number of split windows.

Explanation

Display Color Settings
You cannot change the colors of the displayed waveforms in the display setting dialog box. You can 
change the waveform color settings in the Channel Setting window. ► sections 3.5, 4.2

Tone Inversion
Click Inversion to invert the tone. Clicking the button again sets the colors back to the original 
settings.

Initialization
Click Default to reset the color settings to their defaults.
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Multiple waveforms can be displayed on a single time axis.
•	 When multiple files are selected and opened, the waveforms are displayed on a single time axis.
•	 If you add waveforms of another file to waveforms that are displayed, you can set the coaxial 

display in the following manner.
	- From the list of waveform files, select the files you want to load, right-click to open the shortcut 

menu, and set Start Coaxial.
	- From the list of waveform files, drag and drop the files you want to load onto the displayed 

waveforms.
► “Waveform Files” on page 3-32
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4.7	 Automatically Measuring Waveform 
Parameters

This section explains the following operations:
• Automatically Measuring Waveform Parameters • Automated Measurement of Cycle Statistics
• Automated Measurement of History Statistics

Procedure

Automatically Measuring Waveform Parameters
Setting the measurement items
1.	 From the Wave Parameter Settings drop-down list on the Analysis tab, select Wave 

Parameter.
*	 If Waveform Parameter is already selected, click Measure Setting.

	 A Waveform Parameter Setting dialog box appears.

2.	 Set the measurement items and the display conditions of measurement results, and click 
OK.

				  

Turns measurement items on or off

Set the start time.

Starts automated 
measurement

Set the end time.

Voltage measurement items

Time measurement items

Area measurement items

Names of the items 
to be measured

Sets the cursor 
range to start 
and end times

	� The dialog box closes, and automated measurement starts.
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	 When the measurement is completed, a measurement result panel appears. A 
measurement range (Measure) bar appears at the top of the Overview panel and View 
panel.

Displaying Measured Results
1.	 On the Analysis tab, click Measure to display the Measure Result panel.

Rows: channel, 
columns: measured items

Rows: measured items, 
columns: channel

Drag the left edge of the Measure bar to change 
the math start position and computation time.

Drag the right edge of the Measure 
bar to change the computation time.

Measured results

Measurement items to measure 
automatically
(Set in the waveform parameter 
setting dialog box)

Measurement result panel

Measurement start point cursor Measurement end point cursor

Swaps the rows and columns of 
the measurement result display

Measurement 
time period

	 If you change the measurement range, the wave parameters are automatically 
remeasured.

Explanation

Items That Can Be Measured
For waveform parameters, you can set and measure voltage parameters, time parameters, and 
area parameters.
You can also set the distal line, mesial line, proximal line, and high and low values for each channel 
on the channel setting window. (see section 4.2).

Note
•	 If there are two or more cycles of a waveform in the measurement scope, time parameters are measured 

for the first cycle.
•	 Logic waveforms, high-speed sampling waveforms (sub waveforms) of dual capture, WT5000 PP 

waveforms, external clock data, timestamp data (DL950 power math data or motor dq analysis data and 
Modbus/TCP (MB1 option) data) cannot be measured automatically.
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Details of the Measurement Result Display
Automatically measured values using waveform parameter are displayed.
The displayed items and measured values vary depending on the content of the measurement and 
waveform.
•	 The item names in the result display are abbreviated.
•	 If the display format is percentage, the values are displayed to two decimal places.
•	 If the display format is floating, five digits are displayed.
•	 If the measurement result is invalid or impossible, “***” is displayed as the measured value. 

Waveforms with small amplitudes may fail to produce correct readings.

The display is updated at the following times.
•	 When the Measure bar is moved or the size is changed
•	 When the settings in the Channel Setting window are changed
•	 When OK is clicked in the waveform parameter setting dialog box
•	 When a display group is changed

Note
When the measurement result panel is not displayed and you execute cursor measurement or automated 
measurement of waveform parameters, the measurement result panel will automatically appear.

Table of Items
Group Item Display Format Unit Prefix Unit
Voltage axis items Peak to Peak Decimal Y VUnit

Amplitude Decimal Y VUnit
Maximum Decimal Y VUnit
Minimum Decimal Y VUnit
High Decimal Y VUnit
Low Decimal Y VUnit
Average Decimal Y VUnit
Middle Decimal Y VUnit
RMS Decimal Y VUnit
Std. Deviation Decimal Y VUnit
+Overshoot % — Fixed to %
-Overshoot % — Fixed to %

Time axis items Rise Decimal Y HUnit
Fall Decimal Y HUnit
Frequency Decimal Y Fixed to Hz
Period Decimal Y HUnit
+Width Decimal Y HUnit
-Width Decimal Y HUnit
Duty % — Fixed to %
Pulse Integer — None
Burst1 Decimal Y HUnit
Burst2 Decimal Y HUnit
Avg. Frequency Decimal Y Fixed to Hz
Avg. Period Decimal Y HUnit

Area items Integ1TY Decimal Y None
Integ2TY Decimal Y None
Integ1XY Decimal Y None
Integ2XY Decimal Y None

For details on each measurement item, see the user’s manual for the instrument.
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Data Obtained through Automatic Measurements with Waveform 
Parameters
You can save the automatically measured values that are shown in the measurement result panel 
to a file.
There are two methods to save automatically measured data.

Exporting the Measured Results to a File
On the File tab, click Export File.
► “Exporting a File” on page 3-41

Saving the Measured Results Using the Export Menu
Right-click on the measurement result panel to display the following menu.

	

Clip Board Export menu

Decimal Point
File

Export menu
Item Description
Clipboard All the contents displayed in measurement result panel are copied to the clipboard.
File A Save to Measure Result dialog box will open. You can save the contents of the 

measurement result panel to a CSV file in the specified destination.
Decimal Point You can select the decimal point and separator (data separation). Select either of the 

following:
Point The decimal point is a period, and the separator is a comma.
Comma The decimal point is a comma, and the separator is a period.
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Procedure

Automated Measurement of History Statistics
You can perform the following operations when a history waveform file is open.

Setting the measurement items
1.	 From the Wave Parameter Settings drop-down list on the Analysis tab, select History 

Statistics.
*	 If History Statistics is already selected, click Measure Setting.

	 The History Statistics Settings dialog box appears.

2.	 Set the measurement items and the display conditions of measurement results, and click 
OK.

	

Turns measurement items on or off

Voltage measurement items

Time measurement items

Area measurement items

Set the measurement 
start time.

Set the measurement 
end time.

Starts automated 
measurement

Names of the items 
to be measured

	� The dialog box closes, and automated measurement starts.
	� When the measurement is completed, a measurement result panel appears. Two vertical 

cursors and a measurement range (Measure) bar are displayed on the history waveform 
chart of the History panel.
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Displaying History Statistic Results
1.	 On the Analysis tab, click Measure to show or hide the Measure Result panel.

Shows or hides the histogram 
of statistical results on the 
measurement result panel

Measurement 
result panel

Measurement start 
point cursor

Measurement end 
point cursor

Measurement 
time period

History Statistics Values

History numbers

Statistic results for each 
history entry

Histogram of Statistic Results

Measurement items 
and channels

Drag the left edge of the Measure bar to 
change the measurement start position 
and computation time.

Drag the right edge of the Measure bar to 
change the measurement time.

Properties on the measurement result

Uses a linear scale to display 
the histogram’s Y axis

Uses a logarithmic scale to 
display the histogram’s Y axis

Maximum and minimum markers
: Displayed next to the maximum 

value of each measurement item
: Displayed next to the minimum 

value of each measurement item

	 If you change the measurement range, the history statistics are automatically 
remeasured.

Histogram of Statistic Results
•	 Using a property on the Measure Result panel, you can show or hide the histogram display.
•	 When the histogram display is on, you can select Linear or Log for displaying the Y axis.

History Statistics Values
For each of the following statistics items, the statistical results of the selected measurement 
item and target channel are displayed.

Max (maximum), Min (minimum), Avg (average), StdDev (standard deviation), Count (cycle 
count)

Displaying Statistic Results for Each History Entry
•	 For each history entry, the measurement results of the selected measurement item and 

target channel are displayed.
•	 When the View1 panel is displayed, clicking a history number causes the corresponding 

history waveform to be displayed in the View1 panel.
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Explanation

Items That Can Be Measured with History Statistics
On history waveforms, you can set and measure voltage parameters, time parameters, and 
area parameters. Parameters that can be measured are the same as those of the automated 
measurement of waveform parameters. ► page 4-41

Displayed Content of History Statistic Result
Automatically measured history statistics are displayed.
The displayed items and measured values vary depending on the content of the measurement and 
waveform.
•	 The item names in the result display are abbreviated.
•	 If the display format is percentage, the values are displayed to two decimal places.
•	 If the display format is floating, five digits are displayed.
•	 If the measurement result is invalid or impossible, “***” is displayed as the measured value. 

Waveforms with small amplitudes may fail to produce correct readings.

The display is updated at the following times.
•	 When the Measure bar is moved or the size is changed
•	 When the settings in the Channel Setting window are changed
•	 When OK is clicked in the History Statistics Settings dialog box
•	 When a display group is changed

Note
•	 When the measurement result panel is not displayed and you execute automated measurement of 

history statistics, the measurement result panel will automatically appear.
•	 If the total number of items that is determined by the number of history waveforms, the number of 

channels, and the number of measurement items exceeds 100000, computation results cannot be 
displayed. If a message appears, change the number of displayed channels and measurement items so 
that 100000 is not exceeded.

Saving History Statistics’ Automated Measurement Data
You can save the contents displayed in the measurement result panel to a file.
The save procedure is the same as for automated measurement of waveform parameters. 
► page 4-43
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Procedure

Automated Measurement of Cycle Statistics
Setting the measurement items
1.	 From the Wave Parameter Settings drop-down list on the Analysis tab, select Cycle 

Statistics.
*	 If Cycle Statistics is already selected, click Measure Setting.

	 The Cycle Statistics Settings dialog box appears.

2.	 Set the names of the traces to be measured, measurement items and the display 
conditions of measurement results, and click OK.

Names of the traces to 
be measured

Traces and measurement 
items to perform cycle 
statistic measurement 

(up to eight items)

Select the cycle trace to use as 
the cycle statistics reference.

Starts automated measurement

Names of the items to be measured

Set the measurement start time.
Set the measurement end time.

Sets the cursor range to 
start and end times

	� The dialog box closes, and automated measurement starts.
	 �When the measurement is completed, a measurement result panel appears. A measurement 

range (Measure) bar appears at the top of the Overview panel and View panel.

Displaying Cycle Statistic Results
1.	 On the Analysis tab, click Measure to show or hide the Measure Result panel.

Displaying Cycle Statistic Values

Displaying Statistic Results 
for Each Cycle

Histogram of Statistic Results

Measurement start 
point cursor

Measurement end 
point cursor

Cycle number/
measurement time

Measurement 
result panel

Measurement 
time period

Drag the left edge of the Measure bar to 
change the measurement start position 
and computation time.

Drag the right edge of the Measure bar to 
change the measurement time.

Maximum and minimum markers
: Displayed next to the maximum 

value of each measurement item
: Displayed next to the minimum 

value of each measurement item

Measurement items and channels
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Display settings

Properties on the measurement result

Shows or hides the histogram 
of statistical results on the 
measurement result panel

Uses a linear scale to display 
the histogram’s Y axis

Uses a logarithmic scale to 
display the histogram’s Y axis

	 If you change the measurement range, the cycle statistics are automatically remeasured.

Histogram of Statistic Results
This is the same as displaying history statistic results. ► page 4-45

Displaying Cycle Statistic Values
This is the same as displaying history statistic results. ► page 4-45

Displaying Statistic Results for Each Cycle
For each cycle, the measurement results of the selected measurement item and target 
channel are displayed.
•	 When the Cycle Trace Is a Trace

	- You can select the content to be displayed in the Cycle No. column using the Display 
Settings property on the Measure Result panel.
Display Settings Content to be displayed in the Cycle No. column
Cycle No. Displays the cycle number.
Relative The start times of cycle divisions are displayed with relative times.
Absolute The start times of cycle divisions are displayed with absolute times.

	- If you click a cycle number/time in the Cycle No. column when the View1 panel is 
displayed causes the target cycle to be displayed in the View1 panel.

•	 When the Cycle Trace Is Own
The cycle statistics results of each trace is displayed according to the minimum number of 
cycles in the target traces.
Example
	� If the numbers of cycles are three for trace 1, two for trace 2, and five for trace 3, the 

results of all traces are displayed for two cycles (which is the least number of cycles).

Explanation

Items That Can Be Measured with Cycle Statistics
On each cycle of the waveforms, you can set and measure voltage, time, and area items. Items that 
can be measured are the same as those of the automated measurement of waveform parameters.
► page 4-41
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Cycle Trace
Select the trace that will be used as the reference cycle for performing cycle statistic measurement. 
If Own has been selected, cycle statistic measurement is performed using each trace’s cycle. The 
measurement result panel will show the measured results over the time period for the least number 
of cycles.

	 CH2

CH1

The number of cycles in the channel with the 
slowest cycle (CH3) is four, so statistical 
processing is performed on the four oldest 
cycles of the data for CH1 and CH2. The 
remaining data is not used for statistical 
processing.

When Cycle Trace Is Set to Own

CH3

Statistically processed cycles

Statistically processed cycles

Statistically processed cycles

Note
If the measurement cycle of the measurement source waveform is different from that of the waveform 
assigned to be the cycle trace, “***” is displayed in the measurement results.

Displayed Content of Cycle Statistic Results
Automatically measured cycle statistics are displayed.
The displayed items and measured values vary depending on the content of the measurement and 
waveform.
•	 The item names in the result display are abbreviated.
•	 If the display format is percentage, the values are displayed to two decimal places.
•	 If the display format is floating, five digits are displayed.
•	 If the measurement result is invalid or impossible, “***” is displayed as the measured value. 

Waveforms with small amplitudes may fail to produce correct readings.

The display is updated at the following times.
•	 When the Measure bar is moved or the size is changed
•	 When the settings in the Channel Setting window are changed
•	 When OK is clicked in the Cycle Statistics Settings dialog box
•	 When a display group is changed

Note
•	 When the measurement result panel is not displayed and you execute automated measurement of cycle 

statistics, the measurement result panel will automatically appear.
•	 If the total number of items that is determined by the number of cycles and the number of measurement 

items exceeds 100000, computation results cannot be displayed. If a message appears, change the 
measurement range and the number of measurement items so that 100000 is not exceeded.
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Saving Cycle Statistics’ Automated Measurement Data
You can save the contents displayed in the measurement result panel to a file.
The save procedure is the same as for automated measurement of waveform parameters. 
► page 4-43
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This section explains the following operations:
•	 Setting expressions
•	 Displaying math waveforms and math ranges
•	 Setting the math start time, math time, and math start history
•	 Setting filters

Procedure

Setting expressions
1.	 On the Analysis tab, click Math Setting to display of a Arithmetic Setting dialog box.
	 Set expressions, filters, FFTs, and other math operations to display math waveforms.
2.	 In the Arithmetic Setting dialog box, select the Math Setting tab.

3.	 Click the Expression column to display of a user-defined expression input dialog box.

		

Expression number Set the label, unit, and expression in the displayed window.

Set constants
(Range:
-1.0000E+30 to 1.0000E+30)

Set the math start time.
Set the math end time.

Sets the cursor values to math start and end times

Filter settings
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4.	 Input an expression using variables and operators.

	

Set the label name (up to 31 characters).

Other math waveform information

Set the expression (up to 63 characters).

Select the operator.

Set the unit (up to 15 characters).

Set numerals and variables.

Trace names corresponding 
to the variables

•	 Trace names corresponding to the variables
Use the Cx (where x is a number) or Mx variables to specify channels in an expression.
Assign Cx and trace names here.

•	 Other math waveform information
Registered expressions are automatically assigned to Mx variables.

5.	 Click Register to close the expression input dialog box. The specified expression is displayed 
in the Expression column of the Arithmetic Setting dialog box.

6.	 Click Register. The specified expression is registered.

Displaying Math Waveforms and Math Range
When an expression is registered, a Math bar is displayed representing the math waveform and 
math range in the Overview panel. Further, Math on the Analysis tab become selectable. Click 
Math to show or hide the math waveform and Math bar.

Setting the Math Start Time and Math End Time
You can set the math range by specifying the math start time and math end time. 
Click Cursor value to set the cursor values to the math start and end times.
You can also change the math range by using the Math bar on the Overview panel.

Note
•	 An error message appears when the math time exceeds the math range (12 Mpoint).
•	 MATLAB Runtime can be used to extend the computation range up to 100 Mpoints.
	 Install MATLAB Runtime version 9.11, and make sure it is located in the following path.

	 C:\Program Files\MATLAB\MATLAB Runtime\v9.11
•	 Logic waveforms, high-speed sampling waveforms (sub waveforms) of dual capture, WT5000 PP 

waveforms, external clock data, timestamp data (DL950 power math data and Modbus/TCP (MB1 option) 
data) cannot be computed.
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Setting Filters
Use the FILT1 and FILT2 settings in the Math Setting dialog box to set filters.
•	 Type: Set the type.
•	 Band: Set the band.
•	 CutOff1, CutOff2: Set the cutoff frequencies.

Explanation

Operator Menu
The operators that you can specify can be accessed from the Function column in the user-defined 
expression input dialog box.
Function Display Allowed Operators
Basic SHIFT, ABS, SQRT, LOG, EXP, RMS, NEG, P2, P3, F1, F2
Trigonometric SIN, COS, TAN, ATAN, PH
Pulse Width PWHH, PWHL, PWLH, PWLL, PWXX, FV, DUTYH, DUTYL
DIF & INTG DIF, DDIF, INTG, IINTG
Filter FILT1, FILT2, HLBT, MEAN, BIN

Limitations on Expressions
When m ≤ n, an expression for Mathm cannot include the variable Mn (operations for Mathn).

Example of an expression that is not allowed: Math5 = M6 + M3

Filter Settings
Type/Band
•	 Gauss (Gauss):	 Low Pass
•	 Sharp (Sharp):	 Low Pass/High Pass/Band Pass
•	 IIR (Butterworth):	Low Pass/High Pass/Band Pass

CutOff1/CutOff2
Set either or both cutoff frequencies as a ratio to the sampling frequency. The allowable range 
is 2.0 % to 30.0 % (0.2 % steps). If you set Band to Bandpass, specify both the CutOff1 and 
CutOff2 orders. The higher the filter order, the longer the computation.
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Math Start Time and Math Time
When you perform a math operation, a Math bar appears on the Overview panel.
•	 When you click the left edge of the Math bar, a horizontal arrow cursor appears. You can drag 

the edge to change the math start time and math time.

	

•	 When you click the right edge of the Math bar, a horizontal arrow cursor appears. In this 
situation, you can only change the math time.

•	 When you drag the middle of the Math bar, the math range is displayed in light blue, and you can 
change the math start time with the math time fixed.

	 Math range

Drag the middle of the Math bar to move the 
math start time. (The math time is fixed.)

Variables and Operators
The following variables and operators can be used in expressions. You can use up to 63 characters 
to define an expression. You can register up to 32 expressions.

Variable
Variable Example Description
Cx C1+C2 Measured value of the channel assigned with a trace name corresponding 

to variable C
My ABS(M1) Computed (Math) value
A BIN(C1,A,B) Upper threshold level
B BIN(C1,A,B) Lower threshold level
N SHIFT(C1,N) Integrated data value over time
T RMS(C1,T) Math time (ms)

x: �Number. Specify the number according to the number of channels that are loaded. For example, if 
three channels, CH1, CH5, and CH8, are loaded, specify the channels as C1, C2, and C3.

y: Number
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Operators
Operator Example Description
+, −, *, / C1+C2 Basic arithmetic on the two specified waveforms
SHIFT SHIFT(C1,N) Phase shift
ABS ABS(M1) Absolute value of the specified waveform
SQRT SQRT(C2) Square root of the specified waveform
LOG LOG(C1) Natural logarithm of the specified waveform
EXP EXP(C1) Euler’s number power (Napier’s constant power) of the specified waveform
RMS RMS(C1,T) Rms value of the specified waveform (for internal clock). The unit is milliseconds.

RMS(C1,N) Rms value of the specified waveform (for external clock).
NEG NEG(C1) Negation
SIN SIN(C1) Sine of the specified waveform
COS COS(C1) Cosine of the specified waveform
TAN TAN(C1) Tangent of the specified waveform
ATAN ATAN(C1) Displays the arc tangent of the specified waveform (a value within ± π)
P2 P2(C1) Square of the specified waveform
P3 P3(C1) Cube of the specified waveform
F1 F1(C1,C2) |C12 + C22|  of the specified waveform
F2 F2(C1,C2) |C12 - C22|  of the specified waveform
K1 to 10 C1+K1 Constant (set a specific value)
BIN BIN(C1,A,B) Binarization of the specified waveform
PWHH PWHH(M1,A,B) Computation of a pulse width between a rising edge and the next rising edge
PWHL PWHL(C2,A,B) Computation of a pulse width between a rising edge and the next falling edge
PWLH PWLH(C1,A,B) Computation of a pulse width between a falling edge and the next rising edge
PWLL PWLL(C1,A,B) Computation of a pulse width between a falling edge and the next falling edge
PWXX PWXX(C2,A,B) Computation of a pulse width from a rising edge to the next rising edge or from a 

falling edge and the next falling edge
FV FV(C1,A,B) Inverse of PWHH
DUTYH DUTYH(C1,A,B) Percentage of the interval from a rising edge to the next falling edge within the 

interval from a rising edge to the next rising edge
DUTYL DUTYL(C1,A,B) Percentage of the interval from a falling edge to the next rising edge within the 

interval from a rising edge to the next rising edge
MEAN MEAN(C1) 10th order moving average of the specified waveform
DIF DIF(C1) Derivative of the specified waveform
DDIF DDIF(C1) Second-order derivative of the specified waveform
INTG INTG(C1) Integral of the specified waveform
IINTG IINTG(C1) Second-order integral of the specified waveform
PH PH(C1,C2) Unwrapping phase between the two specified waveforms
HLBT HLBT(C1) Hilbert function of the specified waveform
FILT1 FILT1(C1) Filtering of the specified waveform
FILT2 FILT2(C1) Filtering of the specified waveform
For details on each operator, see the user’s manual for the instrument.

Display during Math Measurement
A progress bar is displayed while math measurement is in progress.

Note
Canceling Math Operations
While a math operation is in progress, a progress bar and a Cancel button are displayed. Click the Cancel 
button to cancel the math operation.
If you cancel a math operation, nothing will be displayed in the waveform display panel or measurement 
result panel.

Computational Accuracy
Single-precision floating-point type
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Details of Various Computations
Phase Shift (SHIFT)
Shifts the phase of the specified waveform. Set the amount of shift as follows.

SHIFT(C1,N)

N:	Integrated value for the number of data points to the time axis

RMS Value (RMS)
Calculates the RMS value of the waveform that has been assigned.

	 s(n)2

n = 1

N
1
N

s: Sampling data
N: Integrated value for the number of data points to the time axis

In the expression, set the target trace number and time.

Expression: RMS(C1,T)

T: Computation time (ms)
T = (N/sample rate) × 1000

Filter (FILT1/FILT2)
Type
Type Bandwidth
Gauss Low Pass
Sharp Low Pass/High Pass/Band Pass
IIR (Butterworth) Low Pass/High Pass/Band Pass

Filter Orders
See the following table for the filter orders.
Cutoff frequency/sampling frequency × 100 2 % 5 % 10 % 20 % 30 %
Gauss Low Pass 49 21 9 5 5
Sharp Low Pass 88 36 18 9 8

High Pass 159 65 33 17 13
IIR Low Pass 4 4 4 3 2

High Pass 4 4 4 4 3

Note
•	 You can set the cutoff frequency in the range from 2 to 30 % of the sampling frequency (in 0.2 % 

steps).
•	 The higher the filter order, the longer computation takes.

Filter Characteristics
Filter Pass band Ripple Attenuation slope Attenuation in the 

Stop band
Phase

Gauss 0 dB * - Linear
Sharp ±0.3 dB -40 dB at 1 oct (Low Pass), -40 dB Linear

-40 dB at -1 oct (High Pass)
IIR 0 dB -5 dB at 1/6 oct (Low Pass), - Non-linear

-20 dB at -1 oct (High Pass)
*	 Attenuation for a Gauss filter is –3.0 × (f/fc)2 dB (where f is the frequency and fc is the cutoff 

frequency).
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Examples of Frequency Characteristics for Various Filters

Gauss Sharp IIR 
Cutoff: 10 % Low Pass, cutoff: 10 % Low Pass, cutoff: 10 %

f : Sampling Frequency [Hz] 

Hilbert Function (HLBT)
Normally, when we analyze a real time signal, it is convenient to think of the signal as the 
real part of a complex valued signal. Analysis is often more convenient when done using 
the complex signal. Given that the real time signal is considered to be the real part of the 
complex signal, the imaginary part is then equal to the Hilbert transform of the real part. When 
performing a Hilbert transform on a signal in the time domain, the signal is first transformed 
into the frequency domain using the Fourier transform. Next, the phase of each frequency 
component is shifted by -90 degrees if the frequency is positive and +90 degrees if negative. 
Lastly, the Hilbert transform is completed by taking the inverse Fourier transform. As can 
be seen from the above description, the Hilbert transform does not change the order of the 
individual variables. The Hilbert transform of a time signal results in another time signal.

Application Example
The Hilbert transform can be used to analyze an envelope waveform.
AM (amplitude modulation): SQRT(C1*C1+HLBT(C1)*HLBT(C1))
Demodulation of a FM signal: DIF(PH(C1,HLBT(C1)))

Phase Function (PH)
Phase function PH(C1,C2) computes tan-1 (C1/C2). However, the phase function takes the 
phase of the previous point into consideration and continues to sum even when the value 
exceeds ±π (The ATAN function reflects at ±π). The unit is radians.

Previous point

Previous point

θ2 = θ1 + Δθ2 θ2 = θ1 - Δθ2

θ2

θ2

θ1

θ1

Δθ2

Δθ2
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Binary Conversion (BIN)
Performs binary conversion with respect to the specified threshold level.
The threshold level is specified as follows:

Expression: BIN(C1,A,B)

A: Upper threshold level
B: Lower threshold level

	

1

0

A: Upper threshold level
B: Lower threshold level

Waveform to
be computed

Computed
waveform

Pulse Width Computation (PWHH/PWHL/PWLH/PWLL/PWXX)
The signal is converted into binary values by comparing to a preset threshold level, and the 
time of the pulse width is plotted as the Y-axis value for that interval.
The following 4 intervals are available:

PWHH: From the rising edge to the next rising edge.
PWHL: From the rising edge to the next falling edge.
PWLH: From the falling edge to the next rising edge.
PWLL: From the falling edge to the next falling edge.
PWXX: �From a rising edge to the next rising edge or from a falling edge and the next falling 

edge.

The threshold level is specified as follows:

Expression: PWHH(C1,A,B)

A: Upper threshold level
B: Lower threshold level

	

Waveform to
be computed

A: Upper threshold level

t1 t2 t3

Computed
waveform

B: Lower threshold level

t1
t2 t3
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4.9	 Analyzing and Searching CAN Bus Signals 
(SB1 option)

This section explains the following operations:
• Analyzing CAN Bus Signals • List Display
• Decoded View • Displaying the Analysis/Search Results (zoom view)
• Search Settings (search type and search execution) • Saving the Results of CAN Bus Signal Analysi (zoom 

view)• Setting the Source Waveforms and Analysis Range

Procedure

Analyzing CAN Bus Signals
1.	 When you open a waveform data file (see section 4.1), overview waveforms and vertical 

cursor measurement results are displayed.
Cursor measurement ► section 4.4

2.	 On the Analysis tab, click Serial bus Analysis to show or hide the serial bus panel.
	 When you show the serial bus panel:

•	 A serial bus bar appears indicating the analysis range at the top of the overview panel.
•	 If you load waveform data and then show the serial bus panel for the first time, the decoded results 

are also displayed below the overview waveforms.

		

Serial bus bar

Serial bus 
panel

Serial bus  
properties

Vertical 
cursor panel

Overview panel

Decoded display

List display

Search

Decode

Analyze

Display

Cursor 1 
(Measurement start point)

Cursor 2 
(Measurement end point)

Trigger position (    )

Analysis range
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Setting the Source Waveforms and Analysis Range
3.	 On the Analysis tab, click Serial bus Setting to display a serial bus settings dialog box.
	� Set the analysis/search source waveforms and the analysis range.

		

Serial bus type
Select the source 
waveforms.

Set the analysis range.

Uses the measurement start and end 
points of the vertical cursors

Selecting the Source Waveforms
From the loaded waveforms, waveforms that can be used for CAN bus signal analysis are 
displayed in the drop-down list.

Setting the Analysis Range
The analysis range setting is reflected in the serial bus bar.

You can also drag the serial bus bar to change the analysis range.
•	 When you click the left edge of the serial bus bar, a horizontal arrow cursor appears. You can drag the 

edge to change the analysis start time and analysis time.

		

•	 When you click the right edge of the serial bus bar, a horizontal arrow cursor appears. In this situation, 
you can only change the analysis time.

•	 When you drag the middle of the serial bus bar, the analysis range is displayed in light blue, and you can 
change the analysis start time with the analysis time fixed.

		

Analysis range

Drag the middle of the serial bus bar to move the 
analysis start time. (The analysis time is fixed.)

Decoded View
4.	 On the Analysis tab, click Decode view to show or hide the decoded results.

Details of the decode view ► section page 4-62



4-61IM IS8000-01EN

4.9  Analyzing and Searching CAN Bus Signals (SB1 option)

5.	 Select the serial bus panel. Under Decode of serial bus properties, set the parameters needed 
for analysis.

		

Label
Decode format
Analysis/search source waveform
Level for detecting analysis/search source waveform states
Hysteresis
Bit rate

Recessive level

Sample point

Parameter Description
Type The type of serial bus signal is displayed.
Label You can assign labels using up to 8 characters to be displayed.
Format You can select from the following decode formats.

•	 Hex: Always displayed in hexadecimal format.
•	 Hex (Auto Bin): Usually displayed in hexadecimal format. When zoom display is in 

use, the format automatically switches to binary when the zoom range is adjusted 
with the zoom frame. ►see page 4-70

Trace Select the analysis/search source waveform.
Level (V) Enter the level used to detect the analysis/search source waveform.

Selectable range: 8 divisions within the window
Resolution: 0.01 divisions (for example: 0.02 mV when the time scale is set to 2 mV/
division)

Hysteresis (div) You can apply a hysteresis to the detection level so that level changes within the 
range will not be detected as edges.
Range: 0.3 div to 8.0 div
Resolution: 0.1 div

Bit rate (bps) Set the CAN bus signal transfer rate.
•	 You can select the following values from the drop-down list.

33.3 k, 83.3 k, 125 k, 250 k, 500 k, 1 M
•	 You can also manually enter the value in the range of 10.0 kbps  to 1000.0 kbps 

(1 Mbps).
Resolution: 0.1 kbps

Recessive Select the recessive level from one of the settings below. In either setting, the logical 
value of the recessive level is 1, and the logical value of the dominant level is 0.
•	 High: The recessive level is greater than the dominant level.
•	 Low: The recessive level is less than the dominant level.

Sample point (%) You can set the point that will be used to determine the bus level (recessive or 
dominant) in the range of 18.8 to 90.6%.
Resolution: 0.1 %

1 bit

1 bit
62.5[%]

18.8[%] 90.6[%]
Sample point

If the sample point is set to 62.5%

Input waveform
Waveform sampled
using the internal
clock

	 Changes you make are reflected in the serial bus panel’s list display and the decoded view on 
the overview panel.
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Decoded Display
The instrument decodes each field value and displays the decoded result using different colors for 
each field at the bottom of the screen.
Decoded display format: Hex, Bin

Display Example

Overview panel

View 1 panel

Decoded view

The colors that are used for the fields in the decoded display are as follows:
Field Display Color
Arbitration Light green (Light Green)
Control Pink (Pink)
Data Cyan (Cyan)
CRC Light blue (Light Blue)
Error bit, field in which the error occurred, frame, error frame Red (Red)
Overload frame Green (Green)
Frame background Gray (Gray)
Stuff bits Gray (Gray) fill



4-63IM IS8000-01EN

4.9  Analyzing and Searching CAN Bus Signals (SB1 option)

List Display

Analysis number (0 up to 99999)

Serial bus panel

Shows a list of decoded results. The list displays the following items from the left.
Parameter Description
Analysis number From the analysis start position of the overview waveform, numbers are assigned as 0, 1, ..., 

(number of analysis - 1). Analysis results can be displayed for up to 100000 frames in the 
range of 0 to 99999.

Time(ms) The time is displayed in ms relative to the trigger point or relative to the time difference 
between frames.
Setting the time display method ►see page 4-69

Frame Displays the frame type. The following four frame types can be analyzed: data frame (Data), 
remote frame (Remote), error frame (Error), and overload frame (Over load).

ID •	 Frame format: Standard, frame type: Data/Remote
11 bits of the ID value in 3 hexadecimal digits

•	 Frame format: Extend, frame type: Data/Remote
29 bits of the ID value in 8 hexadecimal digits

DLC Displays the data length of the data field. Displays the number of significant bytes in 
decimal notation.

Data Displays the data in hexadecimal notation when the frame type is data frame.
CRC Displays the sequence in hexadecimal notation. This is displayed when the frame type is 

data frame or remote frame.
ACK Displays “ACK” when an ACK bit is detected and “NON ACK” otherwise.
Information Displays the following error information. If multiple errors are detected in one piece of data, 

the instrument displays a single error in the following order of precedence. 
Stuff Error, CRC Error
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Search Settings
6.	 On the Analysis tab, click Search to display a CAN search settings dialog box.

	 You can also display the same dialog box with the Search button under serial bus properties.

		

Select the search type.

Executes searching

7.	 Select the search type.

Search Type Description
SOF Searches for the start-of-frame position
ID/Data Searches for the position where the search conditions specified by ID bit pattern are 

met. (Search by data pattern is not available in this version. This is planned to be 
supported in the future.)

Error Searches for error frames (when the error flag is active) or various errors.

8.	 If you select ID/Data or Error, set the search conditions.

ID/Data search conditions
The instrument searches on the AND of the SOF, ID, frame type (Remote or Data), Data, and 
ACK Mode conditions.
Items whose check boxes are selected are used as search conditions.

1.	 Select Standard or Extend frame format.
	 ► “Frame Format and Detected Point” on page 4-72

When the Comparison Condition Is True or False
(Example when the frame format is Standard)

Data pattern

Select the search source frame.

ACK slot state

Data length of the data field
Comparison condition

Hex

Set the ID bit pattern.

Bin

Select the frame format.

SOF (always selected)

Set the search type to ID/Data.
Set the ID input format to Pattern.
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When the data frame condition is Data = a; Data ≠ a; a ≤ Data; Data ≤ b; a ≤ Data ≤ b; or 
Data < a, b < Data
(Example when the frame format is Extend)

Whether to use a signed (Sign) or
unsigned (Unsign) data formatACK slot state

Byte order

Reference Values (a and b)

Bit positions of the most significant
bit (MSB) and the least significant bit
(LSB) in the data to be compared

Hex

Bin

Select the search source frame.

Set the ID bit pattern.

Select the frame format.
SOF (always selected)

Set the search type to ID/Data.
Set the ID input format to Pattern.

Data length of the data field
Comparison condition

SOF
Searches for the start-of-frame position of the CAN bus signal when the search condition 
is SOF only. SOF of ID/Data is always selected as a search condition.

ID
If you select ID, enter the ID bit pattern.

Hex/Bin (Bit Pattern)
•	 Set the 11-bit standard format ID bit pattern or the 29-bit extended format ID bit pattern 

in hexadecimal (Hex) or binary (Bin) notation. The ID search condition is met when the 
input signal ID bit pattern matches the specified bit pattern.

•	 HWhen you click the Hex or Bin input box, a soft keyboard (see the figure above) 
appears. Use the 

►

 and ► keys to move the cursor and enter the value.

Note
•	 If you specify X in the ID bit pattern, the condition is assumed to be met regardless of the 

corresponding bit status.
•	 In a bit pattern setting, if a binary pattern contains any Xs, the corresponding hexadecimal 

display will be “$.”
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Frame
If you select Frame, select the frame to search from Remote or Data.
Frame Type Description
Remote A search is performed on the Remote Frame.
Data A search is performed on the Data Frame. You can set a search condition based 

on the data field value.
DLC, Condition, and data pattern can be set only when Data is selected.

DLC (Data Length Code)
Set the data length of the data field. The DLC search condition is met when the specified 
value matches the input signal DLC value.
Selectable range: 0 to 8 bytes

Comparison Condition (Condition)
The data search condition is met when the result of comparing the data pattern or 
reference value to the input signal’s data field meets the specified comparison condition.
True When the value matches the data pattern
False When the value does not match the data pattern
Data=a1 When the value is equal to the reference value
Data≠a1 When the value is not equal to the reference value
a≤Data1 When the value is greater than or equal to the reference value
Data≤b1 When the value is less than or equal to the reference value
a≤Data≤b2 When the value is within the reference range (including the reference values)
Data<a, b<Data2 When the value is outside the reference range (excluding the reference values)

1	 Set one reference value
2	 Set two reference values

•	 When the Comparison Condition Is True or False

Data Pattern (Hex/Bin)
If the comparison condition is set to True or False, set the data pattern for the data 
whose length was set with DLC in hexadecimal (Hex) or binary (Bin) notation.

•	 When the data frame condition is Data = a; Data ≠ a; a ≤ Data; Data ≤ b; a ≤ Data ≤ b; 
or Data < a, b < Data

Reference Values (a and b)
If the comparison condition is set to Data = A, Data ≠ a, a ≤ Data, Data ≤ b, a ≤ Data ≤ b, 
or “Data < a or b < Data,” set the reference values in decimal notation. You must set the 
byte order (Endian), sign (Sign), and comparison range (MSB or LSB). The selectable 
ranges are as follows:
Unsigned (Unsign) 0 to 1.84467440737096e+019

This is the range when 18446744073709551615 ((2^64)-1) is rounded to 
15-digit exponential notation.
The selectable maximum value is limited by the data length and bit position, 
which are determined by the DLC and MSB/LSB settings, respectively.

Signed (Sign) -9.22337203685478E+18  to  9.22337203685478E+18
This is –9223372036854775808 to 9223372036854775807 rounded to 
exponential representation.
The selectable minimum and maximum values are limited by the data 
length and bit position, which are determined by the DLC and MSB/LSB 
settings, respectively.
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Values are displayed as integers up to 15 digits, and exponents for 16 or more digits.
Display example:
1.84467440737096e+019 (when 18446744073709551615 is entered)

Byte Order (Endian)
Set the byte order of the data stream to Big Endian (Big) or Little Endian (Little). The 
following figure illustrates a 4-byte data stream on the bus. The data field value is 
12345678 in hexadecimal notation.

		

Big endian

12 34 56 78

0 0 0 1 0 0 1 0 0 0 1 1 0 1 0 0 0 1 0 1 0 1 1 0 0 1 1 1 1 0 0 0

Bit
0

Bit
31

Bit
0

Bit
31

Data 3Data 2Data 1Data 0

Data Field

Little endian

78 56 34 12

0 1 1 1 1 0 0 0 0 1 0 1 0 1 1 0 0 0 1 1 0 1 0 0 0 0 0 1 0 0 1 0

Data 0Data 1Data 2Data 3

Data Field

Sign (Sign)
Set whether to use a signed (Sign) or unsigned (Unsign) data format.
The selectable range of data reference values varies depending on whether the data is 
signed or unsigned.

Comparison Range (MSB/LSB)
Set the MSB (MSB) or LSB (LSB) bit positions for the data that you will compare. For 
example, if you want to compare bits 5 through 20 of a 4-byte data value (12345678: 
hexadecimal), set the MSB to 20 and the LSB to 5. In this case, the bits that are 
compared are those that are shaded in the following figure.
Selectable range: 0 to (the number of bytes of data No 8 − 1). The maximum value is 63.

		

Big endian

0 0 0 1 0 0 1 0 0 0 1 1 0 1 0 0 0 1 0 1 0 1 1 0 0 1 1 1 1 0 0 0

Bit
31

Bit
0

Data 3Data 2Data 1Data 0
Little endian

0 1 1 1 1 0 0 0 0 1 0 1 0 1 1 0 0 0 1 1 0 1 0 0 0 0 0 1 0 0 1 0

Bit
31

Bit
0

Data 0Data 1Data 2Data 3

ACK
You can set a search condition based on the ACK slot state. The ACK search condition is 
met when the specified state matches the input signal ACK slot state.
NON ACK When the status is recessive
ACK When the status is dominant
NON ACK or ACK When the status is recessive or dominant
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Error search conditions
1.	 Select the Error type.

		  Select the error types to 
search for.

Error Type Description
Error frame Searches for active error flags (six consecutive dominant bits)
Stuff Searches for instances where stuff bits are not inserted correctly
CRC Searches for CRC errors

9.	 In the search settings dialog box, click Search to execute a search.

		

Detected points (    )
Detected points are displayed above the overview waveform.

• List display

• Overview

	 If the search conditions are matched, the background color of the analysis number is highlighted in 
yellow.
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Displaying the Analysis/Search Results
Select the serial bus panel, and use Search, Analysis, and Display settings under serial bus 
properties to change or control the analysis/search results.

Clears the search results
Shows only the search results

Moves the zoom position to the next detected point
Moves the zoom position to the previous detected point

Opens a CAN search settings dialog box

Turns zoom view linking on or off
Select a view panel (view1 to 4) to zoom 
in on the detected point.

Select the time display format.

Search
•	 Click Search to display a CAN search settings dialog box.

► page 4-64
•	 Clicking Clear search results will clear the detected points ( ) shown at the top of the overview 

waveform and the search results in the list display.
•	 You can use the Display only search result check box to set what to show in the list display.

Check Box Description
ON Only the analysis results that match the search conditions are listed.
OFF All analysis results are listed.

Analysis
•	 Use the View link check box to set whether to link the detected point selection and zoom display.

Check Box Description
ON When you select a detected point, it is enlarged in the specified view panel.

Result window: Select the panel to show the enlarged view from View1 to 4.
OFF The view panel display is not linked even when you select a detected point.

Display
•	 Time reference

You can select how to display the time in the analysis result list.
Parameter Description
Trigger position Displayed in time relative to the trigger point.
Previous row Displayed in time relative to the previous row.
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Linking the Search Result (Detected Point) Selection and Zoom Display
1.	 Select the View link check box, and select the view panel you want to link (View1 to 4).

2.	 Select the analysis result (detected point) you want to zoom in on. You can use either of 
the following methods.
•	 Click on the list in the serial bus panel.
•	 Under serial bus properties, click Search > Jump to search result Previous or Next.

	 If the view panel is hidden, the view panel selected in step 1 is automatically shown.
	 The area enclosed by the zoom frame (view1 to 4) of the overview waveform is displayed 

zoomed in the view panel.
*	 The area of the zoom frame centered on the search point is enlarged. You can also drag the 

zoom frame to change the area displayed in the view panel.
	 Moving the zoom position ► see page 4-13
	 Changing the zoom area ► see page 4-15
	 Moving the waveform, zoom display ► see page 4-29

Display Example

Overview panel

Selected detected point (    )
Select the search result.

Select the detected points with buttons.

View 1 panel

View 1 panel

Zoom frame (view1)

Select View1.Select the View link check box.

Zoom view

Serial bus 
panel

Serial bus 
properties

When the display area of each field is narrow, the data is displayed in hexadecimal format. 
When the zoom frame is adjusted and the zoom range is increased, the format switches to 
binary.

Select the decode display format.

•  When the decode display format is Hex (Auto Bin)

•  When the decode display format is Hex
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Saving the Results of CAN Bus Signal Analysi
Analysis results (list data of decoded results) shown in the serial bus panel can be saved in CSV 
format.
There are two ways to save analysis results.

Exporting Analysis Results to a File
On the File tab, click Export to File.
► “Exporting a File” on page 3-41

Saving the Analysis Results Using the Export Menu
Right-click on the serial bus panel to display the following menu.

	

File

Export menu

Export menu
Item Description
File (File) A Save Serial bus analysis result As screen appears. You can save the analysis results to 

a CSV file in the specified destination.
Save file format: You can select CSV with or without a BOM.

Explanation

Number of Analyzable and Searchable Frames or Data Bytes
The following frames can be analyzed for up to 100000 frames.

Remote, data, error, and overload frames

Analysis/search source waveform
•	 From the loaded waveforms, waveforms that can be used for CAN bus signal analysis are 

displayed in the drop-down list.
•	 The following waveforms cannot be analyzed.

Logic waveforms, Math, high-speed sampling waveforms (sub waveforms) of dual capture, 
external clock data, timestamp data (DL950 power math data or motor dq analysis data, and 
Modbus/TCP (MB1 option) data)
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Frame Format and Detected Point
The following figures illustrate the formats and detected points of the various frames.

Data Frame (Data Frame)
•	 Standard format

	

1 11 1 1 1 4 158N (0≤N≤8) 1 1 1

ID 10-0

Arbitration Field Control Field Data Field CRC Field ACK
CAN Data Frame

DLC
3-0

CRC
SequenceData

7

EOF

(1) (2) (3) (4) (6)(5)

Recessive

Dominant

SO
F

R
TR

ID
E

r0

ACK Delim
iter

AC
K slot

CRC Delim
iter

•	 Extended format

	

1 11 1 1 1 4 8N (0≤N≤8) 15 1 1 1 71 1 18

ID 28-18

ACK
CAN Data Frame

ID 17-0 DLC
3-0

CRC
Sequence

EOFData

(1) (2) (3) (4) (6)(5)

Arbitration Field Control Field Data Field CRC Field

SO
F

SR
R

ID
E

ACK Delim
iter

AC
K Slot

CRC Delim
iter

R
TR

r0r1
Positions (1) to (6) above are detected points for the following conditions.
(1) SOF (4) Data Frame (when DLC ≠ 0)
(2) ID (5) CRC Error
(3) Data Frame (when DLC = 0) (6) ACK

Remote Frame (Remote Frame)
•	 Standard format

	

1 11 1 1 1 4 15 1 1 1

ID 10-0

Arbitration Field Control Field CRC Field ACK
Remote Frame

DLC
3-0

CRC
Sequence

7

EOF

(1)′ (2)′ (3)′ (5)′(4)′

Recessive

Dominant

S
O

F

R
TR

ID
E

r0

ACK Delim
iter

A
C

K
 S

lot
CRC Delim

iter

•	 Extended format

	

1 11 1 1 1 4 15 1 1 1 71 1 18

ID 28-18

ACK
Remote Frame

ID 17-0 DLC
3-0

CRC
Sequence

EOF

(1)′ (2)′ (3)′ (5)′(4)′

Arbitration Field Control Field CRC Field

S
O

F

S
R

R
ID

E

R
TR

r0r1

ACK Delim
iter

A
C

K
 S

lot
CRC Delim

iter

Positions (1)’ to (5)’ above are detected points for the following conditions.
(1)’ SOF (4)’ CRC Error
(2)’ ID (5)’ ACK
(3)’ Remote Frame (when DLC = 0) 
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Error Frame (Error Frame)

	

Error Frame

Data Frame 
or 

Remote Frame
Error Flag Error Delimiter

86 ≤ Error Flag ≤ 12

Recessive

Dominant

If the mode is set to Error Frame, the 
detected point is the 6th error flag bit.

Stuff Error (Stuff Error)
The detected point is the sample point of the bit that violates the bit stuffing rule.

CRC Error (CRC Error)
CRC errors are indicated in the data-frame and remote-frame figures.

Note
If multiple field types and frame types are combined, the detected point is the point where the last 
type appears on the time axis.

High speed CAN (ISO11898) and Low speed CAN (ISO11519-2)
The primary standards for the CAN physical layer are High-speed CAN (ISO11898) and Low-speed 
CAN (ISO11519-2).
As shown in the following figure, the bus level is determined by the potential difference between 
two buses, CAN_High and CAN_Low, in either standard.

0
1
2
3
4
5

B
us

 le
ve

l [
V]

CAN_High

CAN_Low

Node n
(Max:30)Node 1

High speed CAN (ISO11898)

Recessive RecessiveDominant

CAN bus physical signal
CAN_High

CAN_Low

120Ω 120 Ω

Transfer rate: 1 Mbps or less

0
1
2
3
4
5

B
us

 le
ve

l [
V]

2.2 kΩ

2.2 kΩ

CAN_High

CAN_Low

Node n
(Max:20)Node 1

Low speed CAN (ISO11519-2)

Recessive RecessiveDominant

CAN bus physical signal
CAN_Low

CAN_High

Transfer rate: 125 kbps or less
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This section explains the following operations:
•	 Selecting the annotation type
•	 Inserting annotations

Procedure

Selecting the Annotation Type
Follow the procedure below to enter annotation mode.

1.	 On the Analysis tab, in the Annotation group, click an annotation type command.

	 The five available annotation types are text, ΔT, ΔV, marker, and Δ marker. Depending on the 
annotation that you select, the pointer displayed in the waveform view will vary.

	 For details, see the explanations on the following pages.

2.	 Depending on the annotation that you selected, perform the appropriate operations to insert 
the annotation.

	 For details, see the explanations on the following pages.

		

Inserted annotation

 Annotation input box

Set the annotation font and 
color in the dialog box that is 
displayed.
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Inserting Annotations
3.	 When an annotation command is selected, right-click the panel displaying the waveforms or a 

waveform to display a shortcut menu.

Creating a New Annotation
Select Annotation and then New. Select an annotation type to insert the annotation in the 
view.

Set the annotation type to text, ΔT, ΔV, or marker.

The Δ marker can be selected from the ribbon commands.
It cannot be selected from the pop-up menu.

Editing or Deleting an Annotation
1.	 Click the annotation you want to edit to select it. The selected annotation appears red.

2.	 Right-click to display the same shortcut menu as shown in the figure above.

Editing an Annotation
3.	 Select Annotation and then Edit. The corresponding annotation dialog box appears.

4.	 Make the edit, and click OK.

Deleting an Annotation
3.	 Select Annotation and then Delete. The annotation is deleted.

Note
•	 When you select an annotation command is selected and right-click the panel displaying the waveforms, 

an annotation format setting dialog box appears.
•	 When you double-click an already inserted annotation, a format setting dialog box is displayed for that 

annotation.
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Explanation

Annotation Types
The five available annotation types are text, ΔT, ΔV, marker, and Δ marker.

Linked Annotations
•	 ΔT, ΔV, marker, and Δ marker are annotations that are linked to waveforms.
•	 When a text annotation is linked to a waveform, the text is connected to the waveform with 

a link line.
•	 You can insert a linked annotation for each waveform. Even if you change the displayed 

group, these annotations remain linked to their corresponding waveforms.

Unlinked Annotations
Text annotations that are not connected by link lines are unlinked annotations. Their positions 
change depending on the window size.

	
Linked annotation

Unlinked annotation

Link line

Text annotation 
example

Display Panels That Annotations Can Be Inserted Into
Y: Insertable, N: Uninsertable

Annotation Types Display Panel
Overview View XY

Text, ΔT, ΔV Y Y Y
Marker, Δ marker Y Y N

*	 Only text annotations can be inserted for logic waveforms.
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Text Annotation  Pointer icon: 

If you select text annotation and double-click in the waveform view or a waveform, the following 
setting dialog box appears. You can set the display format of the annotation, such as the font type 
and color.

	

You can set any color.

You can select the 
colors assigned to 
the displayed 
waveform group.

Annotation input box

Select this check box to show a 
frame around annotations.

You can set the font type and size.

A pop-up menu appears for setting the color.

Display Example

Annotation with a frame

Moving an annotation

Select the annotation. When it turns red, drag it.

Link line

Note
Inserting a Text Annotation Linked to a Waveform
If you double-click a waveform to set an annotation, you can insert an annotation linked to the waveform.
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ΔT Annotation  Pointer icon: 

When you select ΔT annotation and perform either of the procedures below in the waveform view, 
the X value is displayed.

Drag horizontally

	

Double-click
The following setting dialog box appears. You can set the trace (waveform) that the annotation is 
linked to, the display format, the arrow style, and other items.
The measurement range of the new X value displayed when you double-click is 2 divisions.

	
Select the display format (floating point).
► section 3.5.

Select the number of decimal places (1 to 5).

Displays a ΔT annotation between vertical cursors

Select the trace (waveform) to which to 
link the annotation.

Select the arrow weight.

Hides values

Select the weight of the auxiliary lines that 
pass through the arrow tips.

Preview of the displayed value (cannot be entered)

Set the font type, color, and frame.
(See the text annotations section.)

Shows additional lines

Display Example

ΔT annotation with auxiliary lines ΔT annotation between vertical cursors
Auxiliary lines Vertical cursor

Moving a ΔT annotation Moving arrows
Select an arrow and drag. To 
only move the value, you can 
move it in the same manner as 
with a text annotation.

Select an arrow tip and drag. 
The value is updated according 
to the length of the arrow line.

Changing the text size
Same procedure as for text annotations.
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ΔV Annotation  Pointer icon: 

When you select ΔV annotation and perform either of the procedures below in the waveform view, 
the Y value is displayed.

Drag vertically

	

Double-click
The following setting dialog box appears. You can set the trace (waveform) that the annotation is 
linked to, the display format, the arrow style, and other items.
The measurement range of the new Y value displayed when you double-click is 2 divisions.

	

Select the number of decimal places (0 to 9).
Select the display format (floating point, 
exponential).
► section 3.5.

Displays a ΔV annotation between horizontal cursors

Select the trace (waveform) to which to link 
the annotation.

Select the arrow weight.

Hides values

Select the weight of the auxiliary lines 
that pass through the arrow tips.

Preview of the displayed value (cannot be entered)

Set the font type, color, and frame.
(See the text annotations section.)

Shows additional lines

Display Example

ΔV annotation with auxiliary lines ΔV annotation between horizontal cursors
Auxiliary lines Horizontal cursor

Moving a ΔV annotation Moving arrows
Select an arrow and drag. To 
only move the value, you can 
move it in the same manner as 
with a text annotation.

Select an arrow tip and drag. 
The value is updated according 
to the length of the arrow line.
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When the waveform is zoomed vertically
The length of the arrow and the value are updated according to the 
zoom factor.

Changing the text size
Same procedure as for text annotations.

Marker Annotation  Pointer icon: 

A marker annotation displays the trace, X value, and Y value at the double-clicked point.
If you select Marker annotation and double-click a waveform, the following setting dialog box appears.
•	 You can set the trace (waveform) that the annotation is linked to, the format, the marker shape, 

and other items.
•	 There are four marker shapes ( , , , ). Each time a marker annotation is inserted, a shape 

different from the previous one is used.

	

Select the trace (waveform) to link 
the annotation to.

Preview the annotation to be displayed
(You cannot edit this.)

Select the items to display.
Select the marker shape and size.

Set the font type and frame.
(See the text annotations section.)

Select the X (horizontal) scale display format* 
and the number of decimal places (1 to 5).
(* floating point ► section 3.5.)

Select the Y (vertical) scale display format* 
and the number of decimal places (0 to 9).
(* floating point, exponential ► section 3.5.)

Display Example

Trace X value
Y value

Marker

Moving a marker Moving an annotation
Select a marker and drag. Only 
the marker moves.
The value is updated according 
to where the marker moves to.

Link line

Select the annotation and then 
drag. Only the annotation moves.
If the linked point flows outside 
of the waveform view when 
zooming or changing the scale, 
the link line disappears.

Changing the text size
Same procedure as for text annotations.
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Δ Marker Annotation  Pointer icon: 

A Δ marker annotation displays the ΔT (X value) and ΔV (Y value) between two markers.
•	 If you select Δ marker annotation and drag between two points on a waveform, the ΔT and ΔV 

annotations between the two markers are displayed.
•	 Between two traces (waveforms), only the ΔT marker is displayed.

	

Click on the waveform. Drag Drop on the waveform.
Marker 1

Marker 2

ΔT

Arrows
ΔV

Double-clicking an annotation displays the following setting dialog box.
•	 For the marker, you can set the source trace (waveform), marker shape, and so on.
•	 There are four marker shapes ( , , , ). Each time a marker annotation is inserted, a shape 

different from the previous one is used.
•	 For ΔT and ΔV markers, you can set the display format, arrow style, and so on. Click the ΔT and 

ΔV tabs to switch between the two.

	

Configure the settings of ΔT and ΔV annotations 
that are used in Δ marker annotations.
See the descriptions of the annotations on the 
previous page.
• If you clear a Show Arrow check box, the arrow and 
value of that annotation will not be displayed.

• There are no Link cursor and Hide value options, 
which are available for ΔT and ΔV annotations on 
the previous page.

Select the marker source trace (waveform).

Select the marker shape and size.
The shape and size of the marker 1 and 
marker 2 pair are the same.
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Display Example
Δ Marker annotation with auxiliary lines Moving a marker

Auxiliary lines

Marker 1

Marker 2

Select a marker and drag. The 
length of the arrow line, values, 
and auxiliary lines are updated 
according to where the marker is 
moved to.

Moving a ΔT annotation Moving a ΔV annotation
Select the arrow of the ΔT 
annotation and �drag. To only 
move the value, you can move 
it in the same manner as with a 
text annotation.

Select the arrow of the ΔV 
annotation and drag. To only 
move the value, you can move 
it in the same manner as with a 
text annotation.

Changing the text size
Same procedure as for text annotations.
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This section explains the following operations:
• Configuring Channels
• Setting Expressions
• Displaying FFT Waveforms and Math Range
• Setting the FFT Start Time and the Number of FFT Points
• Displaying Zoom Waveforms
• Displaying History Waveforms
• Measuring with Vertical Cursors
• Measuring with Horizontal Cursors
• Saving the Analysis Results of FFT Waveforms
• Configuring the FFT Waveform Display

Procedure

Configuring Channels
1.	 On the FFT View tab, click Channel Setting. A Channel Setting window opens.

		

Moves the selected line up

Moves the selected line down

Applies the settings and closes the window

Cancels the settings and closes the window

Applies the settings

Add channels. Select filter conditions.

Deletes the selected line

Aligns the selected range of settings 
to the contents of the first row

Resets the selected range of 
settings to default

Inverts the selected range of settings

Automatically sets the 
selected range of settings
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Adding Channels (Add Channel)
2.	 Click Add Channel to open the following dialog box. Channels that can be added (FFT 

numbers) are displayed.

		

Adds the selected channels

Selecting Filter Conditions
► section 3.5

List of Measurement Conditions of Each Channel
For each channel number, set the numeric display format and the number of displayed digits 
of the FFT waveforms as well as the display conditions and the unit of logic waveforms.
•	 You can use the check boxes in the title line to collectively turn on or off the display 

conditions of the corresponding columns.
•	 You can set multiple items collectively. Select a range, and then click Auto, Invert, Copy, 

or Default below the list. ► page 3-19

The items in the table are explained in order from left-most column.

Channel number
► page 3-15

Trace
► page 3-15

Model
► page 3-15

Group1 (Group1)
•	 Adding and Deleting Groups
•	 Display (Display)

► page 3-16
•	 Mapping (Mapping)

► page 3-16
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Waveform Color (Color)
► page 3-16

Log
Select this check box to use the Log scale.

*	 FFTs that involve LOG calculations (e.g., PS-LOGMAG(C1)) will not be displayed properly.

Minimum (Min) and Maximum (Max)
► page 3-16

Display Format (Format Type)
► page 3-17

Significant digits (Significant digits)
► page 3-17

Display Conditions of Logic Waveforms (Logic)
► page 3-18

Vertical Scale Unit (Unit)
► page 3-19

Selecting Display Groups
3.	 On the FFT View tab, click Group Selection. You can select the groups (1 to 4) to show 

in the FFT View panel from a drop-down list.
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Procedure

Setting Expressions
1.	 On the FFT View tab, click FFT Setting to display of a Arithmetic Setting dialog box.
	 Set expressions, FFTs, and other math operations to display FFT waveforms.
2.	 In the Arithmetic Setting dialog box, select the FFT Setting tab.

3.	 Click the Expression column in the Arithmetic Setting dialog box to display of a user-defined 
expression input dialog box.

		

Expression number Set the label, unit, and expression in the displayed window.

Select the number of FFT points.
Select the window function.
Set the FFT start time.
Sets the cursor (1) value to FFT start time

FFT Points
 Select the number of FFT points from the following:

1K, 2K, 5K, 10K, 20K, 50K, 100K, 200K, 500K, 1M, 2M, 5M,* 10M,* 20M,* 50M,* 100M*
*	 5M, 10M, 20M, 50M, and 100M become available when MATLAB Runtime is installed.

Note
To analyze data points exceeding 2 Mpoints using FFT, you need to install MATLAB Runtime version 
9.11, and make sure it is located in the following path.
	 C:\Program Files\MATLAB\MATLAB Runtime\v9.11

Windows
► page 4-93

FFT Start (s)
You can specify the FFT start time. You can also change the FFT start time by using the FFT 
bar on the Overview panel.
For history waveforms, enter the elapsed time from the start point of the history waveform as 
the FFT start time.
The elapsed time from the start point can be determined with the vertical cursor.
► page 4-95
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Label, Unit, and Expression 
4.	 Create an expression using variables and operators.

		

Set the expression (up to 63 characters).

Other math waveform information

Set the label name (up to 31 characters).

Select the operator.

Set the unit (up to 15 characters).

Trace names corresponding 
to the variables

5.	 Click Register to close the expression input dialog box. The specified expression is 
displayed in the Expression column of the Arithmetic Setting dialog box.

6.	 Click Register. The specified expression is registered.

	 FFT waveforms are displayed on the FFT View panel.
	 In addition, FFT becomes available (active) on the FFT View tab.

Explanation

Operator Menu
The operators that you can specify can be accessed from the Function column in the user-defined 
expression input dialog box.
Function Display Allowed Operators
LS LS-REAL, LS-IMAG, LS-MAG, LS-LOGMAG, LS-PHASE
RS RS-MAG, RS-LOGMAG
PS PS-MAG, PS-LOGMAG, PSD-MAG, PSD-LOGMAG
CS CS-REAL, CS-IMAG, CS-MAG, CS-LOGMAG, CS-PHASE
TF TF-REAL, TF-IMAG, TF-MAG, TF-LOGMAG, TF-PHASE
CH CH-MAG
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Limitations on Expressions
•	 Only one source waveform can be specified in an FFT.

Example of an expression that is not allowed: PS-MAG(C1+C2)
•	 A computation cannot be performed on the result of an FFT.

Example of an expression that is not allowed: PS-MAG(C1)+C2

Note
FFT operation is possible on math results. In the example above, define Math1=C1+C2 in advance, and 
then perform P-MAG(M1).

Notes on Computation
An FFT is not possible when there is no waveform in the math range if the display record length of 
the waveform is less than number of math points.

Operators
Operator Example Description
LS-REAL LS-REAL(C1) Real part of the linear spectrum of the specified waveform
LS-IMAG LS-IMAG(C1) Imaginary part of the linear spectrum of the specified waveform
LS-MAG LS-MAG(C1) Magnitude of the linear spectrum of the specified waveform
LS-LOGMAG LS-LOGMAG(C1) Logarithmic magnitude of the linear spectrum of the specified 

waveform
LS-PHASE LS-PHASE(C1) Phase of the linear spectrum of the specified waveform
RS-MAG RS-MAG(C1) Magnitude of the specified waveform’s RMS spectrum
RS-LOGMAG RS-LOGMAG(C1) Logarithmic magnitude of the specified waveform’s RMS 

spectrum
PS-MAG PS-MAG(C1) Magnitude of the power spectrum of the specified waveform
PS-LOGMAG PS-LOGMAG(C1) Logarithmic magnitude of the power spectrum of the specified 

waveform
PSD-MAG PSD-MAG(C1) Magnitude of the power spectrum density of the specified 

waveform
PSD-LOGMAG PSD-LOGMAG(C1) Logarithmic magnitude of the power spectrum density of the 

specified waveform
CS-REAL CS-REAL(C1,C2) Real part of the cross spectrum of the two specified waveforms
CS-IMAG CS-IMAG(C1,C2) Imaginary part of the cross spectrum of the two specified 

waveforms
CS-MAG CS-MAG(C1,C2) Magnitude of the cross spectrum of the specified two 

waveforms
CS-LOGMAG CS-LOGMAG(C1,C2) Logarithmic amplitude of the cross spectrum of the two 

specified waveforms
CS-PHASE CS-PHASE(C1,C2) Phase of the cross spectrum of the two specified waveforms
TF-REAL TF-REAL(C1,C2) Real part of the transfer function of the two specified 

waveforms
TF-IMAG TF-IMAG(C1,C2) Imaginary part of the transfer function of the two specified 

waveforms
TF-MAG TF-MAG(C1,C2) Amplitude of the transfer function of the two specified 

waveforms
TF-LOGMAG TF-LOGMAG(C1,C2) Logarithmic amplitude of the transfer function of the two 

specified waveforms
TF-PHASE TF-PHASE(C1,C2) Phase of the transfer function of the two specified waveforms
CH-MAG CH-MAG(C1,C2) Magnitude of the coherence function of the two specified 

waveforms
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FFT Functions
Linear Spectrum (LS-REAL/LS-IMAG/LS-MAG/LS-LOGMAG/LS-PHASE)
The linear spectrum is directly determined by the FFT. The power spectrum and cross 
spectrum can be determined from one or two linear spectra.

The FFT is a complex function, and thus the linear spectrum is composed of both a real and 
an imaginary part. The magnitude and phase of the frequency components of the measured 
waveform can be derived from the real and imaginary parts of the FFT result.

The following spectra can be determined:
Item Expression Computation
Real part LS-REAL R
Imaginary part LS-IMAG I
Magnitude LS-MAG (R2 + I2)
Log magnitude LS-LOGMAG 20 × log (R2 + I2)
Phase LS-PHASE tan-1(I/R)

Log magnitude reference (0 dB): 1 Vpeak
R, I: R and I represent the real part and the imaginary part, respectively, when each frequency 
component G of a linear spectrum is represented by “R + jI.”

Rms Value Spectrum (RS-MAG/RS-LOGMAG)
Rms value spectrum expresses the rms value of the magnitude of the linear spectrum. It does 
not contain phase information.

The following spectra can be determined:
Item Expression Computation
Magnitude RS-MAG (R2 + I2)/2
Log magnitude RS-LOGMAG 20 × log (R2 + I2)/2

Log magnitude reference (0 dB): 1 Vrms

Power Spectrum (PS-MAG/PS-LOGMAG)
The power spectrum expresses the power of each frequency component included in the 
measured signal. It is determined by taking the product of the linear spectrum and its complex 
conjugate. It does not contain phase information.

The following spectra can be determined:
Item Expression Computation
Amplitude PS-MAG DC component R2 + I2

AC component (R2 + II2)/2
Log magnitude PS-LOGMAG DC component 10 × log(R2 + II2)

AC component 10 × log{(R2 + II2)/2}
Log magnitude reference (0 dB): 1 Vrms2
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Power Spectral Density (PSD-MAG/PSD-LOGMAG)
The power spectral density (PSD) expresses the power spectrum per unit frequency. It is 
determined by dividing the power spectrum by the frequency resolution Δf found during the 
analysis of the power spectrum. The results of the PSD computation vary depending on 
the window function chosen. The power spectral density is used to compare power spectra 
analyzed at different frequency bands. However, it is not necessary for signals having a line 
spectrum such as a sine wave.

The following spectra can be determined:
Item Expression Computation
Magnitude PSD-MAG PS-MAG/(Δf × NENBW)
Log magnitude PSD-LOGMAG 10 × log(PS-MAG/(Δf × NENBW))

Log magnitude reference (0 dB): 1 Vrms2

NENBW (Normalized Equivalent Noise BandWidth)
NENBW varies as indicated below depending on the selected time window.
Time Window Type NENBW
Rect (Rectangular window) 1
Hanning (Hanning window) 1.5
FlatTop (Flattop window) 3.19693
Hamming (Hamming window) 1.3628
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Cross Spectrum (CS-REAL/CS-IMAG/CS-MAG/CS-LOGMAG/CS-PHASE)
The cross spectrum is determined from 2 signals. It is found by taking the product of the linear 
spectrum of one signal (Gx) and the complex conjugate (Gx*) of the linear spectrum of the 
other signal (Gy).
If the linear spectra of the 2 signals are represented by

Gx = Rx + jIx
Gy = Ry + jIy

then the cross spectrum Gyx is
Gyx	 = Gy×Gx*
	 = (Ry + jIy)(Rx - jIx) = Ryx + jIyx

where	Ryx = RyRx + IyIx
Iyx = RxIy - RyIx

The following spectra can be determined:
Item Expression Computation
Real part CS-REAL DC component Ryx

AC component Ryx/2
Imaginary part CS-IMAG DC component Iyx

AC component Iyx/2
Amplitude CS-MAG DC component (Ryx2 + Iyx2)

AC component (Ryx2 + Iyx2) /2
Log magnitude CS-LOGMAG DC component 10 × log (Ryx2 + Iyx2)

AC component 10 × log( (Ryx2 + Iyx2)) /2
Phase CS-PHASE tan-1(Iyx/Ryx)

Transfer Function (TF-REAL/TF-IMAG/TF-MAG/TF-LOGMAG/TF-PHASE)
The transfer function expresses the frequency characteristics between the input and the 
output of a system. The transfer function is given by the ratio of the linear spectrum of the 
output (Gy) to the spectrum of the input (Gx) at each frequency. Also, as can be seen from the 
equation below, the transfer function can be defined as the ratio of the cross spectrum of the 
input and output (Gyx) and the input power spectrum (Gxx).

Transfer Function = Gy/Gx = (Gy×Gx*)/(Gx×Gx*) = Gyx/Gxx = (Ryx + jIyx)/(Rx2 + Ix2)

The following items can be determined:
Item Expression Computation
Real part TF-REAL Ryx/(Rx2 + Ix2)
Imaginary part TF-IMAG Iyx/(Rx2 + Ix2)
Magnitude TF-MAG (Ryx2 + Iyx2) /(Rx2 + Ix2)
Log magnitude TF-LOGMAG 20 × log (Ryx2 + Iyx2)/(Rx2 + Ix2)
Phase TF-PHASE tan-1(Iyx/Ryx)

The magnitude of the transfer function gives the ratio of the magnitudes of the linear spectra 
of the output and input, whereas phase of the transfer function gives the phase difference 
between the two.
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Coherence Function (CH-MAG)
This function expresses the ratio of the output power generated by the input to the system to 
the total output power.

Coherence function = Gyx×Gyx*/(Gxx×Gyy)

Item Expression Computation
Magnitude CH-MAG (Ryx2 + Iyx2)/(Gxx × Gyy)

If the output signal is due entirely to the input signal, the coherence function becomes 1. 
As the ratio decreases, it falls below 1. Thus, the coherence function always takes on a value 
between 0 and 1.

Note
•	 On one data acquisition, the coherence function becomes 1 across all frequencies.
•	 The computed waveform must be averaged.
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Time Windows
You can select rectangular, Hanning, flattop, or Hamming as the time window.
The rectangular window is best suited to transient signals, such as an impulse wave, that attenuate 
completely within the time window. 
The Hanning window allows continuity of the signal by gradually attenuating the parts of the 
signal located near the ends of the time window down to the “0” level. Hence, it is best suited 
to continuous signals. The Hanning window provides a relatively higher frequency resolution 
compared to the flattop window. However, the flattop window has a higher level of accuracy. The 
Hamming window is a corrected Hanning window. The frequency resolution of its main beam is 
greater than that of the Hanning window. The Hamming window is suited for dividing close signals.
When the waveform being analyzed is a continuous signal, consider the above characteristics in 
selecting the proper window to be applied.

Time windows Integral Power spectrum
Rectangular

window

W(t) = u(t) - u(t - T) U(t): Step function

W(t) = 0.5 - 0.5cos(2π     )

W(t) = {0.54 - 0.46cos(2π     )}

W(t) = 0.54 - 0.46cos(2π     )

T

T

T

T

t

Sine wave

Hanning window

Rectangular window:

Hanning window:

Flattop window:

Hamming window:

T

TFlattop window

T

THamming window

t
T

t
T
t
T

sin{2π(1 - 2t/T)}
2π(1 - 2t/T)
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Procedure

Displaying FFT Waveforms and Math Range
When you register an FFT expression, the FFT waveform will be displayed on the FFT View panel. 
In addition, an FFT bar indicating the computation range will be displayed above the overview 
waveform on the Overview panel.
FFT View on the FFT View tab become selectable. Click FFT View to show or hide the FFT View 
panel.

FFT View Panel
Example displaying FFT view waveforms and properties

FFT View panel

Overview panel

FFT bar

FFT

FFT Vew 
Properties

[FFT] Vertical 
Coursor panel

*	 If the FFT is not active on the FFT View tab, FFT view, [FFT] vertical cursor, and horizontal cursor 
panels will not be displayed.

FFT View Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
FFT view waveforms can be displayed separately by trace names.
•	 Share property setting in FFT View/Zoom

Check Box Description
ON The split style setting is shared among FFT view waveforms and zoom 1 and 2 

waveforms.
•	 Cursor measurement values use the settings of the FFT View panel.
•	 When the display style is Split, detailed settings such as Auto, Count, and Tile 

Column and Row are not shared.
Set these separately for the FFT view and zoom waveforms.

OFF The split style setting is not shared among FFT view waveforms and zoom 1 and 2 
waveforms.
Set these separately for the FFT view and zoom waveforms.
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•	 Overlap, Split, and Tile
► page 4-10

Channel (Channel)
The trace names, sample rates, source file names of the channels displayed on the FFT View 
panel are shown in a table.

Setting the FFT Start Time and the Number of FFT Points
•	 When you drag the middle of the FFT bar, the math range is displayed in light blue, and you can 

change the FFT start time with the math time fixed.

	

Math range

Moves the FFT start time 
(the math time is fixed)

•	 The math time is the length corresponding to the number of FFT points. You cannot change the 
math time with the FFT bar.
► step 3 on page 4-86

•	 The FFT result will not be displayed if the FFT operation range contains sections without FFT 
source waveform signals.
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Procedure

Displaying Zoom Waveforms
On the FFT View tab, click Zoom 1 or Zoom 2 to show or hide zoom waveforms. 

Zoom 1 and 2 Panels
The areas enclosed by the zoom frames (zoom1 and 2) on the FFT view waveform appear 
zoomed.

Note
FFT operation is not possible on logic waveforms or WT5000’s PP waveforms.

Example displaying zoom waveforms (overlap display) and properties

Zoom 2 panelZoom 1 panel

FFT View panel

Select the scrolling direction or stop scrolling
Select the scrolling speed Drag to move the section to zoom

Zoom frame (zoom 1) Zoom frame (zoom 2) 

Zoom 1 
properties

Zoom 1 and 2 Properties
The following items are displayed in the property display area. Click  in front of each item to 
expand or collapse the display.

Split Style
Zoom waveforms can be displayed separately by trace names.
•	 Share Property Setting in FFT View/Zoom

The split style setting can be shared among FFT view waveforms and zoom 1 and 2 
waveforms. ► page 4-94

•	 Overlap, Split, and Tile
► page 4-10

Channel (Channel)
The trace names, sample rates, source file names of the channels displayed in the zoom 1 
and 2 panels are shown in a table.
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Position
•	 Offset

When you click the  Y button, the vertical movement mode can be turned on or off for the 
zoom waveform.

•	 View range
When you click the following items, you can set the zoom area to any position and zoom in 
or out of the target zoom waveform.
Item Description
Drag to set the range When you click this button and drag the FFT view waveform to any 

position, the zoom area is set to the area that results from dragging.
Horizontal ‒/+ Each time you click [-] or [+], the waveform is expanded or reduced 

horizontally.
Vertical ‒/+ Each time you click [-] or [+], the waveform is expanded or reduced 

vertically.

Horizontal auto scroll
The target zoom waveform can be scrolled horizontally automatically.
Item Description

Scrolling starts to the left.
Scrolling stops.
Scrolling starts to the right.

Scroll Speed You can select the auto scroll speed. From the drop-down list, you can select x1 
(normal speed) or x2 (double speed).

Shortcut key description
► page 4-13
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Procedure

Displaying History Waveforms
On the FFT View tab, click History to show or hide the [FFT] History panel.

*	 Valid only when an FFT operation is performed on a history waveform.

The history waveform FFT is exclusive to histories. FFT operations are performed for each history.
The FFTs of histories can be displayed overlapped in the FFT View panel.

Note
•	 When a history waveform and a non-history waveform are displayed on the same axis, FFT operations 

cannot be performed.
•	 The FFT bar is not displayed for FFTs of history waveforms.

[FFT] History Panel
The [FFT] History panel displays history waveforms.

Example displaying FFT history waveforms and properties

[FFT] History panel

FFT View panel
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Procedure

Measuring with Vertical Cursors
On the FFT View tab, click Vertical Cursor to display two vertical cursors in the FFT View panel. 
The vertical cursor panel displays the measured value at each cursor position (frequency), the 
differences in frequencies and measured values between the two cursors, and so on.

[FFT] Vertical Cursor Panel
► This is similar to the Vertical Cursor Panel in section 4.4.

Read “overview” as “FFT view and “view” as “zoom.”

Measuring with Horizontal Cursors
On the FFT View tab, click Horizontal Cursor to display two horizontal cursors in the FFT View 
panel. The horizontal cursor panel displays the measured value at each cursor position (time), the 
differences in times and measured values between the two cursors, and so on.

[FFT] Horizontal Cursor Panel
► This is similar to the Horizontal Cursor Panel in section 4.4.

Read “overview” as “FFT view and “view” as “zoom.”

Example displaying [FFT] vertical cursor panel, [FFT] horizontal cursor panel, and 
properties

FFT View panel

Zoom 1 panel

[FFT] Vertical 
Coursor properties

[FFT] Horizontal 
Coursor panel

[FFT] Vertical 
Coursor panel

Saving the Analysis Results of FFT Waveforms
The analysis results of FFT waveforms can be saved to a file.

Exporting Analysis Results to a File
On the File tab, click Export to File.
► “Exporting a File” on page 3-41.
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Procedure

Configuring the FFT Waveform Display
On the FFT View tab, click Display Setting to open the display setting dialog box. Click the 
Graticule, Horizontal Axis, Color, Size, and Other information tabs, and configure the display 
settings.

Grid
When you click the Graticule tab, the following item appears.

Select the number of vertical divisions.

Setting the Grid

Setting the Grid

Item Description
Auto Automatically determines whether to display the supplementary scale on the vertical axis.
ON Displays the supplementary scale on the vertical axis.
OFF Does not display the supplementary scale on the vertical axis.

Horizontal Axis
When you click the Horizontal Axis tab, the following items appear. You can set the horizontal 
scale and whether to show or hide the DC components.

Set the scale (LINEAR, LOG). 

DC component display (On, Off)

Color
This is the same as the display setting for measured data. ► page 4-36

Waveform and Grid Line Weight
This is the same as the display setting for measured data. ► page 4-37
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Other
When you click the Other information tab, the following items appear. You can set the 
waveform interpolation display. ► page 4-37 

Set the waveform interpolation 
display (Off, Line).

Note
Supplementary grid and horizontal scale can be set only when the horizontal axis unit is Hz.
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4.12	 High-speed Camera Synchronization 
Measurement (FS1 option)

You can synchronize video data of high-speed cameras saved through online monitoring and 
waveform data of a measuring instrument and analyze them.*

*	 You can also synchronize any other video files (saved by means other than high-speed cameras) and a waveform 
and analyze them.

For details, see the User’s Manual, IM IS8000-61EN.
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Chapter 5	

Acquiring Data (Online Monitoring)

This chapter explains how to monitor waveforms of measuring instruments and acquiring waveform 
data using the USB or Ethernet interface.

5.1	 Connecting to Instruments

Refer to the instruction manuals for the measuring instruments, and connect the instruments to 
your PC using USB or LAN cables.
If you are connecting the instruments to your PC through USB for the first time after purchase, you 
must install the USB driver. Install the USB driver in the PC according to the Installation Manual, IM 
IS8000-04EN.

Note
DL950 Operation Mode and Motion Mode
•	 Connect the DL950 with the operation mode set to Scope.
	 If you connect the DL950 through DAQ with the operation mode set to Recorder, it is automatically 

changed to Scope.
	 For details on the operation mode, see the DL950 manuals.
•	 When you connect the DL950 through DAQ, the DL950 Motion Mode (page 5-21) is automatically set to 

FreeRun.

Procedure
1.	 Start this software. A launcher appears.

2.	 Click DAQ, DAQ (WT), or DAQ (IEC 2k-9kHz).1, 2 
1	 To connect only the WT5000, select DAQ (WT).
2	 Select DAQ (IEC 2k-9kHz) when connecting a WT5000 to measure harmonics complying with the 

IEC 61000-4-7 Annex B (2k-9kHz) standard. This feature is available when the IEC harmonics/flicker 
measurement feature (/G7 option) is installed in the WT5000.

		  A Device Search window opens. ► section 3.4
		  Instruments connected to the PC via USB are automatically detected and displayed in a table.

3.	 If the instrument to be connected is not displayed in the table, select the communication 
interface (WIRE) type under Auto or select the detailed wire type under Manual, and click 
Search.

4.	 From the table of detected instruments, select the instrument you want to connect, and click 
Next or Open.
•	 Next
	 The Channel Setting window opens. ► sections 3.5, 5.2

If you click Next in the Channel Setting window, the DAQ setting window opens. ► sections 3.6, 5.9

•	 Open
	 The Control tab of the Monitor ribbon appears, and you can immediately execute monitoring 

(measurement) and recording (data acquisition).
	 Depending on the function selected in step 2, the status displayed will vary as follows.
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5.1  Connecting to Instruments

When Connected via DAQ
A DAQ - (host name) tab window opens. This is an example when a DL950 is connected.

Overview panel

Numeric monitor 
panel

DAQ list panel Overview 
properties

Device 
control panel

Channel 
control panel

When Connected via DAQ (WT) (WT5000 only)
A DAQ (WT) - (host name) tab window opens.
Displayed panels Default setting Reference
Numeric panel Matrix display page 5-9
Overview panel PP waveforms (WU1, WI1) page 5-5
Device control panel Measurement mode Normal page 5-24

WaveTime/div maximum update rate setting at start (1/10)

Numeric 1 panel

Numeric 1 
properties

Overview panel

Device control panel

Channel control panel
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5.1  Connecting to Instruments

When Connected via DAQ (IEC 2k-9kHz) (WT5000 only)
DAQ (IEC 2k-9kHz) - (host name) tab window opens.
Displayed panels Default setting Reference
Bar panel Display by frequency according to IEC61000-4-7 Annex B (2k-9kHz) 

standard
page 5-10

Overview panel Display channel: Numeric display Preset 25 (page 3-23) page 5-5
Numeric panel 4-value display page 5-9
Device control panel Measurement Mode IEC Harmonic page 5-12

Calculate Type 2k - 9kHz
IEC 61000-4-7 Edition 2.0 A1
PLL Source U1
U Grouping Type2
I Grouping Type2
Averaging ON
Min Frequency 2000
Max Frequency 9000
Crest Factor 3

Bar 1 panel

Numeric 1 panel

Overview panel

Bar 1 
properties

Device 
control panel

Channel 
control panel

Explanation
Monitor Ribbon

This is a ribbon for online measurement. Click a tab to switch the ribbon.
Tab Description Refer To
Monitor Displays measured data of connected measuring instruments. Section 5.2 to section 5.7
Control You can execute monitoring (measurement) and recording (data 

acquisition).
Section 5.8 to section 5.11

Video This is a high-speed camera synchronization option feature. Section 5.12
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5.2	 Waveform/Power Display Window

This section explains how to configure the display channels for measurement data (waveforms, power 
values) of connected instruments on this software.
The settings are the same as those in the Channel Setting window of Smart Setup described in 
section 3.5.

Procedure

Channel Setting Window
You can set display groups and measurement conditions for each channel to acquire channel 
information from the connected measuring instrument and display it on this software.

1.	 On the Monitor tab, click Channel Setting. A Channel Setting window opens.

2.	 Refer to section 3.5, and set the waveform display conditions, groups, and so on for each 
channel.

When a WT5000 Is Connected and Data Streaming Is Set to ON*
*	 Data streaming measurement condition settings ► page 5-22

Data streaming feature (DS option) is required in the WT5000.

Selecting DS/PP Waveforms
A column for selecting DS/PP waveforms appears in the list of measurement conditions of 
each channel.
In addition to the acquisition channels of data streaming (DS) waveforms, channels can be 
added to acquire PP waveforms (waveform display data).

Selecting DS/PP Waveforms
Add channels.

• Selected: DS waveform
• Unselected: PP waveform
• Blank: Waveform channels other 

than those of the WT5000 
(WT’s numeric channels, 
DL950’s waveform channels)

Trace Names of DS/PP Waveforms
“Data Streaming” or “PP Compress” indication is added to the trace names in the overview 
waveform display and file export settings.
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5.3	 Using the Window

This section explains the following operations:

• Displaying Overview Waveforms
• Displaying Preview Waveform (When a 

WT5000 is connected)
• Displaying Numeric Monitor
• Displaying View Waveforms
• Moving and Zooming Waveforms

• Numeric Display (When a WT5000 is 
connected)

• Displaying Harmonic Bar Graphs (When a 
WT5000 is connected)

• Displaying Vector (When a WT5000 is 
connected)

Procedure

Displaying Overview Waveforms
1.	 When a connection is established with a measuring instrument, a DAQ-(host name) tab 

window opens. You can show or hide Overview panel by clicking Overview Monitor on the 
Monitor tab.

Overview panel
2.	 When you start measuring or recording, the entire waveform data is displayed in the 

Overview panel.
•	 Starting and stopping measurements ► section 5.8
•	 Starting and stopping recording ► section 5.9

Example Displaying the Overview Panel (Split Display) and Properties

Overview panel Overview properties

When waveforms are overlapped, clicking the top waveform causes the waveform under it to 
become active.
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5.3  Using the Window

Overview Properties
► page 4-10

The position setting is not available.

Procedure

Displaying Preview Waveform (When a WT5000 is connected)
1.	 On the Monitor tab, click Preview to show or hide the preview panel.

Preview Panel
The most recent DS or PP waveform is displayed.
WT5000 waveform channels selected in the channel settings in section 5.2 are shown in the 
preview display.

*	 WT5000 numeric channels and DL950 waveforms are not shown in the preview display.

Perview panel

Overview panel

Perview properties

Preview Properties
Channel (Channel)
► page 4-10

Multiple Display (Multiple Display)

Check Box Description
ON A trace with the same sample rate as the selected trace is overlaid.
OFF The trace you select in the list of channels in the properties is shown in preview.
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5.3  Using the Window

Procedure

Displaying Numeric Monitor
1.	 On the Monitor tab, click Numeric Monitor to show or hide the numeric monitor panel.

Numeric Monitor Panel
The current measured values are displayed numerically.
The numeric monitor allows you to view the values of measurement data acquired from the 
measuring instruments that this software is connected to at 300 ms cycles.*

*	 Data acquisition interval may increase depending on the connected instruments.

The channels displayed on the numeric monitor are those selected in the channel settings in 
section 3.5 .
Selecting the numeric monitor display channels ► pages 3-15, 3-16

Numeric monitor
panel

Overview panel

Numeric monitor 
properties

Numeric Monitor Properties
There are no settings.
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5.3  Using the Window

Procedure

Displaying View Waveforms
1.	 On the Monitor tab, click View1 or View2 to show or hide the View 1 or 2 panel.

View 1 and 2 Panels
The waveform in the area enclosed by the zoom frame (view 1 and 2 ) on the overview 
waveform appears zoomed.
► page 4-12

View 1 and 2 Properties
► page 4-12

Here, read Position as Scaling. The offset setting is not available.

Procedure

Moving and Zooming Waveforms
► page 4-29

Note
The waveform displayed in the Overview panel when a DL950 is connected shows the maximum and 
minimum values over a given number of points because of its high-speed display. If the range of a given 
number of points exceeds one dot of the resolution of the waveform display screen, maximum and minimum 
values are displayed continuously. To view the actual values, use the following method.
•	 Open the recorded waveform data using offline analysis, and view the data. ► section 4.3
•	 Display the Remote Control ribbon, click Trigger Mode, and zoom in on the waveform. ► chapter 6
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5.3  Using the Window

Procedure

Numeric Display (When a WT5000 is connected)
For display channel settings, see “When a WT5000 is connected” on page 3-13.

1.	 On the Monitor tab, click Numeric1 or Numeric2 to show or hide the Numeric 1 or 2 panel.

Numeric 1 and 2 Panels
The WT’s measurement data is displayed numerically.
•	 You can change the numeric display format in the property display area.
•	 You can change the measurement function, harmonic order, displayed items of elements, 

and devices in the numeric display setting dialog box. ► page 5-27.
You cannot change the settings while measured data acquisition is in progress.

Example Displaying the Numeric 1 Panel (4-value Display), Numeric 2 Panel (Matrix 
Display), and Properties

Numeric 2 panel

Numeric 1 panel

Numeric 1 
properties

Numeric 1 and 2 Properties
You can set the numeric display format in the property display area.

Numeric Data Display

Display Format Description
4 items 4-value display. Four numeric data values are displayed in two columns.
8 items 8-value display. Eight numeric data values are displayed in two columns.
16 items 16-value display. 16 numeric data values are displayed in four columns.
32 items 32-value display. 32 numeric data values are displayed in four columns.
Matrix Matrix display. A table of numeric data is displayed with measurement functions 

listed vertically and symbols indicating elements and wiring units listed horizontally.
Data can be displayed for all connected units and for all measurement modes (850 
channels max.).*
*	 For 17 functions × (7 elements + 3 wiring units) × 5 units max.

Select element 
to display

Show or hide the elements and wiring units by selecting or unselecting the check 
boxes of Element 1 to 7, ΣA , ΣB , and ΣC.

Display example ► page 4-23
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5.3  Using the Window

Procedure

Displaying Harmonic Bar Graphs (When a WT5000 is connected)
1.	 On the Monitor tab, click Bar1 or Bar2 to show or hide the Bar 1 or Bar 2 panel.

Bar 1 and 2 Panels
•	 Harmonic measurement data is displayed in a bar graph and numeric list for each harmonic.

On the Bar 1 and 2 panels, you can display harmonic bar graphs and numeric lists. Up to 
three of these elements can be displayed.

•	 You can change the number of bar graphs to display, the measurement function, displayed 
items of elements, and devices in the bar graph display setting dialog box. ► page 5-30

Example Displaying the Bar 1 Panel and Properties

Bar1 panel

Bar1
properties

When you select a 
value in the numeric 
list, the boundary of 
the corresponding 
harmonic bar is 
highlighted.

Harmonic bar graphs Numeric list

Bar 1 and 2 Properties
Bar2 propertiesBar1 properties

Shows or hides numeric lists
Synchronizes or 
unsynchronizes numeric lists

Bar setting items are displayed in the property display area.
• Function • Numeric List
• Color • Synchronization
• Start Order and End Order
Setting details ► page 4-25



5-11IM IS8000-01EN

5.3  Using the Window

Harmonic bar graph display complying with IEC 61000-4-7 Annex B 
(2k-9kHz)
When DAQ (IEC 2k-9kHz) is selected in the launcher, measurements are taken under the 
following measurement conditions, and the bar graph and numeric list are displayed by 
frequency.

Setting the Measurement Conditions
•	 Measurement Mode: IEC Harmonic
•	 Calculate Type: 2k - 9kHz
•	 IEC 61000-4-7: Edition 2.0 A1

When you select a value in the numeric list, the 
boundary of the corresponding harmonic bar is 
highlighted.

Measurement Mode 
set to IEC Harmonic

Calculate Type set 
to 2k -9kHz

IEC 61000-4-7 set 
to Edition 2.0 A1

Bar1 panel

Bar1
properties

Harmonic bar graphs Numeric list

Note
When Calculate Type is 2k - 9kHz and IEC 61000-4-7 is Edition 1.0 in the measurement conditions, 
U(f) and I(f) in the numeric list are displayed as “---.” “f” represents frequency.
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5.3  Using the Window

Explanation

Measurement Conditions when the Measurement Mode is IEC Harmonic*
*	 IEC harmonics/flicker measurement feature (/G7 option) is required for WT5000.

•	 For the measurement conditions when the measurement mode is Normal, see page 5-24.
•	 For details on the IEC harmonic measurement settings, see the WT5000 user’s manuals.
Setting Description
Calculate Type 2k - 9kHz: Select this item to measure harmonics complying with IEC 61000-4-7 Annex 

B (2k-9kHz).
Measurements are made using the software’s internal computation process. 
For details on expressions, grouping, and averaging, see page 5-13.

Harmonic Order: Measurements are made using the computation process of IEC harmonics 
mode on the WT5000 measuring instrument.

IEC 61000-4-7 Edition 1.0, Edition 2.0, Edition 2.0 A1
PLL Source U1, I1, U2, I2, U3, I3, U4, I4, U5, I5, U6, I6, U7, I7, Ext Clk
U Grouping OFF, Type 1, Type 2, Type 3,* Type 4*
I Grouping OFF, Type 1, Type 2, Type 3,* Type 4*
Averaging ON, OFF
Crest Factor 3, 6, 6A

*	 This can be selected when the WT5000 firmware version is 3.61 or later and Calculate Type is Harmonic 
Order.

Settings when Calculate Type is 2k - 9kHz
Min Frequency 2000, 2100, 2500
Max Frequency 8900, 9000, 9900, 10000
Settings when Calculate Type is Harmonic Order
Min Order 0, 1
Max Order 40, 50, 150, 180, 200

Default Values
• When Calculate Type is 2k - 9kHz • When Calculate Type is Harmonic Order

Item Setting Item Setting
IEC 61000-4-7 Edition 2.0 A1 IEC 61000-4-7 Edition 2.0 A1
PLL Source U1 PLL Source U1
U Grouping Type 2 U Grouping Type 2
I Grouping Type 2 I Grouping Type 2
Averaging ON Averaging ON
Min Frequency* 2000 Min Order 1
Max Frequency* 9000 Max Order 180
Crest Factor 3 Crest Factor 3
*	 The center frequency within the range of Min Frequency to Max Frequency is the target of the 

calculation. For details on the center frequency, see the expression on the next page.

Voltage Grouping and Current Grouping (U Grouping/I Grouping)
Item Description
OFF The middle harmonic components are not included in the harmonic components.
Type 1 Harmonic subgroups are treated as components of the frequency’s harmonics.
Type 2 Harmonic groups are treated as components of the frequency’s harmonics.
Type 3* Interharmonic center subgroups are treated as components of the frequency’s harmonics.
Type 4* Interharmonic groups are treated as components of the frequency’s harmonics.

*	 This can be selected when the WT5000 firmware version is 3.61 or later and Calculate Type is 
Harmonic Order.

	 For details on interharmonic center subgroups and interharmonic groups, see the WT5000 user’s 
manual or section 1.7 in Harmonic/Flicker Software User’s Manual (IM IS8000-63EN).
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Harmonics when Calculate Type is 2k - 9kHz are obtained from the components of harmonic 
subgroups and harmonic groups with respect to the center frequency. 

Select the grouping setting from OFF, Type1, and Type2.

Note
For grouping when Calculate Type is Harmonic Order, the calculation expression for IEC harmonic 
mode specified in the WT5000 instrument is applied.

IEC 61000-4-7 Annex B (2k-9kHz) harmonic measurement
This section describes the calculation expression, grouping, and averaging for measuring 
harmonics complying with IEC 61000-4-7 Annex B (2k-9kHz)* with this software.
* Complies with IEC 61000-4-7 Annex B (2k-9kHz) only when the grouping is Type 2
For terms related to IEC harmonic measurements., see the WT5000 user’s manuals.

Expression when Calculate Type is 2k - 9kHz

kC2Gb = 

b: Center frequency  2100, 2300, ..., 8900 Hz
f = b–95Hz

b + 100Hz Type 1: -5 to +5 Hz

Type 2: -95 to +100 Hz

Grouping
The figure below shows the harmonics when OFF, Type 1, and Type 2 are used, using the 
case where the center frequency is 2100 Hz as an example.

2100 Hz 2200 Hz2000 Hz

Type 1 = 2095 to 2105 Hz, harmonic subgroup

2100 Hz 2200 Hz2000 Hz

Type = OFF (2100 Hz only), no grouping

2100 Hz 2200 Hz2000 Hz

Type 2 = 2005 to 2200 Hz, harmonic group
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Averaging
When Calculate Type is 2k - 9kHz and Edition is 2.0, 2.0A1
Smoothing:  Time constant: 1.5 s
Smoothing filter coefficient (window width: 200 ms)

SUM 8.012

Z-17.012

1

Note
•	 When Calculate Type is 2k - 9kHz and Edition is 1.0, there is no averaging process.
•	 When Calculate Type is Harmonic Order, computation is performed in the WT5000.

THC (Total Harmonic Current)
The sum of the rms values of harmonic current components from orders 2 to Max Order.

k = 2

I(k): rms current of each harmonic
k: harmonic order

Max Order

I(k)2
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5.3  Using the Window

Procedure

Displaying Vector (When a WT5000 is connected)
1.	 On the Monitor tab, click Vector1 or Vector2 to show or hide the Vector 1 or Vector 2 panel.

Vector 1 and 2 Panels
•	 The relationship of the phase difference and magnitude (rms value) between the 

fundamental waves U(1) and I(1) of each element assigned to the selected wiring unit is 
displayed using vectors. The positive vertical axis is set to zero (angle zero), and the vector 
of each input signal is displayed.

•	 You can change the vector display source (element or wiring unit) and the device in the 
numeric display setting dialog box. ► page 5-32

Example showing the Vector1 panel and properties (vector display of wiring unit A)

Vector1 panel

Vector1
properties

Numeric display 
(magnitude) of input 
element 1

Numeric display 
(magnitude) of input 
element 2

Numeric display (magnitude) of input element 3
Numeric display (phase difference) of wiring unit A

Vector 1 and 2 Properties

Turns the numeric display on and off

Set the display colors.

Set the zoom factor.

Vector source

Vector setting items are displayed in the property display area.
• Vector Source (Object) • Color 
• Voltage Zoom Factor (U Mag), Current Zoom Factor (I Mag) • Numeric Display (Numeric)
Setting details ► page 4-28
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5.4	 Measuring with Cursors

This section explains the following operations:
•	 Measuring with vertical cursors
•	 Measuring with horizontal cursors

Procedure
The procedure is the same as with the cursor measurement of offline analysis.
► section 4.4

Measuring with Vertical Cursors
1.	 On the Monitor tab, click Vertical in the Cursor group to display two vertical cursors in the 

Overview and View panels.

Measuring with Horizontal Cursors
1.	 On the Monitor tab, click Horizontal in the Cursor group to display two horizontal cursors in 

the Overview and View panels.

Note
The cursor values on the online monitor display maximum and minimum values over a given number of 
points.

When DL950 power math or motor dq analysis waveform data (timestamp format) is displayed
The timestamp data value at the cursor position is displayed. If the data is not available, the previous data 
value is displayed.
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5.5	 Displaying a List of Recorded Data

This section explains how to display a list of recorded data.

Procedure
1.	 On the Monitor tab, click DAQ List to show or hide the DAQ List panel.

DAQ List Panel
2.	 When you start recording, the following items of recorded data are displayed in a list.

Starting and stopping recording ► section 5.9

Item Description
Name The recording destination folder and file name are displayed.
Date You can specify the display format with the record setting in the DAQ setting window.

► page 3-25
Size The size of the recorded data file is shown.

Example Displaying the DAQ List Panel and Properties

		

DAQ list 
propertieDAQ list panel

Opening a Recorded Data File
When you double-click a file in the DAQ List, an Analysis-(file name) tab window opens, and 
the waveforms of recorded data are displayed in the Overview panel. You can continue offline 
analysis.
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Opening the File Automatically When Recording Ends
You can set whether to automatically open the file saved last after a recording stops. Use the 
Automatically open the last saved file ON/OFF check box in the property display area.
Check Box Description
ON File saved last is opened automatically when a recording stops. A new Analysis-(file name) 

tab window opens, and the waveforms of recorded data are displayed in the Overview 
panel.

OFF �The file saved last is not opened automatically.
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5.6	 Setting the Measurement Conditions on the 
Measuring Instrument

This section explains the following operations:
• Simple Channel Control Settings: channel settings
• Simple Instrument Control Settings: trigger, waveform acquisition conditions

Note
•	 The operation here directly changes the parameters of the connected measuring instrument itself.
•	 Changes made to the measurement conditions of the measuring instrument will not be reflected in the 

measurement conditions on the IS8000 Software (“List of Measurement Conditions of Each Channel” 
under “Channel Setting Window” of section 3.5).

Procedure

Simple Channel Control Settings
1.	 On the Monitor tab, click Channel in the Control group to show or hide the channel control 

panel.

Channel Control Panel
2.	 Select the channel you want to configure from the drop-down list at the top of the panel. 

You can also select by clicking the channel you want to configure from the list of channels 
in the property display area.

3.	 Set the channel measurement conditions.

Example Displaying the Channel Control Panel and Properties
The settings displayed for each channel vary depending on the instrument being controlled 
and the installed modules.
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•	 When a DL950 Is Being Controlled
For each measurement channel, you can set signal input conditions, such as input coupling, 
probe attenuation, and bandwidth limit, and main amplitude measurement conditions.

	

Channel 
control panel

Channel control 
properties

Select a measurement channel. Set Devices to DL950.

•	 When a WT5000 Is Being Measured
For each measurement channel, you can set the module name display, terminal (the target 
for setting the current range), although voltage range, voltage range, auto current range, 
current range, line filter, frequency filter, and so on.

	

Channel 
control panel

Channel control 
properties

Select a measurement channel. Set Devices to WT5000.

List of Channels in the Property Display Area
When you click the channel control panel, the property display area shows the measurement 
channel trace names, sample rates, and instrument names in a list. When you click a channel 
on the list, the channel to be configured in the channel control panel changes.
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Simple Instrument Control Settings
1.	 On the Monitor tab, click Device in the Control group to show or hide the device control 

panel.

Device Control Panel
2.	 When multiple devices are connected and displayed synchronously, select the instrument 

you want to configure from the drop-down list at the top of the panel.

3.	 Set each item.

Example Displaying the Device Control Panel and Properties
The settings vary depending on the instrument being controlled and the installed modules.
•	 When a DL950 Is Being Controlled

You can set the recording operation mode, time base, record length, frequency and so on.

	

Device control 
properties

Motion Mode

Set Devices to DL950.

Device 
control panel

Motion Mode
The following two types are available.
Motion mode Description
FreeRun Data is acquired immediately when measurement is started. Data acquisition 

continues until measurement is stopped.
Trigger Data is acquired after you start a measurement when trigger conditions are met. 

Data acquisition stops when data is acquired for the specified length of time.
In Trigger mode, set the mode (Auto, Auto Level, Normal, Single, N Single, On 
Start), measurement time, and trigger count. The setting range is determined by 
the number of measurement channels and sample rate.

Note
When a DL950 is connected through DAQ, the operation mode is automatically set to FreeRun. When 
the connection is closed, the mode changes to Trigger.
If data is acquired in Trigger mode, the DL950 will stop at the specified trigger count, but the IS8000 
data acquisition will not stop in sync.



5-22 IM IS8000-01EN

5.6  Setting the Measurement Conditions on the Measuring Instrument

•	 When a WT5000 Is Being Measured
You can set the data update interval, crest factor, the null feature on/off state, the averaging 
on/off state, and so on.

	

Device control 
properties

Set Devices to WT5000.

Set the measurement 
conditions of data 
streaming waveforms.

Device 
control panel

Measurement Conditions of Data Streaming Waveforms
You can turn data streaming on or off and specify the sample rate in the following cases.

•	 Available when the data streaming feature (DS option) is installed in the WT5000
•	 WT5000 setting conditions

Setting Description
Measurement Mode Normal
Update Mode Constant
Update Rate 50 ms to 1 s (When the waveform sample rate is 2 MS/s or more, 

Update Rate is 100 ms to 1 s.)

•	 Communication interface
USB3.0 or later for USB, 1 GB or better for Ethernet

•	 Number of streams that can be acquired
Sampling rate USB3.0 and later Ethernet 1 GB or better

10 kS/s 22 streams 22 streams
20 kS/s 22 streams 22 streams
50 kS/s 22 streams 22 streams

100 kS/s 22 streams 22 streams
200 kS/s 22 streams 22 streams
500 kS/s 14 streams 6 streams

1 MS/s 6 streams 4 streams
2 MS/s 2 streams 2 streams
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List of Channels in the Property Display Area
When you click the Device Control panel, the property display area shows the measurement 
channel trace names, sample rates, and instrument names in a list. The displayed contents 
are the same as when you click Channel Control panel.

Explanation

Settings on the Channel Control Panel
When a DL950 Is Being Controlled
The displayed settings vary depending on the measured item (installed module).
For details on measurement items, modules, settings, and their ranges, see the measuring 
instrument User’s Manual, IM DL950-01EN, or the Getting Started Guide, IM DL950-03EN.

For the conditions that allow monitoring and DAQ (data acquisition) when Motion Mode (see page 
5-21)  is set to Trigger, see Appendix 2.

When a WT5000 Is Being Controlled
For details on the settings, and their ranges, see the measuring instrument User’s Manual, 
IM WT5000-01EN, or the Getting Started Guide, IM WT5000-03EN.

Settings on the Device Control Panel
For details on the settings and their ranges,, see the user’s manual for the instrument.
When a DL950 Is Being Controlled

Setting Description
Motion Mode FreeRun, Trigger

Example of settings displayed when the operation mode is set to FreeRun
Time Base Internal, External
Record Length Can be set when Motion Mode is set to Trigger Fixed to 100 M for Free Run

► Getting Started Guide, IM DL950-03EN.
Sample Rate Can be set when the Motion Mode is set to FreeRun and the time base is 

Internal.
► Getting Started Guide, IM DL950-03EN.

Trigger Out Pulse, Normal
Pulse Width Can be set when Trigger Out is Pulse.

1 ms, 50 ms, 100 ms, 500 ms
External Sample Output OFF, Acquisition, Freerun
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When a WT5000 Is Being Controlled

Settings Description
Measurement Mode Normal, IEC Harmonic

► User's Manual, IM WT5000-01EN

•	 When the Measurement Mode Is Norma
Example of displayed settings

Settings Description
Update Mode Constant, Trigger, Auto
Update Rate •	 Update interval setting range on the WT5000: 10 ms to 20 s (data streaming 

update interval: 50 ms to 1 s)
•	 When Update Mode is set to Auto, you can select either 10 ms or 50 ms.

Crest Factor 3, 6, 6A
Zero-level compensation 
(Null)

ON, OFF

Averaging ON, OFF
Wave Time/div PP waveforms’ time scale (time per grid division) on the measuring instrument. 

On the monitor, a single PP waveform is displayed using a time scale magnified 
10 times (up to the update rate).
* Fixed to 100 ms/div when data streaming is on.

Data Streaming* ON, OFF
Can be specified only when the data streaming feature (DS option) is installed 
in the WT5000.
•	 When the data streaming feature is disabled, the following indication is 

displayed depending on the reason for the disabled state.
Indication Reason for the disabled state
Disabled (No/DS option) ... No DS option
Disabled (Invalid license) ... No DS license
Disabled (Slow connection) ... The connection speed is not compatible with 

DS (not at least USB 3.0 or Ethernet 1 G).

Sample Rate* Can be specified only when the data streaming feature (DS option) is installed 
in the WT5000.

*	 For details, see “Measurement Conditions of Data Streaming Waveforms” on page 5-22.

Note
Timeout period when the update mode is set to Auto (WT5000)
To display the measurement results of each period correctly, check that the timeout period is greater than 
the time limit for detecting the period of the input waveform.
You can view the timeout period setting using the menu icon on the WT5000 control screen.
	 Click the Update Rate/Averaging icon > Update Rate/Averaging menu > Time Out
	 For details, see the WT5000 user’s manual.

•	 When the Measurement Mode Is IEC Harmonicl
For the measurement conditions for IEC Harmonic mode, see page 5-12.
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5.7	 Configuring the Window Display Settings

This section explains the following display setting operations.
•	 Configuring the Waveform Display (grid, horizontal scale, color, waveform and grid line thickness, 

waveform interpolation display)
•	 Configuring the Numeric Display (function, harmonic, measuring instrument, element)
•	 Configuring the Bar Graph Display (function, element, measuring instrument)
•	 Configuring the Vector Display (elements and wiring units, measurement instruments)

Procedure

Configuring the Waveform Display
1.	 On the Monitor tab, click Display Setting to open the display setting dialog box. Click the 

Graticule, Horizontal Axis, Color, Size, and Other information tabs, and configure the display 
settings.

Grid
If you click the Graticule tab, you can set the number of vertical scale divisions of the 
waveform display.
► section 4.5

Horizontal Axis Display Format
When you click the Horizontal Axis tab, the following items appear. You can set the horizontal 
axis display format.

Select the number of decimal places.

Select the type of time to display 
on the horizontal scale.

Type of time to display on the horizontal scale ► section 4.5

Color
If you click the Color tab, you can set the window background, grid, and text colors with a 
color palette.
► section 4.5

*	 You can change the waveform colors in the Channel Setting window. ► sections 3.5, 5.2
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Waveform and Grid Line Weight
If you click the Size tab, you can set the waveform and grid line weights.
► section 4.5

Waveform Interpolation Display Setting
When you click the Other Information tab, the following items appear. You can set the 
waveform interpolation display.

Set the waveform interpolation display.
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Configuring the Numeric Display
Only When a WT5000 Is Connected
1.	 On the Monitor tab, click Numeric1 or Numeric2. The Numeric 1 or Numeric 2 panel is 

displayed, and numeric setting commands are enabled.

2.	 On the Monitor tab, click Numeric Setting to open a numeric value setting dialog box.

3.	 From the Change Numeric drop-down list, select the panel you want to edit.

4.	 Use Record items to select the recording mode.

	 You can set multiple channels you want to record at once.

Recording mode Description
Displayed before recording* Numeric data is recorded for the channels that are displayed.
All Numeric data is recorded for all channels.
Selected You can select the channels to record one by one.

► “Record” on page 5-28
If there is at least one channel configured to be recored for each display 
format, the text color of the display format tab will be blue. (See the figure 
below.)

*	 If a display item is switched after recording has started, only the display item at the start of recording 
will be recorded, not the display item switched later.

5.	 Select the display type tab you want to use.

	 The background color of the selected tabs is blue.

Recording mode: Selected
4-, 8-, 16-, and 32-value Displays

Select the function.
Select the instrument.OrderSelect the element.

Select a display type tab.

Switches the panel to be edited

Select a preset.
Export settings.

Import settings.

Select the channels to 
record separately.*

Select the channels to 
record collectively.*

Select the recording mode.

Load a 
preset.

*  Available when the recording mode is set to Selected

Exporting or import settings, selecting and loading a preset ► page 3-13
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Recording mode: Displayed before recording
Matrix Display

Select the Matrix tab.
Select the measurement mode.

Switches the panel to be edited

Select the instrument.

Select the channels to 
record collectively.*

Select the channels to 
record separately.*

Shows functions Shows elements 
and wiring units

Select the recording mode.

*  Available when the recording mode is set to Selected

•	 Devices
When multiple measuring instruments are connected, you can select the instrument number 
of the measuring instrument you want to measure with from the drop-down list.
For 4-, 8-, 16-, and 32-value displays, you can select it for each channel.

•	 Measure Mode
When matrix display is in use, you can select the measurement mode of the function from 
the following:

RMS, MEAN, DC, RMEAN, AC
*	 For the function measurement mode symbols and their meanings, see the WT User’s Manual.

•	 Record
When the recording mode is set to Selected, you can select the channels to record one by 
one. Use the Record check boxes to make the selection.
Check Box Description
ON The target numeric data will be recorded.
OFF The target numeric data will not be recorded.
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•	 Function 
The function of each channel is displayed. For 4-, 8-, 16-, and 32-value displays, you can 
change the function to be measured. Click the displayed function of a channel, and select 
the function from the drop-down list.

*	 For the function symbols and their meanings, see the WT User’s Manual.

•	 Element
The element of each item is displayed. For 4-, 8-, 16-, and 32-value displays, you can 
change the element setting.
If the launcher’s DAQ (IEC 2k-9kHz) feature is used, the frequency is displayed.
Frequency input range: 2000 to 10000

•	 Harmonic Order (Order)
For 4-, 8-, 16-, and 32-value displays, the harmonic order to be edited is displayed. 
This is blank for functions that cannot display harmonics or frequencies.
To change a harmonic or frequency, click the displayed harmonic you want to change, and 
select a new value from the drop-down list.

*	 For details on harmonics, see the WT User’s Manual.

Select the function. Select the harmonic.

6.	 If you changed the settings, click OK.

Selecting the Input Element or Wiring Unit to Be Measured
7.	 When you click the following items, the display contents of the WT Numeric Viewer panel 

will change.
•	 Input element options: 1 to 7
•	 Wiring unit options: ΣA, ΣB, ΣC
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Configuring the Bar Graph Display
Only When a WT5000 Is Connected
1.	 On the Monitor tab, click Bar1 or Bar2. The Bar 1 or Bar 2 panel is displayed, and bar setting 

commands are enabled.

2.	 On the Monitor tab, click Bar Setting to open a dialog box for setting the WT harmonic bar 
graph.

3.	 From the Change Bar drop-down list, select the panel you want to edit.

Example when Bar1 is selected

		

Min

Auto RangeSwitches the panel to be edited

Select the functions.

Select the instrument.

Select the elements. Max

Select the channels to record.
Select the channels to display.

	 You can use the check boxes in the title line to collectively turn on or off the settings of the 
corresponding columns.

•	 Record
Set whether to record each channel with the check box.
Check Box Description
ON The target harmonic data will be recorded.
OFF The target harmonic data will not be recorded.

•	 Display
Show or hide the bar graph of each channel with the check box.
Check Box Description
ON Bar graphs are shown.
OFF Bar graphs are not shown.

•	 Function
From the drop-down list, select the function to display on the bar graph .
The bar graph is displayed for the combination of the function and element that you select.

Bar1 panel Bar2 panel
Default setting U, I, P S, Q, λ
Only U and I are valid when the DAQ (IEC 2k-9kHz) feature is in use.
*	 For the function symbols and their meanings, see the WT User’s Manual.

•	 Element
Select which element to display on the bar graph.
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•	 Devices
When multiple measuring instruments are connected, you can select the instrument number 
of the measuring instrument you want to measure with from the drop-down list.

•	 Minimum (Min) and Maximum (Max)
Set the maximum and minimum values for displaying harmonic bar graphs.

•	 Auto Range (Link)
For each channel, you can select whether to automatically set the minimum and maximum 
values. Use the Link check boxes to make the selection. The default setting is ON.
Check Box Description
ON The minimum and maximum values are calculated from the voltage range and 

current range and applied to the Min and Max displays.
OFF You can directly change the values displayed for Min and Max.
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Configuring the Vector Display
Only When a WT5000 Is Connected
1.	 On the Monitor tab, click Vector1 or Vector2. The Vector1 or Vector2 panel is displayed, and 

vector setting commands are enabled.

2.	 On the Monitor tab, click Vector Setting to open the vector display setting dialog box.

3.	 From the Change Vector drop-down list, select the panel you want to edit.

Example when Vector1 is selected

Switches the panel to be edited

Select the element or wiring unit.

Select the instrument.

Select the channels to display.

	 You can use the check boxes in the title line to collectively turn on or off the settings of the 
corresponding columns.

•	 Display (Display)
Show or hide the vector graph of each vector source with the check box.
Check Box Description
ON Vectors are displayed.
OFF Vectors are not displayed.

•	 Vector Source (Object)
Select the object to display the vector of. From the drop-down list, you can select from the 
following elements and wiring units.

Element 1 to 7, ΣA, ΣB, ΣC

•	 Devices
When multiple measuring instruments are connected, you can select the instrument number 
of the measuring instrument you want to measure with from the drop-down list.
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This section explains the following operations:
• Starting monitoring • Pausing monitoring
• Stopping monitoring

Procedure

Starting Monitoring
1.	 On the Control tab, click  Monitor Start to start a measurement.

		�  When a measurement is started, data is acquired in the internal memory of the measuring 
instrument.

	 The Overview panel of the DAQ - (host name) tab window of this software displays the 
waveforms of measured data in real time.

Note
•	 Even when a monitoring is started, measured data is not recorded to the storage device of the measuring 

instrument or PC.
•	 While monitoring, you can change the measurement conditions (see section 5.6) from the channel 

control panel and measurement control panel.

When a DL950 Is Connected
•	 You cannot start monitoring with the following settings.

-	 The display is in roll mode.
	 Roll mode is enabled when the trigger mode is set to auto, auto level, single, or on-start, and the time 

axis setting is greater than or equal to 100 ms/div.
-	 When dual capture mode is on

•	 Monitoring is not available when the trigger mode is set to on-start.
•	 When the DL950 firmware version is 1.10 or later and the trigger mode is auto, auto level, or normal, 

data is acquired in sync with triggers. When the trigger mode is Single N, waveforms are not displayed 
while monitoring. The data is acquired and saved after monitoring is finished.

	 When the DL950 is in Trigger Mode
Trigger data points are displayed with the beginning aligned even when the sample rates are different.

When a WT5000 Is Connected
•	 You cannot start monitoring with the following settings.

-	 When the update mode (Update Mode) is trigger (Trigger)
-	 When the temporary memory is insufficient
	 The maximum memory size is 10 MB (1 MB for a single PP waveform). Consider reducing the number 

of channels, increasing T/Div, and decreasing the monitoring display time.
•	 When the data update rate (Update Rate) is 10 ms, harmonic data cannot be monitored.
•	 If the data update rate (Update Rate) is less than 1 s, waveforms of measured data are not displayed on 

the Overview panel even if you start the monitoring of PP waveform data.
•	 If you change the Motor Config settings after connection, the Speed, Torque, and Aux data may not be 

acquired.
•	 When you start monitoring, you will not be able to operate the WT5000 from its control panel.
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Stopping Monitoring
2.	 On the Control tab, click  Monitor Stop to stop the measurement.

Pausing Monitoring
2.	 On the Control tab, click  Hold to pause the measurement.



5-35IM IS8000-01EN

5.9	 Starting and Stopping the Recording Operation

This section explains the following operations:
•	 Starting recording
•	 Stopping the Recording
•	 Dividing recordings
•	 Setting record conditions

Procedure

Starting Recording
1.	 On the Control tab, click  Record Start to start recording measured data.*

*	 If the measurement is stopped when you click Record Start, both measurement and recording will 
start.

	 When a recording is started, data is acquired to the storage device of the PC.

Stopping the Recording
2.	 On the Control tab, click  Record Stop or  Monitor Stop to stop recording.

Command Description
Record Stop The recording will stop, but measurement will continue.
Monitor Stop Both recording and measurement will stop.

Note
When a DL950 Is Connected
► This is similar to the note in section 5.8. Read “monitoring” as “recording.”

	 When the DL950 is in Trigger Mode
•	 When the trigger mode is N Single, all trigger data values are acquired.
•	 When the trigger mode is Single or N Single, the DL950 will stop automatically. After the DL950 stops, 

stop the recording on this software.

When a WT5000 Is Connected
► This is similar to the note in section 5.8. Read “monitoring” as “recording.”
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Dividing Recordings
2.	 On the Control tab, click   File Divide to divide the file being recorded and start recording 

to another file.

	 The divided file that has been recorded can be opened in offline analysis.

Setting Record Conditions
On the Control tab, click DAQ Setting to display a DAQ Setting window. Set the recording 
conditions.
This window is the same as that displayed in the simple wizard. ► section 3.6

Explanation

Recorded Data Files
•	 When you start recording, the file information (recording destination folder and file name, date, 

size) is displayed in the DAQ List panel. ► section 5.5
•	 When you stop or divide a recording, the file information is updated.

When a Recording Is Divided
When a recording is divided, a link file (.wlk extension) will be created.
When you open a link file, all the divided files are opened as a single continuous waveform.

Analyzing Recorded Data
•	 You can double-click a recorded data file to analyze it offline.
•	 The recorded data file can also be opened automatically in the Analysis-(file name) tab 

window when recording is completed. ► section 4.3
•	 The arrangement of the panels (overview panel, numeric panel, etc.) in the tab window 

used during recording is also carried over to the analysis tab window.

Note
Controlling the IS8000 Software from an external application
You can control the IS8000 Software from an external application for purposes such as creating an add-on 
application for motor efficiency mapping. The repetition of Record Start and Monitor Stop can be controlled.

•	 Using the API, you can control the following IS8000 Software functions from an external application.
Online Monitor,  
DAQ (Data Acquisition)

• Monitor Start
• Record Start
• Hold
• Monitor Stop
• Divide

	 For details, see the API User’s Manual, IM D037-01EN.
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When a WT5000 is connected, integrated values can be displayed.

This section explains the following operations:
•	 Starting integration
•	 Pausing and stopping integration
•	 Resetting integration

Procedure
1.	 Check the following points before starting integration.

•	 Set a measurement function or element so that the integrated value is displayed in the 
Numeric 1 or Numeric 2 panel. ► “Configuring the Numeric Display” on page 5-27

•	 With the data from the WT5000 (hereafter referred to as the WT) being monitored (measured) 
on the IS8000 Software, start integration. If the values integrated on the WT are not being 
acquired by the software, integrated values will not be displayed even when integration is 
started.

•	 You cannot start integration when recording is in progress.

Starting Integration
2.	 On the Control tab, click Integration Start.

		  Integration will start on all elements installed in the WT.

Pausing and Stopping Integration
3.	 On the Control tab, click Integration Stop.

		  Integration will pause on all elements installed in the WT.

If you click Integration Stop before the specified integration time is reached, integration will pause.
If you click Integration Start in this condition, integration will resume.

If Integration Is Paused or Integration Has Been Completed by Reaching the Specified Integration Time
If you click Integration Reset and then Integration Start, integration will be reset, and integration 
will start from the beginning.
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Resetting Integration
4.	 On the Control tab, click Integration Reset in the Integration group.

		  Integration on all elements installed in the WT will be reset.

•	 If you click Integration Reset, the integrated data in the WT will be cleared, but the integrated 
values will remain in the software.

•	 If integrated values are displayed in the Numeric1 or Numeric2 panel of the software, the 
integrated values will remain displayed. If you start integration again, the integrated values will 
be updated.

Explanation
The integration operation is executed on all elements of all connected WT5000s. Individual 
integration is not possible.
This software can display the integrate values of active power (watt hour), the current (ampere 
hour), the apparent power (volt-ampere hour), and the reactive power (var hour) values.
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You can check the risk of overruns with the overrun indicator.

Procedure

Displaying the Overrun Indicator
1.	 On the Control tab, click Indicator to show or hide the indicator panel.

Indicator Panel
Indicators are displayed for each measuring instrument (up to five).
Target instruments: DL950, WT5000

Current status
Medium risk:
High risk:

Gray/white (0 to 69 %)
Pink (70 to 100 %)

Window theme
Light Dark
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5.12	 Playing Videos (FS1 option)

When a measuring instrument and a high-speed camera are connected to the PC and the high-
speed camera synchronization feature (FS1 option) is activated, video commands become 
available.
Videos and waveforms can be recorded and saved.

For details on the features and how to use them, see the separate user’s manual (IM IS8000‑61EN).
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Chapter 6	
Controlling an Instrument from a PC (remote 
control)

This chapter explains how to control measuring instruments remotely from a PC.
► For the applicable instruments and available communication interfaces, see page 1-10.

6.1	 Controlling an Instrument from a PC

Procedure

Opening the Remote Control Window
1.	 Start this software. A launcher appears.

2.	 Click Remote Control. ► section 3.2
	 A Device Search window opens. ► section 3.4
	 Instruments connected to the PC via USB are automatically detected and displayed in a table.
3.	 If the instrument to be connected is not displayed in the table, select the communication interface 

(WIRE) type under Auto or select the detailed wire type under Manual, and click Search.

4.	 From the table of detected instruments, select the instrument you want to connect, and click Open.
	 A Remote Control - (host name) window opens.
	 •  �The screen of the connected measuring instrument (Remote Control window) is transferred 

and displayed on the Remote Control panel.
	 •  The control keys or knobs of the measuring instrument are displayed on the keypad panel.

Example When a DL950 Is Connected

In this example, the properties display area is minimized by clicking 
the pin icon      in the Remote Control properties.

Remote Contorl panel

Keypad (showing/hiding the keypad panel)

Keypad
panel
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Example When a WT5000 Is Connected

Remote Contorl panel

In this example, the properties display area is minimized by clicking 
the pin icon      in the Remote Control properties.

Keypad (showing/hiding the keypad panel)

Keypad
panel

Keypad Panel
Click on the Tools tab > Keypad on the Remote Control ribbon to show or hide the keypad 
panel.

The button corresponding to the connected measuring instrument is displayed. The buttons 
displayed will vary from model to model. Use the buttons to control the instrument (Remote 
Control window).

Keypad Panel Display Position and Button Layout
•	 The keypad panel display position can be changed.

See page 3-36 for instructions on how to change the panel display position.
•	 If a DL950 is connected, the button layout changes according to the keypad panel shape. 

The layout of the control keys and knobs differs slightly from that of the measuring 
instrument.

			 

Display example
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Using the Remote Control Window
You can use the keypad to operate and control the Remote Control window.

Note
When you connect a DL850 series instrument, you cannot control the Remote Control window using the 
mouse or touch panel.
You can control it by starting XWirepuller from the APPs tab and connecting the instrument.

Basic Keypad Operations
When you move the mouse pointer over a button (control key or knob) on the keypad, the 
button color changes to blue and the remote control window is ready to be operated.

Operation Display Behavior

Click
ACQ
Start/Stop HOLD ON  Same as pressing the control key on the 

instrument

•	 Rotate the mouse wheel up (to 
the back)

•	 Press the up or right arrow key.

•	 Increases the value
•	 Same as rotating the knob or jog dial 

to the right

•	 Rotate the mouse wheel down (to 
the front)

•	 Press the down or left arrow key.

•	 Decreases the value
•	 Same as rotating the knob or jog dial 

to the left

Explanation

Refresh Rate
You can select the refresh rate of the remote control window from the Refresh Rate drop-down list 
on the Tool tab of the Remote Control ribbon.

100 ms, 200 ms, 300 ms, 500 ms, 1 s, 2 s, 5 s, 10 s
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Keypad Panel
When a DL950 Is Connected
The buttons corresponding to the control and execution keys/knobs shown below are displayed.

Jog dial

Vertical Scale and Horizontal Scale

Utility

Setup

Triggering

Waveform Measurement and Analysis

Waveform Zoom and Search

ACQ Start/Stop Key
(bright green): Waveform acquisition is 
in progress when lit.

Menu Operation and Waveform Acquisition Start/Stop

ACQ
Start/Stop

When a WT5000 Is Connected
The buttons corresponding to the control keys in the HOLD/SINGLE/NULL/CAL section and the 
ESC key are displayed.
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6.2	 Saving Instrument Data to the PC

When you connect to a DL series instrument, you can save waveform data to the PC (ACQ Save).

Procedure
1.	 On the Tool tab of the Remote Control ribbon, click Waveform. A Save As dialog box 

appears.

2.	 Set the file save destination and file name, and then click Save.
	 The file type is Yokogawa waveform file (*.wdf).

	 A progress bar appears, and downloading starts from the measuring instrument to the PC.
	 When the download is complete and Close appears, click it.

3.	 When saving is complete, a message appears.
•	 When you click OK, an Analysis-(file name) tab window opens, and you can analyze the waveforms of 

the saved file offline.
•	 Click Cancel to close the message window.
	 If an anpjt file is specified in the layout default settings,* the tab window will open reflecting the 

specified layout when it is opened.
	 *	� From the Setting menu, select Layout > Initial setting. (See page 3-53.)

Explanation

Saved Waveforms
All waveforms, including math waveforms, displayed in the remote control window are saved.

Supported Models
•	 DL950
•	 DL850 series
•	 DL350
•	 DLM5000 series
•	 DLM3000 series



7-1IM IS8000-01EN

Chapter 7	

Managing Files

This chapter explains the following operations:
•	 Displaying lists of instrument files and pc files
•	 Transferring files
•	 Downloading Data Recorded Using Flash Acquisition

7.1	 Displaying Lists of Instrument Files and PC Files

This section explains the following operations:
•	 Renaming files and folders
•	 Creating and deleting files and folders

Procedure
1.	 On the launcher, select File Manager. A Device Search window opens.

2.	 Connect to the instrument by referring to section 3.4.
	 A File Manager-(host name) tab window, File Manager panel, and File Manager ribbon appear.

File Manager Panel
Sorts the file list

Moves to the higher level

Path to the target file 
or folder in the PC

List of files in the 
instrument

List of files in the PC

Summary of the 
select the files

File Overview Display
When you select a file on the PC, the file information (path, file name, file size, date accessed, and 
comment) is displayed.
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File Manager Ribbon
File Manager Tab

Group/Command Description
Operation

Create Directory Creates a new directory (folder).
This is valid when a folder is selected.

Rename You can rename folders and files on the PC.
This is valid when a folder or file on the PC is selected.

Updated Updates the file list in the File Manager panel.
Delete Deletes the selected files or folders.

This is valid when a file is selected.
Delete all Deletes all recorded data in the Flash ACQ folder.

This is valid when the Flash ACQ folder is selected. ► section 7.3
Upload Transfers files from the PC to the instrument.

This is valid when a folder or file on the PC is selected.
Download Transfers files from the instrument to the PC.

This is valid when a file on the instrument is selected.

Creating a Folder
On the File Manager tab, click Create Directory to open a folder name input dialog box. Enter a 
folder name, and click OK.

Note
•	 Folders are created in the current directory of the file list.
•	 Only ASCII characters (e.g., alphanumeric characters) can be used for folder names and uploaded file 

names.

Renaming a File and Folder
1.	 From the PC file list, select a file or folder you want to edit.

2.	 On the File Manager tab, click Rename to open a folder name input dialog box. Enter a folder 
name, and click OK.

Updating the File List
On the File Manager tab, click Updated to update the information in the file list.
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Deleting a File or Folder
1.	 From the file list, select a file or folder you want to delete.

2.	 On the File Manager tab, click Delete. A delete confirmation message appears.

3.	 Click OK to delete the file or folder selected in step 1.

Note
File Operations Shortcut Menu
When you right-click a file or folder in the right column of the file list, you can select the following operations 
from the shortcut menu.

Menu Item Procedure
Create Directory Creates a folder. The following folder names cannot be used. AUX, CON, 

PRN, NUL, CLOCK, COM0 to COM9, LPT0 to LPT9
Rename Can be used when you select a file or folder in the PC.
Reload Refreshes with the latest information
Delete Can be used when a file or folder is selected.
Download Can be used when you select a file in the instrument.
Upload Can be used when you select a file in the PC.

		

When a file in the instrument is selected

When a file on the PC is selected
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7.2	 Transferring Files

This section explains the following operations:
•	 File download (instrument → PC)
•	 File upload (PC → instrument)

Procedure

File Download (instrument → PC)
1.	 Refer to section 7.1, and select the save destination folder from the PC file list in the bottom 

area of the File Manager panel, or enter the same destination.

2.	 From the instrument file list in the top area, select the file you want to download.

3.	 On the File Manager tab, click Download. The file is transferred from the instrument to the 
PC.

File Upload (PC → instrument)
1.	 Refer to section 7.1, and select the save destination folder from the instrument file list in the 

top area of the File Manager panel.

2.	 From the PC file list in the bottom area, select the file you want to upload.

3.	 On the File Manager tab, click Upload. The file is transferred from the PC to the instrument.
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7.3	 Downloading Data Recorded Using Flash 
Acquisition

This section explains the following operations:
•	 Downloading recorded data (DL950 → PC) and converting to an MDF file
•	 Flash ACQ folder and recorded data operation

Delete all (vaild only when the Flash ACQ folder is selected)

Flash acquisition is a waveform acquisition feature that can be used when the dedicated flash 
memory (/ST2 option) is installed in the DL950. Acquired waveforms are saved as recorded data in 
the DL950 dedicated flash memory. For details, see the DL950 manuals.

When a DL950 is connected, recorded data in the dedicated flash memory can be downloaded to 
the PC. Downloaded recorded data is converted into an MDF file.

Note
•	 When the DL950 is running on an external clock, recorded data cannot be downloaded.
•	 When the DL950 operation mode is set to Recorder, recorded data cannot be downloaded. Change the 

mode to Scope to download.

Procedure

Downloading Recorded Data (DL950 → PC) and Converting to an MDF File
1. 	 Refer to section 7.1, and select the save destination folder from the PC file list in the bottom 

area of the File Manager panel, or enter the same destination.

2. 	 From the DL950 file list in the top area, select FLAS (Flash ACQ folder).
The recorded data in the dedicated flash memory is listed on the right side of the top area.

3. 	 Select the recorded data you want to download.

4. 	 On the File Manager tab, click Download. The recorded data is transferred from the DL950 
dedicated flash memory to the PC and converted to an MDF file.
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Note
Shortcut menu
When you select data in the right column of the data list and right-click it, a shortcut menu appears.
You can select the following operations.

Menu Item Operation
Reload Refreshes with the latest information
Download Can be used when recorded data in the Flash ACQ folder is selected

			 
Select recorded dataSelect FLAS (Flash ACQ folder).

Flash ACQ Folder and Recorded Data Operation
•	 You cannot upload recorded data or files from the PC to the Flash ACQ folder.
•	 You cannot rename the recorded data in the Flash ACQ folder.

Clearing All Recorded Data
1.	 Refer to section 7.1. From the list of files in the DL950 in the top section, select FLAS 

(Flash ACQ folder).
	 The Delete all command is enabled.
2.	 On the File Manager tab, click Delete all.
	 All recorded data in the Flash ACQ folder is cleared.

Note
You cannot delete recorded data individually.
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Chapter 8	

Generating Reports (RP1 option)

This chapter explains how to use the application for generating reports.*
You can export the loaded waveform’s data measurement and analysis conditions and waveforms in a 
report format on a single sheet. You can select the items to include in the report and change the report 
layout as you like. You can also collectively generate reports containing various types of measurement 
data using the same layout.

*	 RP1, Report Generator Option

8.1	 Overview of Creating Reports

Steps to Create Reports
•	 Display the data file to create a report		  Chapter 4
•	 Create a report template			   Section 8.2
•	 Edit the layout of parts (items)		  Section 8.3
•	 Edit the content of the report			   Section 8.4
•	 Generate the report (print, export to file)		  Section 8.5

Procedure

Loading and Displaying Files
1.	 Load the measured data you want to generate a report of and analyze the data.

Loading Files Containing Measured Data Offline
Click File Open on the launcher, or on the File tab of the start window, click Open to load 
files.

Displaying the Analysis Results of Measured Data
Display in the window the necessary information, such as zoom and cursor values, for 
generating a report of the loaded measured data. (See section 2.1 and chapter 4.)

Starting the Report Generator Application
2.	 On the APPs tab, click Report.
	� The Report Generator application starts. The Report Editor toolbar and view appear in a new 

window.
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8.1  Overview of Creating Reports

Report Editor Window
3.	 The first time you use this application, create a new template.

4.	 In the layout view, select the items to include in the report from the parts panel, and arrange 
them.

5.	 In the preview view, check how the actual report will look like, and set the displayed content of 
parts in the preview setting panel.

Page panel

Page panel

Parts panel

Layout setting panel

Preview setting panel
Preview panel

Toolbar

Displays the preview view

Displays the layout view

• Layout view

• Preview view

Toolbar
Creates a new template

Duplicates a template

Select a template.
Batch report generation

Print a report

Exports a report to a file
Deletes a template

Switches the view
The view is switched 
between layout and preview.
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8.1  Overview of Creating Reports

Explanation

Templates
You can create a layout of item parts you plan to use frequently in reports and save it to a template. 
You can select a saved template from a menu that appears when you click the template selection 
button.
Templates can be duplicated and deleted.

Layout View
Page Panel
Thumbnails of page layouts you created are displayed. You can click  to add a new layout 
or click  to delete a selected layout.
When you add a layout, a new layout setting dialog box appears that you can use to set the 
report size, orientation, report title, and so on.
Click  in the upper right to minimize the display area.

Layout Setting Panel
For each page, you can set the layout of items (parts) to include in reports.
Select a part you want to use from the parts panel at the right side of the window, and drop it 
on the layout setting panel. You can move and delete the arranged parts.

Parts Panel
Text, images, values, and other items that you can include in reports are listed.
Template Parts 
•	 Waveform Analysis (2×2, 4×4)
•	 Measure Result (2×4, 4×4)
•	 Comment (1×2, 2×2)
•	 Picture (2×2, 4×4)
Custom Parts
You can also create new parts.

Preview View
Page Panel
Thumbnails of pages in the created report are displayed in the left side of the window. 
Operations such as adding and deleting layouts are the same as those of the page panel of 
the layout view.

Preview Panel
An image of the report that will be exported is displayed in the center of the window.
Click  in the upper right to update the display.

Preview Setting Panel
You can set a header for each page in the report.
You can set the contents (properties) of each part shown in the preview panel.
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Batch Report Generation
You can select an existing template (layout) and collectively generate reports of multiple 
measurement files with the same configuration. ► section 8.6

Printing Reports (Print)
► section 8.5

Exporting Reports to Files
You can export reports to Excel, Word, and PDF files.
► section 8.5
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8.2	 Creating a Report Template

This section explains how to create a report template.
•	 Create a new template
•	 Arrange (lay out) parts
•	 Set headers
•	 Add, duplicate, and delete layouts
•	 Duplicate and delete templates

Procedure
1.	 On the APPs tab, click Report.
	� The Report Generator application starts. The Report Editor tools and view appear in a new 

window.

Creating a New Template
2.	 On the Report Editor window’s toolbar, click New Template. The following dialog box appears.

		
Enter the title of the first page.

Report size (A4) Report orientation 
(portrait, landscape)

Confirm button Cancel button

Enter the template name.

3.	 Enter the report size, orientation, the title of the first page, and template name, and click 
Confirm. The layout view appears.
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8.2  Creating a Report Template

Layout View

		

Page panel

Parts panel

Layout setting panel

•	 Page panel: A thumbnail of a blank page is displayed as the first page.
: Adds a layout
: Duplicates a layout
: Deletes a layout

•	 Layout Setting Panel
	 A grid is displayed that divides one page into 32 (8 x 4) frames. One frame is the minimum size for 

arranging parts.

•	 Parts Panel
	 Click Template Parts to expand the list of parts. [n×n] indicates the size of each part.

Arranging Parts
4.	 You can arrange parts using one of the following two methods.

•	 Double-click
	� When you double-click a part on the parts panel, the part is automatically placed in the first available 

area from the top left of the report. The part cannot be placed if there is no available area.

•	 Drag and Drop
	� Drag a part from the parts panel, and drop it in the layout setting panel on the left to place the part in 

the report.

	 For editing the layout of parts that have already been arranged, see section 8.3.

5.	 On the toolbar, click Go to Preview. A preview view appears.
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8.2  Creating a Report Template

Preview View

		

Page panel
Preview setting panel

Preview panel

•	 Page panel: A preview of the first page is displayed in a thumbnail.
: Adds a layout
: Duplicates a layout
: Deletes a layout

•	 Preview Panel
	 A preview of the contents that will actually appear in the report is displayed. You can check the 

displayed contents.
: Updates the measurement data display

•	 Preview setting panel: You can edit the display contents of each part while viewing the preview.
	 ► section 8.4

6.	 To change the layout of parts, click Go to Layout on the toolbar to switch to the layout view. 
For details on editing, see section 8.3.

Setting Headers
7.	 Set the logo on the first page, report title, page number display, and so on.

			 

Enter the report title.

Large corporation 
logo check box

Set the path to the corporation logo data.

Shows or hides 
page numbers

Collapses the header setting column

Shows or hides the 
corporation logo

Shows or hides 
the Yokogawa logo

Path to the corporation logo data
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8.2  Creating a Report Template

Example When a Company Logo Is Set

		

Corporation logo 
display position Title

Page number

When the Large Corporation Logo check box is selected

8.	 Set the displayed content of various parts. ► section 8.4

Adding a Layout
1.	 On the left side of the page panel of the layout view or preview view, click . The following 

window appears.

			 

Report size (A4)
Report orientation 
(portrait, landscape)

Confirm button Cancel button

Enter the header title.

2.	 Select the size of the layout to add and the report orientation.

3.	 Enter the header title of the layout to add, and click Confirm.
A blank page is added to page 2.

Arranging Parts
4.	 If the preview view is displayed, click Go to Layout on the toolbar to switch to the layout view.

5.	 Arrange parts. ► page 8-6

6.	 On the toolbar, click Go to Preview to switch the view to preview.

7.	 Check the displayed contents.

8.	 If necessary, set the header for the second page (see the previous section), and edit the 
displayed contents of parts. ► section 8.4
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Duplicating a Layout
1.	 In the page panel of the layout view or preview you, select the thumbnail of the page you want 

to duplicate.

2.	 Click  on the left side of the page panel. The following window appears.

			 
Enter the header title.

Confirm button

3.	 Enter the header title, and click Confirm. The layout is duplicated, and its thumbnail is 
displayed at the end.

4.	 To edit the layout, click Go to Layout on the toolbar to switch to the layout view. ► section 8.3

5.	 If necessary, set the header for the duplicated page (see the previous page), and edit the 
displayed contents of parts. ► section 8.4

Deleting a Layout
1.	 In the page panel of the layout view or preview you, select the thumbnail of the layout you 

want to delete.

2.	 Click  on the left side of the page panel. A confirmation message appears.

3.	 Click Yes. The selected layout is deleted.

Duplicating a Template
1.	 On the toolbar, click Copy Template to display a dialog box for entering our new template 

name.

2.	 Enter a template name, and click Confirm. The displayed template is duplicated with a new 
template name.

Deleting a Template
1.	 On the toolbar, click Delete Template. A confirmation message appears.

2.	 Click Yes. The displayed template is deleted.
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8.2  Creating a Report Template

Explanation

Saving Templates and Layouts
If you edit the layout or the displayed content of various parts, they are saved in the selected layout 
or template.
► sections 8.3, 8.4
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8.3	 Editing the Layout of Parts (Items)

Procedure

Displaying the Layout View
1.	 Refer to page 8-2. On the toolbar of the Report Editor review, click the Template button, and 

select the template to edit.
The selected template layout is displayed in the view.

2.	 On the toolbar, click Go to Layout. The layout view appears.
•	 Click Template Parts in the parts panel to expand the list of parts.

•	 If the item you want is not available in the template parts, use Customize Part to create a new part. 
► page 8-14

Creates new parts
Expands the list of template parts

Arranging Parts
3.	 You can arrange parts using one of the following two methods.

•	 Double-click
	� When you double-click a part on the parts panel, the part is automatically placed in the first available 

area from the top left of the report. The part cannot be placed if there is no available area.

•	 Drag and Drop
	� Drag a part from the parts panel, and drop it in the layout setting panel on the left to place the part in 

the report.

		

Scroll bar

Page panel Parts panelLayout setting panel
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8.3  Editing the Layout of Parts (Items)

Moving a Part
3.	 You can move a part by dragging an already placed part and dropping it in an available area 

within the layout setting panel.

Deleting a Part
3.	 You can delete parts using one of the following two methods.

•	 Double-click
	 When you double-click a part already placed in the report, the part is deleted.

•	 Drag and Drop
	 When you drag a part already placed in the report to the parts panel, a trash bin mark appears. When 

you drop the part, the part is deleted.

			 

When a trash bin mark appears 
in the parts panel turns light blue, 
drop the part.

Checking the Displayed Content of Parts
4.	 On the toolbar, click Go to Preview. A preview view appears.

	 Set the displayed content of various parts. ► section 8.4
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8.3  Editing the Layout of Parts (Items)

Explanation

Layout Setting Panel
The arrangement area of the layout setting panel is divided as follows:

Columns: 4 divisions

Rows: 8 divisions

Template part size

[ 1 × 2 ]

[ 2 × 2 ]

[ 2 × 4 ]

[ 4 × 4 ]

Report Parts
You can select the following parts.

Template Parts
Part Name Size* Description
Waveform analysis (small) 2×2 A small waveform is displayed.
Waveform analysis (large) 4×4 A large waveform is displayed.
Measurement result (small) 2×4 The measured result is displayed.
Measurement result (large) 4×4 The measured result is displayed.
Comment (small) 1×2 A small comment is displayed.
Comment (large) 2×2 A large comment is displayed.
Picture (small) 2×2 A small picture is displayed.
Picture (large) 4×4 A large picture is displayed.
* See the figure above for the parts sizes.
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8.3  Editing the Layout of Parts (Items)

Custom Parts
You can create original parts.
Creating a New Part
1.	 Click New Part to display the following dialog box.

		

Rows of parts 
(1 to 8)
Columns of parts 
(1 to 4)

Part type (Comment, Waveform 
Analysis, Measure Result, Picture)

Confirm button Cancel button

Enter a description of the part 
(up to 50 characters).

Enter the part name 
(up to 25 characters).

2.	 Set the part size (row, column), part type, part name, and part description, and then click 
Confirm.

3.	 Click Custom Parts to expand the list of parts. Check that the part you created has been 
added to the parts list.

		

Edit the part.

Deletes the part

When you select a part, edit and 
delete buttons appear.
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8.4	 Editing the Content of the Report

Procedure

Displaying the Preview View
1.	 Refer to page 8-2. On the toolbar of the Report Editor review, click the Template button, and 

select the template to edit.
The selected template layout is displayed in the view.

2.	 If necessary, edit the layout. ► sections 8.2, 8.3

3.	 On the toolbar, click Go to Preview. A preview view appears.

When you select the name 
of the part you want to edit, 
the information setting area 
expands.

Page panel
Preview setting panel

Preview panel

Selecting the Part to Edit
4.	 In the preview setting panel, click the name of the part you want to edit.

•	 If the part information setting area is collapsed, click it to expand it.
	 If the part information setting area is expanded, clicking the part name will collapse the area.
•	 The corresponding part is enclosed in a blue frame on the preview panel.

Setting the Items
5.	 Set the items of the report part.

	 The set items are reflected in the preview panel display.
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8.4  Editing the Content of the Report

Explanation

Setting Report Parts
Header

Item Description
Header Title Enter the report title. You can enter up to 25 characters.
Page Information Shows and hides page numbers.

ON:	� In the upper right of the report, page numbers are displayed in 
the (current page)/(total number of pages) format.

OFF:	Page numbers are not displayed.
Yokogawa Logo Shows and hides the YOKOGAWA logo.

ON:	� A YOKOGAWA logo is displayed in the upper right of the report.
OFF:	A YOKOGAWA logo is not displayed.

Corporation Logo A specified logo can be displayed in the upper left of the report.
ON:	� A corporation logo is displayed. This is valid when a logo image 

data is specified.
OFF:	A corporation logo is not displayed.

Path to the corporation  
logo data

Displays the path to the logo data

Specify the logo image data.
Selectable file formats: png, bmp

Large Corporation Logo This is valid when a logo image data is specified.
ON:	� A slightly enlarged logo is displayed in the upper left of the report.
OFF:	A logo is displayed in the upper left of the report.

* For details on the logo display location, see section 8.2.

Waveform Analysis (Waveform Analysis)

Item Description
Waveform Type Select the type of waveforms to display in reports.

•	 Overview
•	 View 1
•	 View 2
•	 View 3
•	 View 4
•	 History
•	 Dual Capture
•	 XY 1

•	 XY 2
•	 Video 1
•	 Video 2
•	 FFT View
•	 Zoom 1
•	 Zoom 2
•	 [FFT] History

:	 Click this to update the waveform preview.
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Measurement Result 

Item Description
Result Select the measurement results you want to display.

•	 Vertical cursor
•	 Horizontal cursor
•	 Measured results
•	 [FFT] Vertical cursor
•	 [FFT] Horizontal cursor

:	 Click this to update the preview of the measure results.
Font Size Set the font size (6 pt to 72 pt).

Comment

 

Comment input area

Confirm button
Cancel button

Comment edit dialog box

Palette

Item Description
Edit Displays a comment edit dialog box.

Comment input area You can enter a comment and check the format.
Font Family* Font Family* Select a font from the combo box.
Font Size* Font Size* Set the font size (6 pt to 72 pt).
Horizontal* Horizontal position* Select left, center, or right.
Vertical* Vertical position* Select top, center, or bottom.

Confirm The settings entered in the edit dialog box will 
be confirmed.

Cancel The settings entered in the edit dialog box will 
be canceled.

Font color Set the font color using a palette.
Background color Set the background color using a palette.

*	 The settings in the comment information setting area and comment edit dialog box are synchronized.
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8.4  Editing the Content of the Report

Picture

 

 

Item Description
Path to the picture image data Displays the path to the picture data

Specify the picture image data.
Selectable file formats: png, bmp
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8.5	 Exporting Reports

This section explains how to print reports and how to export reports to Excel, Word, and PDF file 
formats.

Procedure

Displaying the Preview View
1.	 Refer to page 8-2. On the toolbar of the Report Editor review, click the Template button, and 

select the template to output.
The selected template layout is displayed in the view.

2.	 If necessary, edit the layout. ► sections 8.2, 8.3

3.	 When you finish editing the layout, on the toolbar, click Go to Preview. A preview view 
appears.
Batch, Print, and Export to File on the toolbar become available.

Select a template.
Batch report generation

Print a report

Exports a report to a file

Switches the view
The view is switched 
between layout and preview.

When Printing to a Printer
4.	 On the toolbar, click Print.

A Print dialog box appears.

		

Print button

Preferences
The preferences dialog box for 
the selected printer opens.

Select a printer.

5.	 Select a printer, and click Preferences.

	 The preferences dialog box for the selected printer opens.

6.	 Select the paper, print orientation, and the like, and click OK. The dialog box closes.
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8.5  Exporting Reports

7.	 Click Print in the print dialog box.
The report is printed with the same image as the preview window.

Note
Set the printer settings properly according to your system environment.

When Exporting to a File
Selecting the Output Format
4.	 On the toolbar, click Export to File, and select the export format.

Select Excel (.xlsx), Word (.docx), or PDF (.pdf).
A Save As dialog box appears.

5.	 Set the file output destination and file name, and then click Save.

		

Save button

Enter the file name.

6.	 When the file is exported successfully, a message appears. Click OK.
The report file is saved with the same image as the preview window.

Note
When you print the PDF file on a printer, the layout may become distorted. If this happens, select the Print 
As Image check box in the printer setup dialog box for your printer, and then print.
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8.6	 Generating Multiple Reports Collectively

This section explains how to collectively generate reports containing various types of measurement 
data using the same layout.

Procedure

Displaying the Preview View
1.	 Refer to page 8-2. On the toolbar of the Report Editor review, click Template, and select the 

template to export collectively.
The selected template page is displayed in the view.

2.	 If necessary, edit the layout. ► sections 8.2, 8.3

3.	 When you finish editing the layout, on the toolbar, click Go to Preview. A preview view 
appears.
Batch, Print, and Export to File on the toolbar become available.

4.	 On the toolbar, click Batch. An export file list is displayed in the right side of the view.

		

Clears the file list

Adds files to the list

Page panel
Output file list

Preview panel

Adding Files to the List
5.	 Click Add. An Open dialog box appears.

6.	 Select files to include in the batch export, and then click Open.
•	 The selectable file formats are WDF and MDF.
•	 You can select multiple files.

	 The names and paths of the selected files are displayed in the export file list.
•	 Clicking Clear clears all the file names and paths displayed in the file list.
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Exporting Files
Selecting the Output Format
7.	 On the toolbar, click Export to File, and select the export format.

Select Excel (.xlsx), Word (.docx), or PDF (.pdf).
A dialog box opens for setting the report export destination.

Specifying the Export Destination Folder
8.	 Select the file export folder, and click Select Folder.

•	 A file export progress bar appears.
•	 When all the files are exported, the specified destination folder opens. Check the exported report files.
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Chapter 9	

Troubleshooting and License Management

This chapter explains troubleshooting measures for solving operation, configuration, and license 
management issues as well as maintenance procedures.
If a message is displayed on the screen, see section 9.2. If servicing is necessary, or if the instrument 
does not operate properly even after you have attempted to deal with the problem according to the 
instructions in this section, contact your nearest YOKOGAWA dealer.

9.1	 Troubleshooting

Operation and Configuration
Problem Probable Cause and Corrective Action
Unable to connect to the instrument. •	 The USB or Ethernet cable may not be connected properly. 

Check the cable connection.
•	 If connected over an Ethernet network, the specified IP address 

may be different from the actual IP address of the instrument. 
Check the IP address assigned to the instrument on the 
instrument display.

•	 Connection cannot be established if the instrument is turned off. 
Turn on the instrument power switch.

An overrun error is displayed during data 
acquisition, and recording stops.

An overrun may occur depending on the PC specifications or load 
conditions.
[PC conditions in which overruns tend to occur]
•	 CPU usage is 50 % or more.
•	 Memory usage is greater than physical memory size (memory 

swap is occurring).
•	 The active disk period is 50 % or more (performance 

degradation due to SSD heat generation).

Consider the following measures.
•	 Do not run other features such as remote control and file 

manager.
•	 Decrease the sample rate of the recording channels.
•	 Decrease the number of recorded channels.
•	 Disable antivirus software.

I want to display the channel settings 
and DAQ settings that were set using the 
DAQ wizard.

•	 To display the channel settings, on the Monitor ribbon, click the 
Monitor tab and then Channel Setting.

•	 To display the DAQ settings, on the Monitor ribbon, click the 
Control tab and then DAQ Setting.

An **** mark is displayed for logic cursor 
values.

There may be too many number of bits, and the significant digits 
may be hidden. Expand the cursor value display frame.
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9.1  Troubleshooting

Problem Probable Cause and Corrective Action
The history waveform’s FFT bar is not 
displayed.

•	 The FFT of history waveforms is taken for each history. 
Therefore, the FFT bar is displayed on the History panel that 
can be displayed by selecting View and then History on the 
Waveform Analysis ribbon.

•	 When a history waveform and a non-history waveform are 
displayed on the same axis, FFT operations cannot be 
performed.

► section 4.11
Measurement, math, and FFT operations 
cannot be performed on sub waveforms 
of a dual capture.

Measurement, math, and FFT operations cannot be performed on 
sub waveforms of a dual capture.

Waveforms cannot be viewed in detail 
even when the waveform is zoomed on 
the online monitor.

The waveforms on the online monitor are displayed using peak-to-
peak waveforms. If the range of a given number of points exceeds 
one dot of the resolution of the waveform display screen, maximum 
and minimum values are displayed continuously.
You can view waveforms in detail using either of the following 
methods.
•	 Record the waveforms for a few seconds, and view the 

waveforms using offline analysis.
•	 Click Trigger Mode on the Remote Control ribbon, view the 

waveforms in trigger mode.
	 If you change to trigger mode, if you click Monitor Start or 

Record Start on the online monitor, the mode automatically 
returns to free run.

When waveforms are shown in split 
display, I want to freely change the 
height of the waveforms.

If the Split check box is selected in properties, clearing the Auto 
check box will allow you to change the height of the waveform 
display areas separately.

A parameter initialization error appears 
at the start of measurement or recording.

The memory may be insufficient. Consider the following measures.
•	 Reduce the number of channels.
•	 Decrease the monitoring display time or the sample rate.
•	 For WT waveform display data (PP waveforms), increase T/DIV.

License Management
Problem Probable Cause and Corrective Action
License code management Keep the license certificate (product information sheet).

The license code can be displayed on this software, but we 
recommend you keep the license certificate.

What is the base license code? It is the first activated license code.
► page 9-14

The license was renewed or an option 
was added within the valid subscription 
license period. What happens to the 
license code?

The newly added license code will be integrated into the base 
license code, and the current base license code will continue to be 
the representative license code.

Is it possible to activate using a different 
license model?

Activation is not possible using a different license model regardless 
of whether the license is a subscription license model or perpetual 
license model.

Online and offline activation methods The activation window changes automatically depending on the 
PC connection status.

How long is the activation deadline (the 
period during which activation can be 
performed)?

Activation is valid for 13 months after purchasing a license. After 
this deadline, activation is not possible. You will need to purchase 
a license again.

Where can I find the license expiration 
date?

Click License on the Help menu of the IS8000 Software to open 
the license information view window.
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Problem Probable Cause and Corrective Action
How to move the license information 
from the first PC to the second

On the second PC, you can obtain the license information of the 
first PC by execute Update in the license information view window 
of the IS8000 Software.
► section 9.5

Can different options be added to the 
two PCs of a single license?

The configuration of options is always the same because the two 
PCs share the same license. If you add an option to the first PC, 
the same option will be added to the second PC.
After activating the software on two PCs, if you add an option to 
the first PC, the same option is added by clicking Update on the 
second PC.

If you want to use the software on 
another PC

•	 Normal First, deactivate the software on the PC you will no longer use. 
Second, activate the software on the PC you will use.

•	 When reinstalling Windows in the 
PC

Deactivate the software before reinstalling Windows. Next, reinstall 
Windows, and then activate the software.

•	 If the PC malfunctions If all the licenses you have are in use, you cannot use it on another 
PC. In such a case, contact your nearest YOKOGAWA dealer.

If your PC breaks but recovers You can obtain the license information from the license server by 
activating the software on the PC that recovered.

The license of an add-on package 
(IS800xEX) cannot be activated.

If the standard feature (IS800x) of the IS8000 software is not 
installed, you will not be able to activate add-on packages.

If only an add-on package is valid, can I 
continue to use the software?

If the standard feature (IS800x) is not available, you cannot use 
the software.

If all the licenses, such as the standard 
feature and add-on packages of the 
IS8000 Software, expire, what happens?

•	 Use of some functions is restricted, but you can continue to use it.
	 ► page vi in the Installation Manual (IM IS8000-04EN)
•	 If you purchase a new license after all the licenses have 

expired, you will need to activate the license. The software will 
be managed using a new base license code.

Can I use only the Harmonic/Flicker 
Software (IS801x)?

Yes.
The Harmonic/Flicker Software (IS801x) is a software that can 
be started from the launcher of the standard feature (IS800x) of 
the IS8000 Software.* It is a separate product from the IS8000 
Software.
*	 The standard feature (IS800x) can start the launcher even 

when the use of some features are restricted (activation not 
completed or after license expiration).

Can add-on features (IS800xEX) 
be used (added) by purchasing the 
Harmonic/Flicker Software (IS801x)?

No. Add-on features cannot be activated if the standard feature 
(IS800x) has not been activated.

If I uninstall the software, what happens 
to the license?

The license information will remain unchanged. (The software will 
not be deactivated, nor will the PC license file be deleted.)



9-4 IM IS8000-01EN

9.2	 Error Messages

Messages may appear on the screen while you are using this software. This section describes the 
error messages and how to respond to them.
•	 Standard Feature Error Messages (Error Code: 1 to 4999)
•	 License Error Messages (Error Code: 5000 to 5999)
•	 Add-On Package Error Messages (Error Code: 6000 to 6999)

Standard Feature Error Messages
Error Code Message Chapter or Section
1 Can’t load project file. —
2 Can’t create project file.
3 Can’t start launcher.
4 This is an unsupported version of the DL950. Please update the firmware. Section 1.1
5 Failed to connect to the measurement device.
6 The configuration file is corrupted. Application needs to be restarted. —
1001 Absolute Time cannot be specified because the waveforms are farther apart 

than the default in some places.
Section 4.2 and 
section 4.5

Absolute time display is not possible if two waveforms are spaced apart more 
than 24 hours.

1002 Cannot be added because the maximum number of channel subscriptions (128) 
has been exceeded.

Section 3.5

1301 Invalid constant in the expression. Section 4.8
1302 Invalid constant in the expression.
1303 Invalid expression.
1304 Invalid expression.
1305 Invalid expression.
1306 Invalid expression.
1307 Invalid expression.
1308 Invalid expression.
1309 Invalid math setting. Section 4.8 and 

section 4.111310 Invalid start time (s).
1311 Invalid interval (s).
1312 FFT Start is out of range.
1313 Math operation failed.
1314 Filter configuration failed.
1315 Math operation failed. Check the constant values.
1316 Math operation failed.
1317 Start Time or Interval is out of range.
1318 Start or End is invaied.
1401 Start Time is out of range. Section 4.7
1402 Interval is invalid.
1403 Start Time or Interval is out of range.
1601 Invalid CSV file. Section 3.8
1602 Invalid waveform file.
1603 Failed to save the file.
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9.2  Error Messages

Error Code Message Chapter or Section
1701 File read error. Section 3.8
1702 Not a link file.
1703 Invalid directory.
1801 Invalid CSV file.
1802 Invalid CSV file.
1803 Data record not found.
2001 Failed to calculate the cache size. —
2002 Not enough memory. Section 3.5 and 

section 5.6Reduce the number of channels, or reduce the sample rate.
2003 No input value. Section 3.6 and 

section 5.92004 Invalid input value.
2005 Input value out of range.
2006 Invalid start recording time.
2007 Invalid stop recording size.
2008 Invalid output folder.
2009 Invalid drive.
2010 The number of characters that can be entered has been exceeded.
2011 Setup transmission error. Section 5.8 and 

section 5.92012 Setup transmission error.
2013 START/DAQ preparation error.

If waveforms are not displayed or the software does not operate properly even 
when a measurement or recording is started, reconnect the instrument.

2014 Setup transmission error.
If waveforms are not displayed or the software does not operate properly even 
when a measurement or recording is started, reconnect the instrument.

2015 The device is measuring. Stop the device.
2016 Setup transmission error.

If waveforms are not displayed or the software does not operate properly even 
when a measurement or recording is started, reconnect the instrument.

2018 Setup transmission error.
Reconnect the instrument.

2019 The number of points displayed in the overview has exceeded the upper limit.
Check the number of display points setting.
Check the WT5000’s Update Rate and Wave Time/div settings or the 
software’s Display Time setting (section 3.6), and change them if the upper 
limit of the number of display points on the overview is exceeded.

2020 Overrun occurred.
2021 Communication error occurred.
2022 Can’t start RecordLength.

Please set RecordLength 100M or less.
2023 Cannot start when the Update Rate is 10ms.
2024 Cannot start when the Update Mode is Trigger.
2025 Can’t acquire data in Trigger mode because the recording channels include 

analysis channels.
Remove the analysis channels or change to Freerun mode.

Section 5.8 and 
section 5.9

2026 Turn off realtime recording of data acquisition.
2027 Stopped for lack of memory.
2028 Stopped because the memory used was exceeded.

Please reduce the Record Length or T/Div.
2101 In auto range mode, because data update rate doesn’t match the actual update 

rate, the time positions of power values gradually shift.
—
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Error Code Message Chapter or Section
2102 Can’t start when Integration is not set to Reset. Section 5.8 and 

section 5.9
2103 Unsupported WT5000 version. Update the firmware. Section 1.1
2104 Cannot start integration.

In order to start, set Time/div for wave bigger than 0.01ms.
Section 5.10

2105 Cannot execute when IEEE 1588 is not in the “Stable” state. To execute, wait
until the state becomes “Stable” or turn off IEEE 1588.

2106 Illegal date-time.
Set the correct date and time.

2107 Cannot start the integration.
Turn off streaming, set appropriate conditions and try again.

2108 Attempted to start integration after integration time has reached its preset 
value.

2109 Attempted to start integration while integration is in progress.
2110 Attempted to stop integration even though integration was not in progress.
2111 Attempted to reset integration even though integration was in progress or 

integration mode was not selected.
2112 Attempted to start integration while measurement of peak overflow was in 

progress.
2113 Attempted to start integration in continuous integration mode when integration 

preset time was set to “0”.
2114 Attempted made to start integration in real time counting integration mode 

when the end time had already passed.
2115 An error has occurred in communication. Reconnect the device. Section 5.8 and 

section 5.9
2116 Insufficient memory for file storage. Section 5.6
2117 Data streaming start condition is not met. Check the WT5000 settings.
2118 Update rate at which data streaming cannot be started.

Please change the update rate.
2119 Number of waveforms for which data streaming cannot be started.

Please change the number of waveforms.
3001 Failed to save file. Section 6.2
3002 There is no data to be saved. Check if there is any data to be saved.
3003 ACQ save cannot be executed in SD recording mode.
3004 Failed to save the file because the file is in use.
4001 There is already a file with the same name in this directory. Use a different 

name.
Section 7.1

4002 The device is running. Stop the device and then try again. Section 7.2
This error occurs when trying to upload or download files when a DLM is 
running.

4003 Can’t delete file. Section 7.1
This error occurs when trying to delete a file in a format that cannot be deleted 
(directory, no extension, etc.).

4004 Can’t create directory.
4005 Cannot upload to the Flash ACQ folder. Section 7.3
4006 Failed to clear the waveform memory.
4007 Upload failed. Chapter 7
4008 Download failed.
4009 Rename failed.
4010 Failed to delete the specified folder or file.
4011 Some items failed to be deleted in the specified folder or file.
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License Error Messages
Error Code Message Chapter or Section
5000-125 The license code you entered is not correct. Sections 2.2 and 

2.31Enter the correct license code.
5000-831 The maximum number of licenses has been exceeded.
5000-1904 The license code has been revoked. It may be integrated into the base license 

code.
Sections 2.2 and 
2.31

Section 9.5 and 
section 9.6

Check the base license code in the license information view window.

5000-4040 The activation period has expired. Section 9.5 and 
section 9.6You will need to repurchase a license.

5001 A technical error has occurred. Contact our customer service for assistance.
5002 This license code cannot be activated until 3 months before it expires.
5003 Already activated.
5004 Already activated.
5005 The license model is different.
5006 Failed to obtain a license.
5007 Already activated.
5008 The license code you entered cannot be used to activate the installed software 

version.
5009 Not connected to a network.
5010 Activate the license that includes the basic features first.

1	 Installation Manual (IM IS8000-04EN)

Add-On Package Error Messages
Error Code Message Chapter or Section
6001 An invalid view has been selected. Chapter 8
6002 An invalid character is present.
6003 An invalid character is present.
6004 Enter a new name as the same name is already in use.
6005 An invalid character is present.
6006 Enter a new name as the same name is already in use.
6007 Invalid save path.
6008 Failed to save to the file. Check the save path or save name.
6009 Failed to export the report. Section 8.5
6010 Failed to export the report.
6011 Failed to export the report.
6012 Failed to print the report.
6201 Invalid file. 2

6202 Invalid video file.
6203 Cannot be added because it exceeds the maximum number of coaxial displays 

for video files.
2	 High-speed Camera Synchronization Feature (FS1 Option) User’s Manual (IM IS8000-61EN)
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9.3	 Viewing the Manuals

You can view the manuals for this software in the following manner.

Viewing the Manuals from the Launcher
Click Manual at the upper right of the launcher.

	

Viewing the Manuals from the Help Menu
On the Help menu, click Manual.

	

The Manuals folder opens. This folder contains the English and Japanese manuals for this 
software. You can view the PDF data of the manual.

	

Note
To view the PDF data, you need Adobe Acrobat Reader or a software application that can open PDF data.
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9.4	 Viewing the Version Information

On the Help menu, click About to display the software version information.

	

Software version
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9.5	 Managing the License Information

This section describes the following operations.
•	 Viewing the License Information
•	 Adding an Add-On Package and Renewing the Expiration Date
•	 Deactivating the License

Procedure

Viewing the License Information
1.	 On the Help menu, click License. The following window appears.

License Information View Window
Subscription License

License code

License information
• Product names
• Model and suffix
• License status
• Expiration date

License model
A message appears three months 
before the license expiration date.

Updates the license information

Closes the license information 
view window

Activate
Adds an add-on package or renews 
the expiration date

When selected, this window will 
not be displayed at startup.

Deactivate
Deactivates the license

Perpetual License

License information
• Product name
• Model and suffix
• License status
• Available version
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9.5  Managing the License Information

Adding an Add-On Package and Renewing the Expiration Date
To add an add-on package or renew the license expiration date, activate the software in the license 
information view window using the new or renewed license code.

2.	 Click Activate. An activation window opens.

3.	 The operation procedure is the same as the initial license activation.
	 The license code is indicated in the product information sheet issued when an add-on package was 

added or when the license was renewed.

Online Activation

		  Enter or view the license code.

Click Activate.

	  ► Proceed to step 2 in section 2.2 in the Installation Manual, IM IS8000-04EN.

Offline Activation
	 Follow steps 1 to 7 in the window.

		

Enter or view the license code.

Click Execute.

Specify the license file, and 
click Select.

	  ► �For details, see the procedure starting with step 2 in section 2.3 in the Installation Manual, IM IS8000-
04EN.

	 When the activation is completed, the license information display is updated.

When a Single License Is Used on Two PCs
When step 2 is completed on the first PC, be sure to update the license information on the second PC.

4.	 On the second PC, start the IS8000 Software. On the Help menu, click License.
	 A license information view window opens.
5.	 Click Update in the upper right of the window. The license status and expiration date in the 

window will be updated.
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9.5  Managing the License Information

Procedure

Deactivating the License
1.	 On the Help menu, click License. 
	 The license information view window (page 9-10) appears.
2.	 Click Deactivate. 
	 When a confirmation dialog box appears, click OK.
	 A deactivation window opens.

Online Deactivation

	

Click Deactivate.

Check that the license code is the same as 
the license code to be deactivated.

3.	 Check that the license code displayed is the same as the license code to be deactivated, 
and click Deactivate.

	 Proceed to step 15.

Offline Deactivation
	 Follow steps 1 to 7 in the window.

		

Click Execute.

Specify the license file, and 
click Select.

Check that the license code is the 
same as the license code to be 
deactivated.
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9.5  Managing the License Information

Creating a Deactivation Key (Zip file)
3.	 Check that the license code displayed is the same as the license code to be deactivated, 

and click Execute.
A deactivation key (Zip file) is created.

4.	 When a confirmation dialog box appears, click OK.
	 A Save As dialog box appears.
5.	 Specify the location to save the zip file, and click Save.

6.	 When a confirmation dialog box appears prompting you to unzip the Zip file on the online 
PC, click OK.

Note
If you do not want to perform steps 7 and later immediately
There is no problem with selecting Cancel to close the deactivation window or closing the IS8000 
Software.
You can always start the IS8000 Software and open the deactivation window again, as explained in 
step 12, and continue with the procedure.

Moving the Zip File to Your Online PC and Creating a License File
7.	 Move (copy) the created Zip file to any location on your online PC using a USB memory 

device or other means.

8.	 Unzip the zip file.

9.	 Start the unzipped activation tool (ActivationTool.cmd).*
*	 When the extension is not displayed

1.	 Click on the View tab from the File Explorer menu.
2.	 Select the File name extensions check box.
	 File names with extensions are displayed.

	 Once the license is activated, the license code and license model to be deactivated will 
be displayed in the window.

10.	 Check the displayed information, and click OK.
	 A license file (without extension) is created.

Moving the License File to the Original Offline PC and Selecting It
11.	 Move (copy) the license file created in step 10 to any location on the original offline PC.

12.	 Start the IS8000 software on the offline PC, and open the deactivation window. (See the 
previous page.)

13.	 Click Select to specify where to browse for the license file.

14.	 Click OK. The license file will be stored in the offline PC.

15.	 When deactivation is completed, a confirmation dialog box appears.
	 Click OK or the “X” in the upper right corner of the dialog box to close it.
	 The software returns to the no license state.

	 The IS8000 Software will restart, and the startup window will appear.
	 For details on the startup window, see section 2.1 in the Installation Manual, IM IS8000-04EN.
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9.5  Managing the License Information

Explanation

License Code
The base license code is always displayed in the license information view window.

What is the Base License Code?
The first activated license code is called the base license code.
Product licenses that have been added or renewed as a result of adding an add-on package 
or upgrading the software are integrated into the base license code for management.

License Models
License Model/Message Description
Subscription This is a subscription license product.

Please confirm. Some products are 
about to expire.

•	 This message will be displayed 3 months before the license 
expiration date.

•	 The license information view window is displayed at 
startup. To stop displaying the window at start up, clear the 
check box at the bottom of the window.

The IS80XX license has expired. This message will be displayed when the license is expired.

Perpetual This is a perpetual license product.

Updating the License Information
All licenses can be used on two PCs per license.
When an activation is completed on the first PC, you can click Update on the second PC to update 
the license information on the second PC.

Note
When Using a Single License on Two PCs
The license information on the second PC is a copy of the first. The IS8000 software license update and 
add-on package information is synchronized between the two PCs.
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Viewing the License Information
Product Name
The product name managed by the base license code shown in the window is displayed. You 
can view added and updated add-on packages and the software product name.

Product and Basic Specifications
The product model or the suffix code of the add-on package is displayed.

*	 You can view the product model and suffix code on the product information sheet.

License Status
•	 When the license is valid

The product license is displayed.
The license expiration date is displayed in red for the period from three months before the 
expiration date to the expiration date.

•	 When the license invalid: Nothing is displayed.

Expiration Date and Available Version
For each product, the license expiration date and available version are displayed.
•	 Subscription license

The license expiration date (yyyy/mm/dd) is displayed.
•	 Perpetual license

The available version (display format is year: yyyy - yyyy) is displayed. The yyyy on the right 
is the upgrade expiration date.

Adding an Add-On Package and Renewing the Expiration Date
When the software currently in use is activated properly, the Activate button becomes available, 
and you will be able to add add-on packages and renew the expiration date.

Note
When Using a Single License on Two PCs
You cannot add separate add-on packages between the two PCs.

Deactivating the License
If you want to uninstall the software, such as when the PC needs to be exchanged, click Deactivate 
to deactivate the license. By deactivating the license, you will be able to activate the software on 
the new PC using the license code that you have been using up to that point.
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9.6	 License Expiration Date and Renewal

This manual explains the following IS8000 software licenses.

Subscription License Model
•	 IS8001 Integrated Software Subscription (1 year)
•	 IS8001EX Integrated Software Add-On Packages Subscription (1 year)

•	 IS8011 Harmonic/Flicker Software Subscription (1 year)

Renewing the License before the Expiration Date
When the expiration dates of all the IS8000 products that you using expire, you will no longer be 
able to use the base license code that has been already activated. Activate using a new license 
code. The base license code will be updated.

Perpetual License Model
•	 IS8002 Integrated Software Perpetual License
•	 IS8002EX Integrated Software Add-On Packages Perpetual License

•	 IS8012 Harmonic/Flicker Software Perpetual License

Behavior after Upgrade Expiration Date
If the software upgrade period expires, you will not be able to make a new version upgrade, but you 
can continue to use the final version of the year when the version upgrade expires.

Note
IS8002 and IS8012 are separate products. If you activate these products at separate times, the software 
upgrade expiration dates will also be separate.
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9.6  License Expiration Date and Renewal

IS8001 	 Integrated Software Subscription
The standard features of the Integrated Software can be used for one year.

License Expiration Date
One year after receiving this software, installing it on your PC, and activating it.
•	 Please activate the software immediately. The activation deadline is 13 months from shipment.
•	 The expiration date is until the expiration date of the first activated PC.
•	 From three months before the expiration date, a message about license renewal will be displayed when 

you start the software.

Software Upgrade
You can always upgrade to the latest software version within the valid license period.

License Renewal
•	 The initial license code (base license code) of the software you are using will be inherited by renewing 

the license within the valid license period, and you will be able to continue using it.
•	 If you renew the license (purchase a new license) after the valid license period expires, the license code 

will not be inherited, and a new license code will become the base license code.

Operation after the Valid License Period Expires
After the valid license period expires, only a limited number of the standard features will be available.

Illustration of Activation and License Renewal

License code inheritance

License update period
(3 months before the expiration date)

Reception

Activation License renewal

IS8001 IS8001

Base license code

Base license code

IS8001 Can be used for 1 year from activation 
when the license is renewed after the 
expiration date

Can be used for 1 year after the base 
license expiration date

Can be used for 1 year from 
activation

Can be used for 1 year from 
activation

Activation

IS8001
New base license code

License expiration date

Functional 
limitations
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9.6  License Expiration Date and Renewal

IS8001EX 	 Add-on Package Subscription
You can use the software for one year by adding features to the IS8001 Integrated Software 
Subscription.

*	 To use the add-on package, the IS8001 license must be valid.
	 (Add-on packages cannot be added to IS8002, IS8011, or IS8012.)

License Expiration Date
One year after receiving this software and installing and activating it.
•	 Please activate the software immediately. The activation deadline is 13 months from shipment.

However, since it operates only within the IS8001 license period, you need to renew the IS8001 license 
before it expires in order to continue using it for one year.

•	 The expiration date is until the expiration date of the first activated PC.
•	 From three months before the expiration date, a message about license renewal will be displayed when 

you start the software.

Software Upgrade
You can always upgrade to the latest software version within the valid license period.

License Renewal
When the license is renewed within the valid license period, the license is integrated into the IS8001 base 
license code in use. You can continue to use the software as before.

Operation after the Valid License Period Expires
After the valid license period expires, you will not be able to use this software (the add-on features).

Illustration of Activation and License Renewal

Functional 
limitations

Activation

If the IS8001 expires, add-on 
packages cannot be used until the 
IS8001 license becomes valid, even 
if the IS8001EX is valid.

License code inheritance

Reception

Activation License renewal

IS8001 IS8001

License code integration

Base license code

License expiration date

License expiration date

IS8001EX

Activation

License code inheritance

License renewal

IS8001 IS8001

License code integration

Base license code

IS8001EX

License update period
(3 months before the expiration date)

Can be used for 1 year after the 
base license expiration date

Can be used for 1 year from 
activation

Can be used for 1 year 
from activation

Can be used for 1 year after 
license renewal

Can be used for 1 year from 
activation

Can be used for 1 
year from activation
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IS8011 	 Harmonic/Flicker Software Subscription
Harmonic/Flicker Software can be used for one year.
The rest of the license policy is the same as the IS8001.

License Expiration Date
One year after receiving this software and installing and activating it.
•	 Please activate the software immediately. The activation deadline is 13 months from shipment.
•	 The expiration date is until the expiration date of the first activated PC.
•	 From three months before the expiration date, a message about license renewal will be displayed when 

you start the software.

Software Upgrade
You can always upgrade to the latest software version within the valid license period.

License Renewal
•	 The initial license code (base license code) of the software you are using will be inherited by renewing 

the license within the valid license period, and you will be able to continue using it.
•	 If you renew the license (purchase a new license) after the valid license period expires, the license code 

will not be inherited, and a new license code will become the base license code.

Operation after the Valid License Period Expires
After the valid license period expires, only a limited number of the IS8001 standard features will be 
available.

Illustration of Activation and License Renewal

IS8001

License code inheritance

Reception

IS8011 IS8011

Base license code

Base license code

IS8011
New base license code

License expiration date

IS8011
Functional 
limitations

Can be used for 1 year from activation 
when the license is renewed after the 
expiration date

Can be used for 1 year after the base 
license expiration date

Can be used for 1 year 
from activation

Can be used for 1 year 
from activation

License update period
(3 months before the expiration date)Activation License renewal

Activation
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IS8002 	 Integrated Software Perpetual
The standard features of the Integrated Software can be used indefinitely.

License Expiration Date
Indefinitely after receiving this software and installing and activating it.
Please activate the software immediately.

Software Upgrade
The software can be updated to the latest version for five years from the year following the year the 
software was shipped.

License Renewal
License renewal is not required.

Illustration of Activation and License Renewal

(year)

Base license code

2021 2022 2023 2024 2025 2026 2027

Reception

Shipment

Example When You Purchase a Perpetual License in 2021

Activation Upgrade expiration date

Can be upgraded to the latest software version
5 years or more

Can be used indefinitely from activation
IS8002

The final 2026 version 
can be used indefinitely.
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9.6  License Expiration Date and Renewal

IS8002EX 	 IS8000 Add-on Package Perpetual
You can use the software indefinitely by adding features to the IS8002 Integrated Software 
Perpetual.

*	 To use add-on packages, the IS8002 must be installed and activated, and the IS8002 must be in the 
upgradeable period.

	 (Add-on packages cannot be added to IS8001, IS8011, or IS8012.)

License Expiration Date
Indefinitely after receiving this software and installing and activating it.
Please activate the software immediately.

Software Upgrade
You can update the software to the latest version during the upgradeable period of the IS8002 you are 
using.

License Renewal
License renewal is not required. At the first activation, the license will be integrated with the license code of 
the IS8002 you are using.

Illustration of Activation and License Renewal

(year)

The final 2026 version 
can be used indefinitely.

Base license code

2021 2022 2023 2024 2025 2026 2027

Can be upgraded to the latest software version

Reception

Shipment

Example When You Purchase a Perpetual License in 2021

Activation

Activation

License code integration

Can be used indefinitely from activation
IS8002EX

5 years or more

Upgrade expiration date

Can be used indefinitely from activation
IS8002
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9.6  License Expiration Date and Renewal

IS8012 	Harmonic/Flicker Software Perpetual
Harmonic/Flicker Software can be used indefinitely.

License Expiration Date
Indefinitely after receiving this software and installing and activating it.
Please activate the software immediately.

Software Upgrade
The software can be updated to the latest version for five years from the year following the year the 
software was shipped.

License Renewal
License renewal is not required.

Illustration of Activation and License Renewal

(year)

Base license code

2021 2022 2023 2024 2025 2026 2027

Can be upgraded to the latest software version
5 years or more

Reception

Shipment

Can be used indefinitely from activation

Example When You Purchase a Perpetual License in 2021

Activation

IS8012

The final 2026 version 
can be used indefinitely.

Upgrade expiration date
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Chapter 10	

Specifications

This chapter explains the specifications of this software.

10.1	 Product Specifications

Integrated Software
Model Suffix Code Description
IS8001 IS8000 Integrated Software Subscription
IS8002 IS8000 Integrated Software Perpetual
Options /SY1 Multi-Unit Connection Option

/MH1 Waveform Math Option (user-defined math)
/SB1 Serial Bus Analysis Option
/PR1 Report Generator Option
/FS1 High-speed Camera Synchronization Option (Photron high-speed camera)
/EM1 ECU Monitor Synchronization Option (DTS INSIGHT RAMScope)
/MB1 Modbus/TCP Communication Option

Add-on Packages
Model Suffix Code Description
IS8001EX IS8000 Add-on Package Subscription
IS8002EX IS8000 Add-on Package Perpetual
Suffix Code -SY1 Multi-Unit Connection

-MH1 Waveform Math (user-defined math)
-SB1 Serial Bus Analysis
-PR1 Report Generator
-FS1 High-speed Camera Synchronization (Photron high-speed camera)
-EM1 ECU Monitor Synchronization (DTS INSIGHT RAMScope)
-MB1 Modbus/TCP Communication

Harmonic/Flicker Software
Model Description
IS8011 Harmonic/Flicker Software Subscription
IS8012 Harmonic/Flicker Software Perpetual
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10.2	 Specifications

Item Specifications
Applicable models DL950/WT5000: Data acquisition, remote control, offline file analysis

DLM3000, DLM5000: Remote control, offline file analysis
SL1000/DL850 series/DL350: Offline file analysis
WT1800 series/WT3000 series: Offline file analysis
DLM2000 series/DLM4000 series: Offline file analysis
ECU monitor1 DTS INSIGHT RAMScope GT122, GT170 (RAM measurement module only)
High-speed camera2 Photron FASTCAM SA-Z, FASTCAM Mini AX/UX2/WX2 series, FASTCAM 

NOVA S series/R2
Modbus/TCP-compatible device3

Language English, Japanese, Chinese (additional languages planned in the future)
PC requirements For data acquisition with 10 Gb Ethernet connection;

Desktop PC required/Intel Core i7-1165G7 or later, 4 cores (8 threads) or more, 4.7 GHz or faster/ 
16 GB or more memory/512 GB or more SSD (NVMe is recommended, Sequential read/write 
3 GB/s or faster)

For data acquisition with 1 Gb Ethernet/USB connection and offline analysis;
Intel Core i5-10210U or later, 4 cores (8 threads) or more, 4.2 GHz or faster/8 GB or more memory/ 
256 GB or more SSD (Sequential read/write 400 MB/s or faster)

Operating system Windows 10 64 bit, Windows 114

Communication interface USB (USBTMC, VISA), Ethernet (VXI-11, HiSLIP, Modbus/TCP3)
Display resolution 1366×768 dots or higher, 100 % zoom
Device connection Maximum number of connected measuring instruments: 55, 6 (However, one ECU monitor, high-speed 

camera, or Modbus/TCP-compatible device may be connected)
Online device configuration Smart setup, remote control
Data acquisition6 Data acquisition (DAQ), real-time waveform monitor 

DL950 measurement mode: Scope mode (Trigger/7FreeRun) and Trigger are available only when the 
link feature is disabled.
WT5000: Numeric display, Harmonic bar,8, 9 Vector display, Data Streaming10

(Maximum transfer rate 320 MB/s (10 MS/s × 16ch): 10 GB Ethernet connection)
(Maximum transfer rate 6.4 MB/s (200 M/s × 16ch): 1 Gb Ethernet/USB connection)
(Maximum continuous recording time  

Automatically stops when the free storage space falls to less than 10%)
(Maximum recording size  

Automatically stops when the free storage space falls to less than 10%)
Data display Waveforms: Overview (1 window), Perview (1 window),View (up to 4 windows),  

X-Y (up to 2 windows), Zoom (FFT waveforms, up to 2 windows)11

Numeric: Numeric monitor, Numeric display (WT5000)
Graph: Harmonic bar (WT5000),8, 9 Vector display (WT5000)

Waveform display format Single display, split display (up to 32 waveforms), tile display (4x8 max.)
History waveform display, dual capture waveform display (ScopeCorder series, DL series)

Maximum number of 
displayed waveforms

Up to 32 waveforms per display group, 4 groups total (128 waveforms) (during T-Y display) 
(Display feature available)

Coaxial waveform position 
adjustment

Time, Absolute Time, First, Last, Offset

Waveform parameter 
measurement

Up to 28 types including P-P, Amp, RMS, and Freq

History statistical 
processing

Automatically measures the waveform parameters on the data of each history waveform and performs 
statistical processing on the parameters.

Cyclic statistical 
processing

Automatically measures the waveform parameters once per cycle and performs statistical processing 
on the parameters.

Cursors Vertical (2), horizontal (2)
Annotation feature Insert annotation anywhere in the overview, view, and X-Y windows (text, measured value)
Waveform math11 Math waveforms Up to 16 waveforms (Math1 to Math16)

Computational accuracy Single-precision floating-point
Operators +, -, x, /, phase shift, ABS, SQRT, LOG, EXP, NEG, SIN, COS, TAN, ATAN, 

PH, DIF, DDF, INTEG, BIN, P2, P3, F1, F2, FV, PWHH, PWHL, PWLH, 
PWLL, PWXX, DUTYH, DUTYL, FLT1, FLT2, HLBT, MEAN

Math points Up to 12.5 Mpoint
100 Mpoints max. when MATLAB Runtime is installed
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10.2  Specifications

Item Specifications
FFT math FFT Up to 16 operations (FFT1 to FF16)

Type: LS, RS, PS, PSD, CS, TF, CH
Subtype: REAL, IMAG, MAG, LOGMAG, PHASE

FFT window function Rect,  Hanning,  Flat top,  Hamming
FFT points Up to 2 Mpoint

100 Mpoints max. when MATLAB Runtime is installed
Digital filter Gauss,  Sharp,  IIR

Serial bus signal  
analysis and search12

Waveform analysis and search can be performed on one serial bus signal.
Analysis The software can decode frames, fields, and other information from the 

waveform displayed on the screen. Then, it can display the decoded results 
and the waveform together on the screen or display a list of detailed decoded 
results.

Search If you set search conditions and perform a search, you can display the 
waveform expanded with the beginning of the frame, field, or data that meets 
the search conditions in the center.

Detected points The software can search up to 100000 points.
CAN bus signal 
analysis and search

Analyze or search for CAN (Controller Area Network) bus signals.
CAN data can be analyzed and displayed.
Waveforms that can be used for CAN bus signal analysis can be selected from loaded waveforms.
Mode SOF, ID/Data, Error
Bit Rate Select from 33.3 kbps, 83.3 kbps, 125 kbps, 250 kbps, 500 kbps, or 1 Mbps or 

enter the value directly. The input range is 10 kbps to 1 Mbps (in 0.1 kbps steps).
Remote control Applicable models DL950 series, DL850 series, DL350, DLM3000 series, DLM5000 series, 

WT5000
Update rate Options (100 ms, 200 ms (default), 300 ms, 500 ms, 1 s, 2 s, 10 s)
Waveform saving Save waveforms in the measurement memory to the PC

File type Load MF4 (MDF4.1), WDF, WVF 
CSV (CSV saved with this software, CSV saved with Xviewer, CSV files of 
DL950, DL850 series, DL350, DLM5000 series, DLM4000 series, DLM3000 
series, DLM2000 series, WT5000, WT3000 series, and WT1800 series). Up 
to the first 128 channels can be loaded. 
CSZ
IS8000 project file

Save MF4 (MDF4.1), CSV, IS8000 project file
File management File transfer Between the instrument and the PC, DL950 Flash Acquisition data transfer
Screen capture Save Clipboard, png, jpg, gif
CSV batch converter Load MF4 (MDF4.1), WDF, WVF

Save CSV, CSZ
Report13 Output format MS-Word, MS-Excel, PDF, printer output

Report parts Waveform, math result, comment, image
Page generation Multiple page generation, copy, preview, layout, part content input

Applications ECU Monitor Synchronization1

High-speed Camera Synchronization2

Modbus/TCP communication3

Harmonic/Flicker Software14

1	 ECU monitor synchronization (EM1 option) is required.
2	 High-speed camera synchronization (FS1 option) is required. The number of frames before and after trigger cannot be set for 

the Mini UX/WX series. (The trigger position is the start of frame.)
3	 Modbus/TCP communication (MB1 option) is required.
4	 ECU monitor synchronization feature (EM1 option) is not compatible with Windows 11.
5	 Multi-unit connection (SY1 option) is required. This option is required to connect multiple instruments, even if the instruments 

are not synchronized with each other.
6	 The specifications of the IS8000 application do not apply to connection of instruments and data collection when multiple 

instances of the application are running on the same PC.
7	 For the conditions that allow monitoring and DAQ (data acquisition) when Motion Mode is set to Trigger, see Appendix 2. 
8	 When the IEC harmonics/flicker measurement feature (/G7 option) is installed in the WT5000, measurement data display 

complying with IEC 61000-4-7 Annex B (2k-9kHz) is supported.
9	 Interharmonic measurement is available when the IEC harmonics/flicker measurement feature (/G7 option) is installed in the 

WT5000 and the WT5000 firmware version is 3.61 or later.
10	 Data streaming requires the /DS option on the WT5000.
11	 Waveform math (MH1 option) is required.
12	 Serial bus analysis (SB1 option) is required.
13	 Report generator (RP1 option) is required.
14	 IEC harmonic/flicker software is required.
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Appendix

Appendix 1	 When Performing Synchronous 
Measurement of Power and Waveforms

The following flowchart shows how to connect a WT5000 and DL950 and perform real-time 
monitoring (measurement) and recording in sync.

Connect the instruments. Connect the measuring instrument and PC via Ethernet or USB.  
See the user’s manual of the measuring instrument.

Start the software. See section 3.1.

Configure the connection.
•	 From the launcher
Select the 
function.

Select DAQ. See section 3.2.

Smart setup •	 On the Device Search window, search for WT5000 and 
DL950, select both instruments, and connect them.

See section 3.4.

•	 On the Channel Setting window, confirm the display 
conditions of each instrument.

See section 3.5.

•	 In the DAQ Setting window, set the instrument display 
conditions and recording conditions.

See section 3.6.

•	 From the start window
Open the 
launcher.
(The first 
instrument)

On the File tab, select New to open the launcher. From here, 
refer to the procedure in “From the launcher” described earlier.

See section 3.2.

And the second 
instrument.

On the File tab, click Add Device, and connect the second 
instrument.

See section 3.8.

Set the measurement and display conditions.� Monitor > Monitor tab

Set the display 
conditions.

On the Channel Control panel, set the monitor (measurement) 
display conditions.

See sections 5.2 
to 5.4.

Set the 
measurement 
conditions.

In the Device Control panel, set the measurement conditions. See section 5.6.

Configure the 
measured data 
display.

•	 Under Display Setting, set the waveform color, grid, and 
other items.

•	 Under Numeric Setting, set the numeric display of power 
values.

See section 5.7.

Continue to the next page.
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Execute measurement and recording.� Monitor > Control tab

Start and stop 
measuring.

Click Start/Stop. See section 5.8.

Set the record 
conditions.

DAQ Setting (Specify the recording start, stop, division, and 
save destination settings.)

See sections 3.6 
and 5.9.

Start and stop 
recording.

Click Record Start/Record Stop. See section 5.9.

•	 When Using a Project File
Tab window and panel positions and various waveform display information can be saved in a 
project file. The next time you open this file, the display conditions will be restored to what they 
were when the software was last closed.
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Appendix 2	 Monitoring and DAQ (Data Acquisition) 
When the DL950 Is Set to Trigger Mode

Number of Measured Data Points That Can Be Saved and 
Measurement Conditions
The following two tables are provided.
•	 DL950 set record length (10 k to 2.5 Mpoint)
•	 DL950 set record length (5 M to 500 Mpoint)
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Appendix 2  Monitoring and DAQ (Data Acquisition) When the DL950 Is Set to Trigger Mode

DL950 set record length (10 k to 2.5 Mpoint)
Relationship between the DL950 time scale and record length settings and the maximum sample rate  
(IS8000 waveform display time: 5 s1)

DL950 
Time/Div 
Setting

Data 
Record 
Time

DL950 Set Record Length [Points]2

10 k 25 k 50 k 100 k 250 k 500 k 1 M 2.5 M ≥ 5 M
100 to  
200 ns/div

1 to 
2 μs

— — — — — — — —

See the 
next 

page.

500 ns/div 5 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
1 μs/div 10 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
2 μs/div 20 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
5 μs/div 50 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s

10 μs/div 100 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
20 μs/div 200 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
50 μs/div 500 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s

100 μs/div 1 ms 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
200 μs/div 2 ms 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
500 μs/div 5 ms 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 20 MS/s 20 MS/s

1 ms/div 10 ms 200 kS/s 200 kS/s 200 kS/s 5 MS/s 5 MS/s 20 MS/s 100 MS/s 100 MS/s
2 ms/div 20 ms 200 kS/s 200 kS/s 200 kS/s 5 MS/s 5 MS/s 5 MS/s 50 MS/s 100 MS/s
5 ms/div 50 ms 200 kS/s 200 kS/s 200 kS/s 2 MS/s 5 MS/s 10 MS/s 20 MS/s 50 MS/s

10 ms/div 100 ms 100 kS/s 200 kS/s 200 kS/s 1 MS/s 2 MS/s 5 MS/s 10 MS/s 20 MS/s
20 ms/div 200 ms 50 kS/s 100 kS/s 200 kS/s 500 kS/s 1 MS/s 2 MS/s 5 MS/s 10 MS/s
50 ms/div 500 ms 20 kS/s 50 kS/s 100 kS/s 200 kS/s 500 kS/s 1 MS/s 2 MS/s 5 MS/s

100 ms/div 1 s 10 kS/s 20 kS/s 50 kS/s 100 kS/s 200 kS/s 500 kS/s 1 MS/s 2 MS/s
200 ms/div 2 s 5 kS/s 10 kS/s 20 kS/s 50 kS/s 100 kS/s 200 kS/s 500 kS/s 1 MS/s
500 ms/div 5 s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s 100 kS/s 200 kS/s 500 kS/s

1 s/div 10 s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s 100 kS/s 200 kS/s
2 s/div 20 s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s 100 kS/s
3 s/div 30 s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s
4 s/div 40 s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s
5 s/div 50 s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s 50 kS/s
6 s/div 60 s 100 S/s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s

10 s/div 100 s 100 S/s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s 20 kS/s
20 s/div 200 s 50 S/s 100 S/s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s 10 kS/s
30 s/div 300 s 20 S/s 50 S/s 100 S/s 200 S/s 500 S/s 1 kS/s 2 kS/s 5 kS/s

1 min/div 10 min 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s 500 S/s 1 kS/s 2 kS/s
2 min/div 20 min 5 S/s 20 S/s 20 S/s 50 S/s 200 S/s 200 S/s 500 S/s 2 kS/s
3 min/div 30 min 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s 500 S/s 1 kS/s
4 min/div 40 min — 10 S/s 20 S/s 20 S/s 100 S/s 200 S/s 200 S/s 1 kS/s
5 min/div 50 min — 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s 500 S/s
6 min/div 60 min — 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s 500 S/s

10 min/div 100 min — — 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s
12 min/div 120 min — — 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s 200 S/s
30 min/div 300 min — — — 5 S/s 10 S/s 20 S/s 50 S/s 100 S/s
1 h/div 10 h — — — — 5 S/s 10 S/s 20 S/s 50 S/s
2 h/div 20 h — — — — 5 S/s 10 S/s 20 S/s
3 h/div 30 h — — — — — 5 S/s 20 S/s
4 h/div 40 h — — — — — 5 S/s 10 S/s
5 h/div 50 h — — — — — 5 S/s 10 S/s
6 h/div 60 h — — — — — — 10 S/s
8 h/div 80 h — — — — — — 5 S/s

10 h/div 100 h — — — — — — 5 S/s
12 h/div 120 h — — — — — — 5 S/s

1 day/div 10 day — — — — — — —
2 to
5 day/div

20 to
50 day

— — — — — — —

1 �When the IS8000 waveform monitoring display time is 5 s. If the display time is increased, the upper sample rate limit may 
decrease under the same conditions.

2 The upper DL950 record length setting limit on the IS8000 is 500 M samples.
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Appendix 2  Monitoring and DAQ (Data Acquisition) When the DL950 Is Set to Trigger Mode

DL950 set record length (5 M to 500 Mpoint)
Relationship between the DL950 time scale and record length settings and the maximum sample rate  
(IS8000 waveform display time: 5 s1)

DL950 
Time/Div 
Setting

Data 
Record 
Time

DL950 Set Record Length [Points]2

≤ 2.5 M 5 M 10 M 25 M 50 M 100 M 250 M 500 M
100 to 
200 ns/div

1 to
 2 μs

See the 
previous 

page.

— — — — — — —

500 ns/div 5 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
1 μs/div 10 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
2 μs/div 20 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
5 μs/div 50 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s

10 μs/div 100 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
20 μs/div 200 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
50 μs/div 500 μs 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s

100 μs/div 1 ms 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
200 μs/div 2 ms 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
500 μs/div 5 ms 20 MS/s 20 MS/s 20 MS/s 20 MS/s 20 MS/s 20 MS/s 20 MS/s

1 ms/div 10 ms 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s
2 ms/div 20 ms 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s
5 ms/div 50 ms 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s

10 ms/div 100 ms 50 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s
20 ms/div 200 ms 20 MS/s 50 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s
50 ms/div 500 ms 10 MS/s 20 MS/s 50 MS/s 100 MS/s 100 MS/s 100 MS/s 100 MS/s

100 ms/div 1 s 5 MS/s 10 MS/s 20 MS/s 50 MS/s 100 MS/s 100 MS/s 100 MS/s
200 ms/div 2 s 2 MS/s 5 MS/s 10 MS/s 20 MS/s 50 MS/s 100 MS/s 100 MS/s
500 ms/div 5 s 1 MS/s 1 MS/s 1 MS/s 1 MS/s 1 MS/s 1 MS/s 1 MS/s

1 s/div 10 s 500 kS/s 500 kS/s 500 kS/s 500 kS/s 500 kS/s 500 kS/s 500 kS/s
2 s/div 20 s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s 200 kS/s
3 s/div 30 s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s
4 s/div 40 s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s
5 s/div 50 s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s 100 kS/s
6 s/div 60 s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s

10 s/div 100 s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s 50 kS/s
20 s/div 200 s 20 kS/s 20 kS/s 20 kS/s 20 kS/s 20 kS/s 20 kS/s 20 kS/s
30 s/div 300 s 10 kS/s 10 kS/s 10 kS/s 10 kS/s 10 kS/s 10 kS/s 10 kS/s

1 min/div 10 min 5 kS/s 5 kS/s 5 kS/s 5 kS/s 5 kS/s 5 kS/s 5 kS/s
2 min/div 20 min 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s
3 min/div 30 min 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s
4 min/div 40 min 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s 2 kS/s
5 min/div 50 min 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s
6 min/div 60 min 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s 1 kS/s

10 min/div 100 min 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s
12 min/div 120 min 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s 500 S/s
30 min/div 300 min 200 S/s 200 S/s 200 S/s 200 S/s 200 S/s 200 S/s 200 S/s

1 h/div 10 h 100 S/s 100 S/s 100 S/s 100 S/s 100 S/s 100 S/s 100 S/s
2 h/div 20 h 50 S/s 50 S/s 50 S/s 50 S/s 50 S/s 50 S/s 50 S/s
3 h/div 30 h 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s
4 h/div 40 h 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s
5 h/div 50 h 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s
6 h/div 60 h 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s 20 S/s
8 h/div 80 h 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s

10 h/div 100 h 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s
12 h/div 120 h 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s 10 S/s

1 day/div 10 day 5 S/s 5 S/s 5 S/s 5 S/s 5 S/s 5 S/s 5 S/s
2 to 
5 day/div

20 to 
50 day

— — — — — — —

1 �When the IS8000 waveform monitoring display time is 5 s. If the display time is increased, the upper sample rate limit may 
decrease under the same conditions.

2 The upper DL950 record length setting limit on the IS8000 is 500 M samples.
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